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Safety InstructionsImportant 
Information

Safety Instructions • English

 WARNING:  This symbol, , when used on the product, is intended to 
alert the user of the presence of uninsulated dangerous voltage within the 
product’s enclosure that may present a risk of electric shock.

ATTENTION:	 This symbol, , when used on the product, is intended 
to alert the user of important operating and maintenance (servicing) 
instructions in the literature provided with the equipment.

For information on safety guidelines, regulatory compliances, EMI/EMF 
compatibility, accessibility, and related topics, see the Extron Safety and 
Regulatory Compliance Guide, part number 68-290-01, on the Extron 
website, www.extron.com.

Sicherheitsanweisungen • Deutsch

WARNUNG:		 Dieses Symbol  auf dem Produkt soll den Benutzer darauf 
aufmerksam machen, dass im Inneren des Gehäuses dieses Produktes 
gefährliche Spannungen herrschen, die nicht isoliert sind und die einen 
elektrischen Schlag verursachen können.

VORSICHT:  Dieses Symbol  auf dem Produkt soll dem Benutzer in 
der im Lieferumfang enthaltenen Dokumentation besonders wichtige 
Hinweise zur Bedienung und Wartung (Instandhaltung) geben.

Weitere Informationen über die Sicherheitsrichtlinien, Produkthandhabung,  
EMI/EMF-Kompatibilität, Zugänglichkeit und verwandte Themen finden Sie in 
den Extron-Richtlinien für Sicherheit und Handhabung  (Artikelnummer  
68-290-01) auf der Extron-Website, www.extron.com.

Instrucciones de seguridad • Español

ADVERTENCIA:		 Este símbolo, , cuando se utiliza en el producto, 
avisa al usuario de la presencia de voltaje peligroso sin aislar dentro del 
producto, lo que puede representar un riesgo de descarga eléctrica.

ATENCIÓN:		 Este símbolo, , cuando se utiliza en el producto, avisa 
al usuario de la presencia de importantes instrucciones de uso y 
mantenimiento recogidas en la documentación proporcionada con el 
equipo.

Para obtener información sobre directrices de seguridad, cumplimiento 
de normativas,  compatibilidad electromagnética, accesibilidad y temas 
relacionados, consulte la  Guía de cumplimiento de normativas y seguridad 
de Extron, referencia 68-290-01, en el sitio Web de Extron, www.extron.com.

Instructions de sécurité • Français

AVERTISSEMENT :	 Ce pictogramme, , lorsqu’il est utilisé sur le 
produit, signale à l’utilisateur la présence à l’intérieur du boîtier du 
produit d’une tension électrique dangereuse susceptible de provoquer 
un choc électrique.

ATTENTION :	 Ce pictogramme, , lorsqu’il est utilisé sur le produit, 
signale à l’utilisateur des instructions d’utilisation ou de maintenance 
importantes qui se trouvent dans la documentation fournie avec le 
matériel.

Pour en savoir plus sur les règles de sécurité, la conformité à la 
réglementation, la compatibilité EMI/EMF, l’accessibilité, et autres sujets 
connexes, lisez les informations de sécurité et de conformité Extron, réf. 
68‑290-01, sur le site Extron, www.extron.com.

Istruzioni di sicurezza • Italiano 

AVVERTENZA:	 Il simbolo, , se usato sul prodotto, serve ad 
avvertire l’utente della presenza di tensione non isolata pericolosa 
all’interno del contenitore del prodotto che può costituire un rischio di 
scosse elettriche.

ATTENTZIONE:	Il simbolo, , se usato sul prodotto, serve ad avvertire 
l’utente della presenza di importanti istruzioni di funzionamento e 
manutenzione nella documentazione fornita con l’apparecchio.

Per informazioni su parametri di sicurezza, conformità alle normative, 
compatibilità EMI/EMF, accessibilità e argomenti simili, fare riferimento 
alla Guida alla conformità normativa e di sicurezza di Extron, cod. articolo 
68‑290‑01, sul sito web di Extron, www.extron.com.
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Copyright Statement

Trademarks

 

   
 

   

 
 

 

 

 

	  

 

   

   

  
   

Copyright
© 2015-2019  Extron Electronics. All rights reserved. www.extron.com

Trademarks
All trademarks mentioned in this guide are the properties of their respective owners.
The following registered trademarks (®), registered service marks (SM), and trademarks (TM) are the property of RGB Systems, Inc. or 
Extron Electronics (see the current list of trademarks on the Terms of Use page at www.extron.com):

Registered Trademarks (®)

Extron, Cable Cubby, ControlScript, CrossPoint, DTP, eBUS, EDID Manager, EDID Minder, Flat Field, FlexOS, Glitch Free. Global 
Configurator, Global Scripter, GlobalViewer, Hideaway, HyperLane, IP Intercom, IP Link, Key Minder, LinkLicense, LockIt, MediaLink, 
MediaPort, NetPA, PlenumVault, PoleVault, PowerCage, PURE3, Quantum, Show Me, SoundField, SpeedMount, SpeedSwitch, 
StudioStation, System INTEGRATOR, TeamWork, TouchLink, V‑Lock, VideoLounge, VN‑Matrix, VoiceLift, WallVault, WindoWall, XPA, XTP, 
XTP Systems, and ZipClip

Registered Service Mark(SM) :  S3 Service Support Solutions

Trademarks (™)

AAP, AFL (Accu‑RATE Frame Lock), ADSP (Advanced Digital Sync Processing), Auto‑Image, AVEdge, CableCover, CDRS (Class D 
Ripple Suppression), Codec Connect, DDSP (Digital Display Sync Processing), DMI (Dynamic Motion Interpolation), Driver Configurator, 
DSP Configurator, DSVP (Digital Sync Validation Processing), eLink, EQIP, Everlast, FastBite, Flex55, FOX, FOXBOX, IP Intercom 
HelpDesk, MAAP, MicroDigital, Opti‑Torque, PendantConnect, ProDSP, QS‑FPC (QuickSwitch Front Panel Controller), Room Agent, 
Scope‑Trigger, ShareLink, SIS, Simple Instruction Set, Skew‑Free, SpeedNav, Triple‑Action Switching, True4K, Vector 4K , WebShare, 
XTRA, and ZipCaddy
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FCC Class A Notice
This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to part 15 of the FCC rules. The Class A limits provide reasonable 
protection against harmful interference when the equipment is operated in a commercial 
environment. This equipment generates, uses, and can radiate radio frequency energy and, 
if not installed and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential area is 
likely to cause interference. This interference must be corrected at the expense of the user.

ATTENTION:	

•	 The Twisted Pair Extension technology works with unshielded twisted pair (UTP) 
or shielded twisted pair (STP) cables; but to ensure FCC Class A and CE 
compliance, STP cables and STP Connectors are required.

•	 La technologie extension paires torsadées fonctionne avec les câbles paires 
torsadées blindées (UTP) ou non blindées (STP).  Afin de s’assurer de la 
compatibilité entre FCC Classe A et CE, les câbles STP et les connecteurs STP 
sont nécessaires.

NOTES:	

•	 This unit was tested with shielded I/O cables on the peripheral devices. Shielded 
cables must be used to ensure compliance with FCC emissions limits.

•	 For more information on safety guidelines, regulatory compliances, EMI/EMF 
compatibility, accessibility, and related topics, see the Extron Safety and 
Regulatory Compliance Guide on the Extron website.

Battery Notice
This product contains a battery. Do not open the unit to replace the battery. If the 
battery needs replacing, return the entire unit to Extron (for the correct address, see the 
Extron Warranty section on the last page of this guide).

CAUTION:	 Risk of explosion. Do not replace the battery with an incorrect type. 
Dispose of used batteries according to the instructions.

ATTENTION :	 Risque d’explosion. Ne pas remplacer la pile par le mauvais type de 
pile. Débarrassez-vous des piles usagées selon le mode d’emploi.
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Conventions Used in this Guide

Notifications
The following notifications are used in this guide:

ATTENTION:	

•	 Risk of property damage. 
•	 Risque de dommages matériels.

NOTE:	 A note draws attention to important information.

TIP:	 A tip provides a suggestion to make working with the application easier.

Software Commands
Commands are written in the fonts shown here: 

^AR Merge Scene,,Op1 scene 1,1 ̂ B 51 ̂ W^C

[01] R 0004 00300 00400 00800 00600 [02] 35 [17] [03]

E X! *X1&* X2)* X2#* X2! CE}

NOTE:	 For commands and examples of computer or device responses mentioned 
in this guide, the character “0” is used for the number zero and “O” is the capital 
letter “o.”

Computer responses and directory paths that do not have variables are written in the font 
shown here: 

Reply from 208.132.180.48: bytes=32 times=2ms TTL=32

C:\Program Files\Extron

Variables are written in slanted form as shown here:
ping xxx.xxx.xxx.xxx —t

SOH R Data STX Command ETB ETX

Selectable items, such as menu names, menu options, buttons, tabs, and field names are 
written in the font shown here:

From the File menu, select New.
Click the OK button.

Specifications Availability
Product specifications are available on the Extron website, www.extron.com.

Extron Glossary of Terms
A glossary of terms is available at https://www.extron.com/technology/glossary.aspx.
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Introduction 

This section describes this user guide and the DMP 128, including:

•	 About this Guide

•	 About the DMP 128 Digital Matrix Processor

•	 Features

•	 DMP 128 Application Diagram

About this Guide
This guide contains installation, configuration, and operating information for the 
Extron DMP 128 ProDSP Digital Matrix Processor.  

In this guide, the DMP 128 may also be referred to as “the mixer” or “device.”

About the DMP 128 Digital Matrix Processor
The Extron DMP 128 Digital Matrix Processor is a 12x8 audio mixer featuring 
Extron ProDSP, automixing, and I/O expansion capabilities, and is available with 
AEC - acoustic echo cancellation plus Dante™ audio networking. The DMP 128 offers 
a configuration approach to DSP to simplify mixing, routing, conferencing, and room 
optimization. Quick and intuitive configuration using the DSP Configurator Software allows 
DMP 128 installation in very little time, with easy-to-learn adjustments heard in real-time. 
A digital audio expansion port allows two DMP 128 units to be linked together to expand 
input and output signal management and routing capabilities. The DMP 128 is ideal for 
presentation and conferencing applications in boardrooms, courtrooms, and conference 
centers that require advanced matrix mixing with DSP. 

In addition, FlexInputs enable processing of Dante channels in place of the first four 
inputs. A single Ethernet cable from one or several linked units to a central equipment rack 
eliminates the need to pull one cable for each mic/line input. 

The DMP 128 has no front panel controls. All configuration is performed using the 
Extron DSP Configurator program from a host computer via any of the communication 
ports; RS-232, USB, or Ethernet (high-speed ports recommended). Signal presence and 
clip LEDs for the twelve input channels and eight output channels are on the front panel.

Features
•	 Six models with 12 mic/line inputs, 8 outputs and Extron EXP expansion bus 

Inputs �— Twelve balanced or unbalanced mic/line level on 3.5 mm, 3-pole and 6-pole 
captive screw connectors, eight with phantom power.

•	 Outputs �— Eight balanced or unbalanced line level on 3.5 mm, 6-pole captive screw 
connectors.

•	 FlexInput Channels — The first eight inputs provide FlexInput capability to route a 
Dante channel in place of a local mic/line input. The flexible input selection enables 
audio processing from remote wireless microphones, wallplates, and other sources from 
anywhere on the Dante network.
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•	 Eight channels of acoustic echo cancellation (AEC) �— The DMP 128 C models 
include eight independent channels of high performance AEC, as well as selectable 
noise cancellation. Extron AEC features advanced algorithms that deliver fast echo 
canceler convergence for optimal intelligibility in situations that challenge AEC 
performance, including double-talk, and the use of wireless microphones at the near 
end.

•	 Dante™ Audio Networking �— Dante equipped DMP 128CP AT models provide 
scalable audio transport over a local area network using standard Internet protocols. 
Each DMP 128 AT sends out 24 channels of 24-bit/48 kHz digital audio and can 
receive 56 channels over the network. A built-in four-port Gigabit switch provides 
direct interconnection of multiple DMP 128 AT units to create larger, cost-effective 
audio matrixes. Both Dante and the DMP 128 AT processor four-port switch are 
AVB - Audio Video Bridging ready. Dante is a trademark of Audinate® Pty Ltd.

•	 Digital audio expansion port for linking two DMP 128 units �— An expansion port 
allows any two DMP 128 models to be linked together via a single shielded CAT 6 
cable. This allows eight matrix mixes of the inputs, plus eight virtual paths to be sent 
and received between units.

•	 Automixer with eight gate groups �— The DMP 128 features an automixer with 
advanced features for managing signal levels from multiple microphones. The automixer 
includes a gating mode that automatically gates channels on or off, as well as a gain 
sharing mode that maintains the overall system gain based on the number of active 
mics.

•	 ProDSP audio signal processing �— The DMP 128 features 32/64-bit floating point 
audio DSP processing, which maintains very wide dynamic range and audio signal 
transparency, to simplify management of gain staging while reducing the possibility of 
DSP signal clipping. 

•	 48-volt phantom power �— The DMP 128 is equipped with selectable 48-volt 
phantom power for the first eight inputs, allowing the use of condenser microphones.

•	 24-bit/48 kHz analog-to-digital and digital-to-analog converters �— Fully preserve 
the integrity of the original audio signal.

•	 Fixed, low latency DSP processing �— Input to output latency is low within 
the DMP 128 and stays constant, regardless of the number of active channels or 
processes. While latency increases marginally on channels with AEC enabled, overall 
latency remains low. Fixed latency processing keeps audio in sync with video, and 
prevents distractions to presenters or performers resulting from delayed live audio.

•	 DSP Configurator Software �— A powerful yet user-friendly PC-based software 
tool for managing all audio operations of the DMP 128. It enables complete setup 
and configuration of digital audio processing tools on the ProDSP platform, as well as 
routing and mixing. 

•	 Intuitive Graphical User Environment �— The DSP Configurator Software features 
a graphical user environment that offers a clear view of all input and outputs, audio 
processing blocks, routing, mix-points, and virtual routing in a single screen. This allows 
a designer or installer to quickly view an audio configuration without having to access 
multiple dialog boxes or menus.

•	 Device Manager  �— Device Manager in the DSP Configurator Software enables 
easy configuration of multiple Extron DSP products, including two linked DMP 128 
processors, by toggling between graphical user environments for each unit. Processors 
can be grouped into folders for organizing as separate rooms or buildings. Settings for 
multiple Extron DSP products in the Device Manager can be saved to a single file.
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•	 Flexible control options �— The DMP 128 can be controlled using the DSP 
Configurator Software and a PC connection to the Ethernet port, the RS-232 serial port, 
or the USB 2.0 port on the front panel. The DMP 128 can also be controlled through a 
control system with Extron Simple Instruction Set (SIS) commands, and by accessing 
the internal Web pages.

•	 Copy and paste for processing blocks �— To help speed audio system design and 
setup, parameter settings can be quickly copied between individual processing blocks 
or identical groups of blocks within the graphical user environment, using conventional 
cut-and-paste commands. 

•	 Building Blocks processor settings �— A collection of pre-designed processor 
settings optimized for a specific type of input or output device, such as microphones 
and Extron speakers, with preset levels, filters, dynamics, and more. Flexible building 
blocks are available on each I/O strip and allow system designers to fully customize and 
save their own building blocks, further streamlining audio system design and integration.

•	 Live and Emulate operation modes with configuration file saving �— Live mode 
allows integrators to connect to the DMP 128 and make live parameter adjustments 
while hearing or metering them in real-time. This avoids the need to compile and upload 
a configuration file to the DSP. Emulation mode allows settings to be configured offline 
and uploaded to the DMP 128. The software also downloads configuration files from the 
mixer for archiving. Settings for two DMP 128 processors linked together can be saved 
to a single configuration file.

•	 32 DSP Configurator presets �— Using the DSP Configurator Software, any 
parameters for DSP processing, levels, or audio routing can be saved as presets. These 
settings can be saved for the entire system, or any selected group of inputs, outputs, 
mix-points, and DSP blocks. 

•	 20 digital I/O ports for remote control or feedback �— Twenty configurable digital 
I/O ports are provided, so that the DMP 128 can be programmed to sense and then 
respond to external triggers such as mic activation, muting, and recall of presets.

•	 Triple matrix design provides output, virtual, and expansion routing options �— 
Employs a triple matrix design that offers substantial flexibility in routing, mixing, and 
processing audio input sources. An output matrix allows any of the twelve inputs to 
be mixed to any or all eight outputs. If desired, any of the inputs can first be directed 
into a virtual matrix, which routes the inputs to eight virtual buses, before being mixed 
back into the output matrix. Virtual buses allow inputs to be processed together as a 
group. When two DMP 128 processors are linked together via the expansion ports over 
shielded CAT 6 cable, inputs and virtual buses of one unit can be routed to the other 
processor through an expansion matrix, for additional processing or matrix mixing into 
the outputs.

•	 Group masters �— The DMP 128 provides the capability to consolidate gain or mute 
control throughout the system. Gain or mute controls can be selected and added to a 
group master, which can then be controlled by a single master fader or mute control. 
Each group master can have up to 16 members, and up to 32 group masters can be 
created.
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DMP 128 Application Diagram
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Installation 

This section describes the installation of the DMP 128, including:

•	 Mounting the DMP 128

•	 DMP 128 Models

•	 Hardware Configuration

•	 Rear Panel Features and Cabling

•	 Front Panel Indicators

•	 USB Configuration Port (Front Panel)

•	 Reset Actuator and LED

Mounting the DMP 128
The 1U high, full rack width, 8.5-inch deep DMP 128 Digital Matrix Processor can be:

•	 Set on a table, 

•	 Mounted on a rack shelf, 

•	 Mounted under a desk or tabletop.

For detailed mounting options and UL rack mounting guidelines, (see 
Mounting the DMP 128 on page 165).

DMP 128 Models
There are six models of the DMP 128 available. Each model has a different feature set for 
various applications.

DMP 128 Model Matrix

The following feature matrix provides a breakdown of the various DMP 128 model variations. 
Where differences occur in operation, they are noted in the text.

Model Description

DMP 128 12x8 ProDSP Processor

DMP 128 C 12x8 ProDSP Processor with AEC

DMP 128 AT 12x8 ProDSP Processor with Dante Interface

DMP 128 C AT 12x8 ProDSP Processor with AEC, EXP Bus, and Dante Interface

DMP 128 C P 12x8 ProDSP Processor with EXP Bus, AEC, and Telephone modem

DMP 128 C P AT 12x8 ProDSP Processor with AEC, Telephone modem, EXP Bus, and 
Dante Interface

Hardware Configuration
The DMP 128 does not have physical controls for configuration or operation. 

The DMP 128 has several front and rear panel operational indicators and a rear panel reset 
button for hardware resets outlined in the following pages.
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Rear Panel Features and Cabling
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Figure 1. DMP 128 Rear Panel (DMP128 C P AT shown)

A	 AC power connector G	 RS-232 connector — for SIS control

B	 Phantom power indicators (MIC +48V) H	 EXP port connector — for adding an additional 
DMP device

C	 Mic/Line connectors — inputs 1 to 8 I	 LAN connector

D	 Mic/Line connectors — inputs 9 to 12 J	 Reset button and LED indicator 

E	 Output connectors — outputs 1 to 8 K	 AT connections (AT models only) — Four RJ-45 
jacks for Ethernet connection

F	 Digital I/O connectors — I/O 1 to 20 L	 Telephone connections (P models only)  

A	 Power connector — IEC power connector 100 to 240 VAC, 50 — 60 Hz

B	 Phantom Power indicators (MIC +48V) — LEDs light when +48 V phantom power 
is placed on the corresponding mic/line input. Phantom power voltage is not adjustable 
and is only available to Mic inputs 1 through 8.

ATTENTION:	

•	 Condenser microphones require phantom power.  
Dynamic microphones do not require power. 

•	 Les microphones électrostatiques nécessitent une alimentation fantôme.  
Les microphones dynamiques n’ont pas besoin d’alimentation.

•	 Never set an unbalanced dynamic microphone to +48 V. Doing so may 
damage the microphone. 

•	 Ne réglez jamais un microphone dynamique asymétrique à +48 V. Cela 
pourrait endommager le micro.

•	 For condenser microphones, verify it safely operates at +48 VDC.

•	 Pour les microphones électrostatiques, vérifiez qu’ils fonctionnent bien à 
+48 Vcc.

•	 When a line level source is connected, be certain the +48 V phantom power is 
off (cleared).

•	 Lorsqu’une source de niveau ligne est connectée, soyez certain que 
l’alimentation fantôme +48 V est débranchée (enlevée).
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C	 Mic/Line 1-8 input connectors — Eight 3-pole 3.5 mm captive screw connectors 
accept balanced or unbalanced mono mic or line level signals and provide phantom 
power. Mic/line inputs provide gain settings to accommodate consumer (– 10 dBV) 
and professional (+ 4 dBu) operating line level sources, plus mic level sources. Up to 
eight mono mics or line inputs, balanced or unbalanced in any combination can be 
connected to these inputs, (see figure 2).

Audio Output Wiring

Audio Input Wiring

Unbalanced Output

Tip

Sleeve
NO Ground Here

Balanced Output

Tip

Sleeve
Ring

Unbalanced Input

Tip
Sleeve

Balanced Input

Tip

Sleeve
Ring

Do not tin the wires!

Do not tin the wires!

Figure 2. Balanced or Unbalanced Mic and Line Input Wiring

D	 Mic/Line 9-12 input connectors — Four 6-pole 3.5 mm captive screw connectors 
accept balanced or unbalanced mono mic or line level signals. Mic/line inputs provide 
gain settings to accommodate consumer (– 10 dBV) and professional (+ 4 dBu) line level 
sources, plus mic level sources. Up to four mono mics or line inputs (or two stereo line 
inputs), balanced or unbalanced in any combination can be connected to these inputs. 

E	 Mono output connectors — Four 3.5 mm, 6-pole captive screw connectors provide 
up to eight balanced or unbalanced connections for mono line level output signals.Audio Output Wiring

Audio Input Wiring

Unbalanced Output

Tip

Sleeve
NO Ground Here

Balanced Output

Tip

Sleeve
Ring

Unbalanced Input

Tip
Sleeve

Balanced Input

Tip

Sleeve
Ring

Do not tin the wires!

Do not tin the wires!

ATTENTION:	

•	 For unbalanced audio, connect the sleeves to the ground contact. DO NOT 
connect the sleeves to the negative (–) contacts.

•	 Pour l’audio asymétrique, connectez les manchons au contact au sol. Ne PAS 
connecter les manchons aux contacts négatifs (–).

Figure 3. Output Connector Wiring

F	 Digital I/O connectors — Four 3.5 mm, 6-pole 
captive screw connectors each provide five 
configurable digital input or output ports allowing 
connection of up to twenty various devices such 
as motion detectors, alarms, lights, LEDs, buttons, 
photo (light) sensors, temperature sensors, and other 
devices. 

Do not tin the wires!

(5 mm) MAX. 3 "
16  

1
2
3
4
5

Digital I/O Wiring
Figure 4. Digital I/O Wiring

Digital I/O ports monitor or drive TTL level digital signals. The inputs can be configured 
to operate in one of two modes: digital input or digital output. In output mode, the 
device can source up to 250 mA at +5 V. In Input mode, voltages greater than 1 V 
indicate a logic ‘high’ signal while voltages less than 1 V indicate a logic ‘low’.

All digital I/O ports are tied to a common ground (one common ground for each 6-pole 
connector), but can be individually configured to operate in one of two modes: digital 
input or digital output 

NOTE:	 These ports can be configured via the DSP Configurator (see 
Digital I/O Ports on page 89).
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G	 RS-232 connector — One 3.5 mm, 
3-pole captive screw connector, labeled 
RS-232, for bi-directional RS-232 (±5 V) 
serial control. Default baud rate is 38400. 
The RS-232 port is not intended to be 
used for configuring the DMP 128.

Receive (Rx)
Transmit (Tx)

Ground (G)

Bidirectional

RS-232
Device

Ground (    )
Receive (Rx)
Transmit (Tx)

RxTx G

G

Do not tin 
the wires!

Figure 5. RS-232 Wiring

H	 EXP port connector — One RJ-45 jack for connection to an additional DMP 128 EXP 
port connection. 

NOTE:	 A one foot shielded CAT 6 cable is provided for the EXP connection. 
A shielded Cat 6 cable wired in a straight through configuration up to 35 feet 
(10 meters) can be used.

I	 LAN connector — An RJ-45 jack accepts a standard Ethernet cable for network 
connection. The control system and DMP 128 must be connected to the same 
network.

NOTE:	 To connect the DMP 128 directly to a computer Ethernet port, use a 
crossover Ethernet cable.

•	 A yellow LED indicates data activity on the connection.

•	 A green (Link) LED indicates the jack is connected properly to the network. 
See SIS Programming and Control on page 129 for additional information on 
Ethernet cabling.

J	 Reset button and LED indicator — The reset button returns the DMP 128 to 
different tiers of default states and can place the unit into an event recording mode for 
troubleshooting. When using the reset function, the LED blinks to signify the different 
tiers (see DMP 128 Hardware Reset Modes on page 169). When not in reset mode, 
the LED operates as a power indicator, duplicating the front panel LED operation.

K	 AT connections (AT models only) — Four RJ-45 jacks for Ethernet connection form 
a 4-port Gigabit switch that interfaces with the AT bus. The AT port expansion bus 
uses the Dante protocol for digital media networking allowing connection of multiple 
DMP 128 AT models to form a larger matrix. 

The AT bus supports 56 channels of audio input (Rx) per DMP 128 AT model. 
Output channel support (Tx) includes the eight line outputs, eight virtual returns (post 
processing), and eight expansion outputs for a total of 24 channels. Audio from an 
AT port is placed on a network and the audio channels assigned to the network are 
available to any Dante‑compatible device on the network, such as another DMP 128 AT. 

NOTE:	 The Dante Controller software is required for configuration of the AT 
expansion bus (see Dante Controller Software Installation on page 114).

L	 Telephone connections (P models only) — These optional connections provide 
telephony access.
The plain old telephone system (POTS) interface provides two RJ-11 telephone jacks 
to connect to the incoming phone line (LINE) and to the telephone (PHONE).  The 
telephone interface follows all applicable US and International standards.

ATTENTION:	  

•	 For telephone and network cabling, to reduce the risk of fire, use a minimum 
conductor size of 26 AWG, UL Listed or CSA Certified Telecommunication Line 
Cord.

•	 Concernant le câblage téléphonique et réseau, afin de réduire le risque 
d’incendie, utilisez une taille de conducteur de 26 AWG minimum, listée UL ou 
un cordon de ligne téléphonique certifié CSA.
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Front Panel Indicators

DMP 128
DIGITAL MATRIX PROCESSOR

CONFIG

1
CLIP

SIGNAL

INPUTS OUTPUTS
1

CLIP

SIGNAL

2 3 4 5 6 7 8 9 10 11 12 2 3 4 5 6 7 8

EXP LAN          

ACTIVITY

E FA CDB

Figure 6.	 DMP 128 Front Panel

A	 Power LED — The power indicator blinks during power-up and firmware uploads; and 
lights solid when the DMP 128 is operational. 

C	 EXP Activity Indicator — Green LED labeled EXP for the expansion audio port

•	 non-AT models

Off — The unit is not connected to a second DMP 128.

On — The unit is connected to another DMP 128 and configured as the primary 
unit.

Blinking — The unit is connected to another DMP 128 and is currently configured 
as the secondary unit.

•	 AT Models 

Off — Dante device is not responding.

On — The EXP port is connected to a non-AT DMP 128 and configured as the 
primary unit.

Blinking — The EXP port is not connected.

D	 LAN Activity Indicator — Green LED labeled LAN Indicates activity on the 
corresponding rear panel Ethernet port connection. 

E	 Input Indicators — Stacked red (signal clipping) and green (signal present) LEDs for 
inputs 1 through 12 . Each stack represents one input channel.

The green signal LED varies in brightness corresponding to the real-time input and 
output signal level (see item F, below). It begins to light at - 60 dBFS increasing 
in steps to full intensity as the signal level increases. When the signal level reaches 
- 3 dBFS or above, the red clipping LED lights and remains lit as long as the signal 
remains above - 3 dBFS. When it falls below that level, the red LED remains lit for 200 
milliseconds, after which the display resumes real‑time monitoring of the signal level.

F	 Output Indicators — Stacked red (signal clipping) and green (signal present) LEDs for 
outputs 1 through 8. Each LED stack represents one output channel.

USB Configuration Port (Front Panel)
A front panel configuration port (see figure 6, B) uses an Extron USB A Male to USB mini-B 
Male Configuration Cable for connection to a PC computer USB port.

The USB 2.0 port uses a mini B connector to connect to a host computer for control. The 
DMP 128 USB driver must be installed prior to using the port (see Installing the USB 
Driver on page 17). 

NOTE:	 The DMP 128 appears as a USB peripheral with bi-directional 
communication. The USB connection is used for software operation (see Software 
Installation on page 13) and SIS control (see SIS Programming and Control 
on page 129).
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Reset Actuator and LED
A recessed button on the rear panel initiates several reset modes. The associated rear panel 
LED blinks to indicate the reset mode. 
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Figure 7.	 Reset Button and LED

Hardware Reset Modes:

NOTE:	 The reset modes listed below close all open IP and Telnet connections, and 
close all sockets. 

With power on, when the reset button is held down, the LED blinks every three seconds. At 
the first blink, mode 3 is available. At the second blink, mode 4 is available. At the third blink,  
mode 5 is available. The reset modes have separate and distinct functions outlined below 
(see DMP 128 Hardware Reset Modes on page 169). 

Mode 1 — Firmware reset:  Disconnect power to the DMP 128. Press and hold the reset 
button while applying power to return the firmware to the version shipped with the unit 
from the factory. Event scripting does not start when powered on in this mode. This allows 
recovering a unit with incorrect or corrupt firmware. 

All user files and settings are maintained. When returning the unit to an earlier firmware 
release, some user Web pages can work incorrectly.

Mode 3 — Events reset:  With power on, press and hold the reset button until the reset 
LED blinks once (~3 seconds). Release the reset button then, within 1 second, press it 
again to toggle events on or off, depending on the current state.

•	 If event logging is currently stopped, following the momentary (<1 sec.) press, the reset 
LED blinks twice indicating events logging has begun.

•	 If any events are currently running, following the momentary (<1 sec.) press, the reset 
LED blinks three times indicating the events logging has stopped. 

If the second momentary press does not occur within 1 second, Mode 3 is exited.

Mode 4 — IP Address reset:  With power on, press and hold the reset button until the 
reset LED blinks twice (about 6 seconds). Release the reset button; then, within 1 second, 
press it again to reset the IP settings. 

Mode 4:

•	 Enables ARP program capability

•	 Sets IP back to factory default IP address (192.168.254.254)

•	 Sets subnet back to factory default (255.255.0.0)

•	 Sets gateway back to factory default (0.0.0.0)

•	 Sets digital I/O port mapping back to factory default

•	 Turns DHCP off

•	 Turns events off

If a second momentary press does not occur within 1 second, the reset is ignored.
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Mode 5 — Factory default reset:  With power on, press and hold the reset button until 
the reset LED blinks 3 times (~9 seconds). Release then momentarily (<1 second) press the 
reset button to return the DMP 128 to factory default conditions. If the second momentary 
press does not occur within 1 second, the reset is exited. 

The default (reset) state of the device is:

•	 All mix‑points are set to 0 dB gain and muted

•	 Input 1 is routed to Output 1

•	 Input 2 is routed to Output 2

•	 Input 3 is routed to Output 3

•	 Input 4 is routed to Output 4

•	 Input 5 is routed to Output 5

•	 Input 6 is routed to Output 6

•	 Input 7 is routed to Output 7

•	 Input 8 is routed to Output 8

•	 All outputs active (unmuted, 100% volume).

•	 No inserted or active DSP processing.

•	 All audio inputs are set to 0 dB gain and muted. 

•	 All preset and group master memory is clear (empty).

Digital I/O Ports
The four 3.5 mm, 6-pole captive screw connector Digital I/O ports provide twenty 
configurable digital input or output ports designed to connect to various devices such as 
motion detectors, alarms, lights, LEDs, buttons, photo (light) sensors, temperature sensors, 
relays (requiring ≥30 mA), and others.

All ports are tied to a common ground (one common ground for each 6-pole connector), but 
can be individually configured to operate in one of two modes: digital input or digital output. 

The ports are configured using DSP Configurator. Each port can be configured to monitor or 
drive TTL level digital signals (see Digital I/O Ports on page 89).

 

DMP 128 • Installation and Operation 11



DMP Software

This section describes the control software for the DMP 128, including:

•	 Software Control

•	 Software Installation

•	 DSP Configurator Program Basics

•	 Audio level, Mix‑point, Processing 
Blocks, and Signal Chains

•	 Mic/Line Input Signal Chain 
Controls

•	 Line Output Channels

•	 Virtual Bus Returns

•	 Output Mix Matrix

•	 Virtual Send Bus Mix Matrix

•	 Expansion Outputs Mix Matrix

•	 Extron EXP Bus

Software Control
The DMP 128 can be controlled using the DSP Configurator software, using SIS commands 
with hyper terminal or Extron DataViewer (see SIS Programming and Control on 
page 129), and accessed using embedded Web pages (see HTML Operation on 
page 156). 

The DMP 128 has the following connection options:

•	 RS-232 — One single 3.5 mm, 3-pole captive screw connector is used for bi‑directional 
RS-232 (± 5 V) serial control. See Rear Panel Features and Cabling on page 6, 
for additional details on connecting the RS‑232 port.

•	 LAN — 10 Mbps, 100 Mbps, half duplex, full duplex connections are supported. Two 
LEDs indicate connection and activity status. The device has the following default 
Ethernet configurations:

IP Address: 192.168.254.254 Default Gateway:  0.0.0.0

Subnet Mask: 255.255.0.0 DHCP: OFF

See Rear Panel Features and Cabling on page 6, and Connection Options on 
page 129 for additional details on connecting the LAN.

•	 USB 2.0 — A USB mini-B connector located on the front panel provides high‑speed 
USB 2.0 connectivity to a host computer, backward compatible to 1.0.

•	 Device Manager

•	 AT (Dante) Bus

•	 Group Masters

•	 Digital I/O Ports

•	 Emulate Mode and Live Mode

•	 Presets

•	 Protected Configuration

•	 DSP Configurator Windows Menus

•	 Optimizing Audio Levels

•	 Signal Path Building Blocks
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Software Installation
The DMP 128 has no front panel hardware controls. To configure and operate the DMP 128, 
use a PC running Microsoft® Windows® 7 or newer and the following software programs:

•	 Dante Controller for Windows from Audinate is required by all DMP 128 AT models 
to select and route digital inputs and outputs to and from connected Dante‑compatible 
devices on the same network and to rename connected devices.

•	 DSP Configurator is used to customize signal processing for the input channels of all 
DMP 128 models.

Both DSP Configurator and Dante Controller are available from the DMP 128 product page 
on the Extron Website.

Signal processing for the DMP 128 can also be controlled using the Extron Simple 
Instruction Set (SIS) commands with HyperTerminal or DataViewer (see SIS Programming 
and Control on page 129). Digital signal routing can only be done using Dante Controller 
from Audinate.

See Rear Panel Features and Cabling on page 6, and Ethernet (LAN) Port on 
page 130 for additional details to connect via the LAN ports.

Software Installation Overview
DSP Configurator and Dante Controller (DMP 128 AT models only) must be installed to 
configure the device and route transmit and receive channels. Download and install both 
software programs in the order they are listed below:

1.	 Download Dante Controller for Windows from the Extron Website (see Dante 
Controller Software Installation on page 114).

2.	 Install Dante Controller.

3.	 Rename each device as it is placed on the network (when there are multiple 
DMP 128s on the network) (see Rename a Dante Device on page 121).

NOTES: 	

•	 To avoid confusion, rename each device with a unique identifier. 

•	 To simplify renaming, connect only one device to the network at a time. As 
each device is renamed, it can remain on the network.

4.	 Download DSP Configurator (see Downloading and Installing DSP Configurator 
on page 15).

5.	 Install DSP Configurator.
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Downloading Dante Controller for Windows
1.	 On the Extron Electronics website, click the Download tab (see figure 8, 1).

2.	 On the Download page, click the Dante Controller link (2) on the left sidebar.

Figure 8.	 Dante Controller Link on the Download Page

3.	 On the Dante Controller page, click the Download button (see figure 9).

Figure 9.	 Download Button on Dante Controller Page
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4.	 Fill in the requested information (2), and click Download dantecontrollernxnxn.exe 
(3).

22

33

Figure 10.	 Download Center - Download Dante Controller Page

5.	 Depending on your browser, either run the file, or save it to a known location for 
installation at a later time. 

Downloading and Installing DSP Configurator
1.	 On the Extron Electronics website, click the Download tab (see figure 11, 1).

2.	 On the left sidebar, click the DSP Configurator link (2).

Figure 11.	 DSP Configurator Link on the Download Page
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3.	 On the DSP Configurator page, click Download.

Figure 12.	 Download Center - Download DSP Configurator

4.	 On the Download Center page, fill in the requested information (see figure 13, 1) and 
click Download dsp_configurator_nxnxn.exe (2).

Figure 13.	 Download Center - Download Dante Controller Screen

5.	 Depending on your browser, run the file (or save it to a known location for installation at 
a later time).

6.	 On the Open File - Security Warning dialog box, click Run. 

7.	 Follow the instructions to install the DSP software.
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Installing the USB Driver
Although USB drivers are not needed for the DMP 128, during the first installation of 
DSP Configurator, a USB driver also loads. 

When the USB installer begins:

1.	 When the driver installation dialog opens, click Next to proceed (a status window tracks 
the installation).

Figure 14. USB Installer Splash Screen

2.	 The USB driver installer launches. When the installer completes the installation of the 
USB drivers, the following dialog opens:

Figure 15. Successful USB Driver Installation

3.	 Click Finish.

USB driver installation is complete.
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DSP Configurator Program Basics

Starting the Program

NOTE:	 Extron recommends connection via the Ethernet LAN port for running the 
DSP Configurator program.

To run the DSP Configurator Program, click  
Start > Programs > Extron Electronics > DSP Configurator > DSP Configurator. 

Select the DMP 128 model and click OK.

DSP Configurator starts in Emulate mode (see figure 16, next page, and see Emulate 
Mode and Live Mode on page 90).

Using the Program
In the DSP Configurator Emulate mode, audio parameters can be selected and transferred 
to the DMP 128 by switching to Live mode (while connected to a DMP 128) and pushing 
the configuration. Audio settings can also be tailored while connected to the DMP 128 for 
real‑time auditioning of the audio output as adjustments are made  
(see Emulate Mode and Live Mode on page 90).

DSP Configurator Main Screen

The main screen contains controls for the input and output channels, virtual sends and 
returns, expansion outputs and inputs, and other information used in the operation of the 
DMP 128. There is too much information contained on the main screen to enable viewing of 
the entire mix board at one time, so several methods, outlined on the following pages, are 
provided to scroll through the screen. 
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Figure 16.	 DMP 128 Navigation Aids

A	 Toolbar — All tools and functions not directly available on the main screen are found 
here.

BC	 Minimize/Maximize buttons — Click to toggle the view of a selected section 
from minimum to maximum. For example, the Inputs section (B) is maximized with 
all processor blocks and the mix‑points shown. Click to toggle the view from maximum 
to minimum. The Virtual Returns section (C) is minimized with all blocks and 
mix‑points hidden. Click the button in this example to expand the view to its maximum 
screen area.

D	 Scroll Bar — When the sections are maximized such that the screen area takes up 
more space than can be displayed at one time, items are pushed down or up and no 
longer appear. Use the scroll bar to bring those items back into view.

E	 Channel Numbers — <Right-click> the channel number to hide a channel that has no 
device connected or is not used in the current configuration. 

NOTE:	 To show hidden channels, highlight View > Show All Channels. A menu 
of additional options expands. From here, select the desired hidden channels to 
display.
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Figure 17.	 DMP 128 DSP Configurator Main Screen

The DSP Configurator program screen consists of an input and virtual return signal 
processor chain, the mix-points, and an output signal processing chain. 

The main mixer is separated into segments as shown in figure 17. 

NOTE:	 The expansion bus input mix-points are not shown in this view.

A	 Input gain controls H	 Virtual returns signal processor 
channels and pre-mixer gains

B	 Input signal processor channels I	 Virtual returns to output mix‑points

C	 Input pre-mixer gains J	 Virtual returns to virtual sends 
mix‑points

D	 Inputs to Outputs mix‑points K	 Virtual returns to EXP sends mix‑points

E	 Output trim control (post-mixer trim) L	 Virtual send bus to virtual returns 
mix‑points

F	 Output signal processor channels M	 Inputs to expansion sends mix‑points

G	 Output volume controls
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Cut, copy, and paste functions

The user can cut, copy, or paste a processor. These actions can be performed from a 
context menu accessed with a right-click on the processor block, using the Edit menu, or 
using the standard Windows keystrokes:  
	 <Ctrl+X> = cut; <Ctrl+C> = copy; <Ctrl+V> = paste. 

Multiple elements can be acted upon but the blocks copied must be compatible with the 
desired paste blocks. A highlighted group of elements can be cut or copied to a clipboard. 
The clipboard contents can then be pasted, but succeeds if there is an exact one-to-one 
relationship between the clipboard contents and the block or blocks they are pasted into. 

In the following example, the Mic #1 input signal path is copied to Mic #5. First click the 
mouse and drag it across the entire signal path. The selected blocks are highlighted in 
green. Press <Ctrl+C>, or use the Edit > Copy menu selection to copy the blocks.

As shown below, the starting point for the paste, (the upper/leftmost element), must first 
be focused by clicking the mouse on it. Note the green focus outline that appears on the 
Mic #4 Gain block. The clipboard elements are pasted using the context menu Paste 
command, the Edit>Paste command from the toolbar, or <Ctrl+V>.

NOTE:	 A cut and copy of elements can be pasted to multiple locations. To copy the 
clipboard to an additional location, click on the leftmost block and paste again. 

The program warns that all settings in the section pasted to will be overwritten:

Click Yes. 
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The entire Mic #4 input path is now identical to the Mic #1 input path including signal levels, 
parameters settings, and mute/bypass selections.

Any single processor block is copied and pasted to a similar processor block in the same 
or different input, virtual or output signal path. Mix‑point gains can be copied from one to 
another. Input gain, pre‑mixer gain, post-mixer trim, and output volume can only be copied 
to like gain blocks. For example, an input gain can be copied to any other input gain, but 
cannot be copied to a pre-mixer gain, post-mixer trim, or output volume. Mix‑point settings 
can be freely copied between mix‑points. The user is always asked whether they want to 
overwrite the existing information. If an attempt is made to copy a processor block setting to 
an incompatible block, the user is warned the action cannot be completed.

Navigation

There are two methods of navigation around the screen: 

•	 Keyboard •	 Mouse

When a new DSP Configurator file is opened, the upper left element (Output #1 Trim) is the 
focus by default.

Keyboard navigation

All screen elements including mix‑points have the ability to receive focus using the tab and 
arrow keys or using the arrow keys following a single click (see Keyboard Navigation on 
page 98).

Mouse navigation

Left-click — Click on a processor block to bring focus to the block, as well as other 
elements such as tabs, sliders, check boxes associated with the block. Other left-click 
actions follow the Windows standard. In this user guide, “click” always refers to a left-click of 
the mouse button.

Right-click — A single right-click on a block brings up a context menu specific to that 
processor block. Other right-click actions follow the Windows standard.

Double-click — Double-click on a box to open it from either the focused or unfocused 
state of an element. 
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Toolbar

DSP Configurator Toolbar Menus

The DSP Configurator contains the following menu bar, arranged horizontally below the title 
bar:

• File • Edit • View • Tools • Window • Help

File menu	

NOTE:	 New, Open, and Recent Files are unavailable in 
Live mode.

•	 New — Discards the current DSP configuration (after 
prompting to save changes) and opens a blank configuration 
file.

•	 Open — Loads and activates a previously saved DSP 
configuration file.

•	 Save — Saves all changes to the current DSP configuration 
file under the current file name. If the file was not previously 
saved, DSP Configurator prompts for a file name.

•	 Save As — Saves all changes to the current DSP configuration file under a new file 
name.

•	 Backup — Recalls and transfers all partial presets plus the current configuration to a 
DSP configuration file within the DSP Configurator program.

•	 Recent Files — Opens a list of recently opened or saved DSP configuration files.

•	 Exit — Closes the DSP Configurator Program.

Edit menu	

•	 Cut — Removes all parameters of a selected processor 
block or set of selected blocks to the clipboard. If not 
followed by a Paste command to a different block, the 
parameters are restored.

NOTE:	 Processor blocks and their parameters can be pasted only into another 
block of the same type. For example, the input 1 filter block and all of its 
parameters can be copied to the input 2 filter block but not to the input 1 delay 
block.

•	 Copy — Copies all parameters of a selected processor block, gain block, or set of 
selected blocks to the clipboard.

•	 Paste — Inserts processor blocks and their parameters from the clipboard into the 
location selected.

 

DMP 128 • Software Control 23



View menu		

•	 Meter Bridge — Opens a Meters dialog box with 
real‑time meters that monitor signal levels at each input 
and output.

Figure 18. Meter Bridge

NOTE:	 Meter Bridge is available in Live mode only while connected through the 
LAN port.

•	 Re-enable All Dialogs — Re-enables all dialog 
boxes, the pop-ups that allow changes to block 
parameters.

•	 Group Controls — Opens the Group Controls 
dialog box (see Group Masters on page 83).

•	 AT Meters  
(AT models only) — Allows the user to view the AT 
meters for an attached Dante device.

To view the meters: 

1.	 From the main DSP Configurator toolbar, 
select View > AT Meters.

2.	 The Browse and Select the Device dialog box opens (see right). 

3.	 Double-click the applicable device. The meter display opens showing the Tx and Rx 
channels. See Viewing AT Channels with AT Meters on page 126 for addtional 
information. 

•	 Show All Channels — Enables channels previously hidden from the main menu to be 
viewed. The selection provides an option to either show all hidden channels for that 
selection, or by moving to the right, an individual channel can be selected while leaving 
the others hidden.
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Tools menu		

The Tools menu contains the following items and sub-menu:

•	 Presets — Provides three options:

•	 Mark All Items — Marks (selects) all parts of the 
current configuration (excluding presets), including 
processors and mix‑points to save as a partial preset.

•	 Save Preset — Saves the currently marked processor, 
and mix‑points as a partial preset.

•	 Clear Marked Items — Unmarks (deselects) all parts 
of the current configuration (excluding presets), including 
processors and mix‑points.

•	 Protected Configuration (live mode only)— Allows a 
user (typically the installer) to save and recall a protected 
configuration. The protected configuration is useful to place the parameters and 
values (with the exception of the device IP address) in a known state, either as a 
troubleshooting tool or as a baseline configuration. The protected configuration, 
once saved in the device, is always present and cannot be overwritten without 
entering a user-defined Personal Identification Number (PIN) password. The protected 
configuration is restored without a PIN.

NOTE:	 The default PIN is 0000.

•	 Save — Saves the current configuration (excluding presets), including processors 
and mixes as a password protected configuration. The DSP Configurator program 
prompts for a PIN to save.

•	 Recall — Recalls the protected configuration.

•	 Change PIN — Changes the PIN associated with the protected configuration.

•	 Configure Digital I/O — Opens a utility to configure digital I/O ports. The DMP 128 
provides twenty digital I/O ports used to trigger external events from internal actions and 
for external events to trigger DMP actions (see Digital I/O Ports on page 89).

•	 Connect to / Disconnect from Device (depending on Emulate or Live mode) — 
Performs the same functions as the Mode Emulate and Mode Live buttons.

•	 Device Manager — Opens the Device Manager dialog box. If a device is connected, 
displays the details (model, MAC address, IP address). In addition, a device can be 
added or removed, or a selected device cloned, and new folders can be added to an 
existing device (see Device Manager on page 82).

•	 Issue RESET Command — Initializes and clears the following: mix‑points, presets, 
processor blocks, and gain blocks. This reset is identical to the E ZXXX} SIS 
command (see SIS Programming and Control on page 129).

•	 Save Changes to Device (live mode only) — Saves configuration changes in the 
DMP 128 to non-volatile memory. This is advised if you are about to power off the 
device.

•	 Firmware Loader — Launches the Firmware Loader program for firmware updates 
(see Firmware Loader on page 168).

•	 Organize Building Blocks — Provides organization of listed building blocks. You can 
also import the building blocks file to use your set of building blocks on other computers 
or export a building blocks file from another computer to use on yours (see Signal Path 
Building Blocks on page 106).

•	 Configure Groups — Opens the Configure Groups dialog box (see Group Masters 
on page 83).
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•	 Device Settings (live mode only) — Opens a dialog box to change the IP address, 
set administrator and user passwords, change the device name, change the date and 
time, and select the serial port baud rate. 

NOTES:	

•	 The factory configured passwords for all accounts on this device have been set 
to the device serial number. Passwords are case sensitive.

•	 If the device is reset, the password reverts to the original password 
configuration, which is no password.

•	 Network Audio Control — Launches Dante Controller to facilitate the discovery of 
networked audio devices that are compliant with the network audio standard used by 
the DMP 128. Discovery is invoked upon launch and retrieves the device name, audio 
channels, IP address and the MAC address (see Dante Controller Configuration on 
page 119).

•	 Phone Dialer — Opens a dialog box that provides telephone service capability for 
answering and initiating calls to remote attendees participating in a conferencing session 
(see Telephone Rx (DMP 128 C P and DMP 128 C P AT only) on page 59).

•	 Options — Opens a dialog box that allows customization of 
the DSP Configurator appearance and operation.

•	 Appearance — Tailor the appearance of the various 
graphs and dialog boxes. Appearance uses a selected 
color scheme for the complimentary and graph colors. 
Complimentary Colors allows custom selection of colors 
used with the various graphs and dialog boxes. Graph 
Colors changes the row colors containing the information 
and descriptions of the graphs seen in the processor 
blocks.

•	 Preferences — Contains general software options. The 
startup splash screen contains options for selection of the 
devices to connect to, or to Always ask on startup. That 
selection can be changed using Default Device. 

NOTE:	 If Show Meters is set to True, Dynamic Block Meters can be used to 
tailor the appearance of the dynamics meters in order to use the full meter to 
show input and gain reduction, or to show the level based on the output and 
gain reduction. 
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•	 Processor Defaults, Reset All Defaults — Returns 
the DMP 128 processor and level control blocks to factory 
default settings. Each processor,  and gain/volume/trim 
block also has an individual default reset.

•	 Processor Defaults, Defaults — Individually selects the 
default parameters for the various processor, trim, and gain 
blocks. 

Each row item contains default settings customized for the 
processor, filter, trim, or gain block it represents. 

Gain and volume blocks can be initially muted, while filter 
and dynamics processor blocks can be initially bypassed. 

NOTE:	 The bypass function is labeled Enable.

•	 To view the individual processor defaults, press [

>

] to the left of the processor, trim, 
gain, or meter device.

•	 Expansion Bus (live mode only) — Provides 
a means to select control of either the 
primary or secondary device (see Extron 
EXP Bus on page 80).

Window Menu	

•	 Cascade — Rearranges all open DSP Configurator program 
screens, including dialog boxes, in a cascading array.

•	 Close All Windows — Closes all open dialog boxes.

•	 Individual Windows — Lists all open dialog boxes. Clicking on the name brings the 
associated dialog box to the front of the desktop.

Help Selection

The Help menu contains the following elements:

•	 Contents — opens the Help file at the Contents tab.

•	 Search — opens the Help file at the Search tab.

•	 About... — displays the name of the application, the current version number, and 
copyright information. 

NOTE:	 Help can be activated via the F1 key from any main screen or dialog (which 
accesses context sensitive Help).
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Presets Drop-down
This drop-down list displays up to 32 presets. Select a preset to 
display and either activate (Recall), abort the selection without either 
recalling or deleting (Cancel), or delete it (Delete).

NOTE:	 An asterisk in the drop-down list indicates a preset exists only in the DMP 128 
and has not been downloaded to DSP Configurator. After recall, the asterisk is 
removed. 

Mode Buttons 
Provides selection between Live mode and Emulate mode (see 
Emulate Mode and Live Mode on page 90).

Backup

In Live mode (connected to a DMP 128), when presets exist in the DMP 128 that are not 
present in DSP Configurator (indicated by an asterisk next to the preset name), the function 
halts and prompts the user to run a backup.

Backup (File > Backup) automates the recall of presets from the DMP 128 to a DSP 
configuration (.edc) file within DSP Configurator and displays a prompt to save the file to the 
hard drive. Backup is unavailable when the DSP Configurator program is in Emulate mode.

NOTE:	 A backup should not be performed during a live event.
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Figure 19.	 Control Blocks and Processor Chains

Audio Level, Mix‑point, Processing Blocks, and Signal Chains
As outlined in red above (see figure 19), all control blocks on the main DSP control screen 
have one of three main functions in the overall signal chain:

•	 Level control (gain, trim, volume)

•	 Mix‑point (signal routing)

•	 Signal processing (filter, AEC, feedback, dynamics, delay, duck, loudness, and automix)

The signal chain varies depending on whether it is in the input, output, virtual bus, or EXP 
bus stage. Each of the three types of signal processing channels; Input (A, B, C), 
Output (D, E, F), and Virtual (H) shown in figure 19, consist of a series of two basic 
types of control blocks specific to that chain: level control (gain A, C, trim E, and volume 
control g), and signal processors (frequency filters, feedback suppression, dynamics, delay, 
ducking, AEC, AM, and loudness). Both types of control blocks are always present in the 
chains. By default, gain controls are unmuted and processor blocks are bypassed upon 
insertion. The default configuration can be modified in the options menu.

The EXP input- bus has only an AM processing block.

Gain, trim, mix-point, and volume blocks can be muted and processor blocks (after being 
inserted) can be bypassed for signal comparison. Mutes and bypasses are shown by a red 
indicator in the lower left of the block (see figure 20).

Figure 20.	 Input Gain Control Muted, Dynamics Processor (AGC) Bypassed
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Level Controls
To access a gain, trim or volume control to view a setting, make a change, or observe a live 
audio meter (input gain and output volume blocks only), double‑click the gain block icon 
(see figure 21). This action opens a dialog box that contains the fader for that control.

A dialog box opens
containing the controls. 

Double-click a 
gain control.

Fader Handle 

Level Display
Peak 

Level Control
Direct Input NOTE: In Emulate mode (the startup 

mode), the input level display 
 is not operational.

Analog Input Digital Input 

-or- 

Input Level 
Display 

Figure 21.	 Accessing a Typical Gain Control Dialog Box

Level controls always have a control for setting the signal level and a digital indication of its 
current setting. They can also have switches or indicators required for their specific function.

Processors
Each processor block represents a menu of one or more processors that can be inserted 
into the audio stream. For blocks that provide more than one processor, only one can 
be selected. Each block can be inserted by a double-click or right-click>Insert 
then select the desired processor (see figure 22). Once a block is inserted, the selected 
processor displays in the block and the block changes color. Processor blocks default to 
bypassed. Bypass is different from mute since the processor passes an unprocessed signal 
when in bypass mode. To have them default to “not bypassed”, see Tools on page 87.

Double-click the
processor block. 

Click the desired 
processor.

The selected processor is displayed in the 
block.
To change processor variables, double-click the 
block again to open the processor dialog box.-or- 

Right-click the
processor block. Click insert.

Click to select the 
desired processor.

Figure 22.	 Selecting a Processor Block
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Once a processor is inserted, to view associated parameters that define the selected 
processor (such as a frequency curve) or to remove the bypass, double‑click the processor 
block. This action opens a new dialog box with parameters for the process (see figure 23).

Figure 23.	 Sample Processor Dialog Box

•	 Click Set Defaults to discard all custom settings and	  
reload the default parameters.

•	 Click Bypass to temporarily suspend processing without	  
removing the processor block. Red indicates the processor is bypassed.

By default, a processor block is bypassed when inserted (the Bypass button in the 
processor dialog box is red).  

NOTE:	 Figure 23 is an example of one type of dialog box. Contents and appearance of 
each dialog box are unique to the processor type.

The block can be removed from the signal chain by clicking it to bring focus and pressing 
<Delete> or by right-clicking and selecting Delete.

Detailed explanations of each signal chain with their processor blocks along with mix‑point 
operation follow in the next section.

Mic/Line Input Signal Chain Controls

The input signal processor chain allows adjustments to program or microphone audio 
before input to the main mixer. 
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FlexInput Channels
The eight AEC-enabled inputs offer FlexInput capability to route 
a Dante channel in place of a local mic/line input. The flexible 
input selection enables audio processing from remote wireless 
microphones, wallplates, and other sources from the Dante network.

Gain Control (GAIN)
Each input provides gain control to accommodate consumer and 
professional analog and digital line level sources and microphones. 
The gain block provides a mono long‑throw fader for gain and 
attenuation. Range differs depending on whether the Digital Input 
checkbox is selected (checked). For an analog source, the range 
is –18 to +80 dB. For a digital source the range is –18 to +24 dB. 
Step resolution is 0.1 dB. Adjustments are made with the slider or by 
entering the desired dB level directly into the level control direct input 
field.

The peak reading meter holds the peak level for one second, 
displaying it numerically in the box below the meter. The default 
setting is unity gain (0.0 dB).

Phantom Power — Select this box to turn the +48 VDC phantom 
power on (checked) and off (unchecked). Phantom power is typically 
used to power a condenser microphone.

Mute — Select to silence the mic/line input. The button turns red 
when the signal is muted.

Polarity — Select to flip the polarity of wires connected to the audio 
connectors (+/tip and – /ring). This can compensate for miswired 
connectors. 

Digital Input — Select this box to switch the input from the rear 
panel analog input (unchecked) to an AT channel input (checked). 
The digital source is selected by Dante Controller (see Selecting 
Inputs and Outputs for Dante on page 123). If the digital input is 
selected, click the box to select the rear panel analog input.

Filter (FILT)
Each filter block allows a total of five filters. The first filter is inserted 
from a processor list that opens when the block is double‑clicked or 
by selecting it from a context list when the block is right‑clicked (see 
figure 24). 

Figure 24.	 Insert Filter Menu

Analog Input 

Digital Input 
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Once inserted, double‑click the processor block to change parameters of the filter. After the 
first filter is inserted, up to four additional filters can be added to the filter block using the 
dialog box. Select the desired filters from the following list using the drop‑down boxes:

•	 High pass filter — A high pass filter passes a band of frequencies extending from a 
specified cutoff frequency (greater than zero) up toward the high end of the frequency 
spectrum. All frequencies above the specified cutoff frequency are allowed to pass, 
while all frequencies below are attenuated.  
The default cutoff is 100 Hz.

•	 Low pass filter — A low pass filter passes a band of frequencies extending from a 
specified cutoff frequency (less than infinite) towards the lower end of the frequency 
spectrum. All frequencies below the specified frequency are allowed to pass, while all 
frequencies above are attenuated.  
The default cutoff is 10 kHz.

•	 Bass and treble filters — Also known as shelving or tone controls, the separate bass 
and treble filters cut or boost gain linearly above or below a specific frequency, with the 
end-band shape giving the visual appearance of a shelf. The bass default frequency is 
100 Hz and the treble default is 8 kHz.

•	 Parametric equalizer filter — The parametric filter is a frequency equalizer that 
offers control of all parameters, including amplitude (the amount of gain/boost or gain 
reduction/cut applied), center frequency (frequency), and range of affected frequencies 
(Q) around the center frequency. 

Figure 25.	 Filter Block Dialog Box

Open the filter block dialog box to insert additional filters. Select a filter type from the drop-
down filter selection list. All filter parameters are modified using the Filter block dialog box. 
Each filter loads with all applicable parameters displayed to the right of each filter selection. 
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A balloon number appears at the top of the frequency graph display (see figure 26, 1) 
corresponding to the row number underneath the graph. The location of the balloon number 
is at the frequency selection of that row. 

Figure 26.	 Filter Dialog Box, Filters Added

Within the dialog box, a filter is focused when a filter type is inserted, or is focused by 
clicking the filter number to the left of the filter selection drop-down list. Note the box 
number in row 3 in figure 27 is highlighted in yellow, indicating it is the filter in focus. The 
results of the filter in focus (independent of other filters) show in the graph as a dotted line 
the same color as its filter row when bypassed. When active (not bypassed), the line is solid. 
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When multiple filters are enabled, the graph indicates the focused filter result (independent 
of other filters) in the color of the filter row in table. The composite response, the combined 
effect of all filters not bypassed, is always displayed in red. 

Figure 27.	 Filter Dialog Box, Filter Not Bypassed

Above the graph, each filter has a "handle" (circled in red above) placed directly above the 
cutoff or center frequency whose number corresponds to the filter number (outlined in red). 
Click a handle or click the table row to bring focus to that filter. Click+hold+drag the handle 
horizontally to change the cutoff or center frequency.

The table below shows each filter type with default parameter settings. The table 
immediately following shows the possible range for each parameter.

Type Frequency Parameter 1 Parameter 2

High Pass   100 Hz Slope: 6 dB N/A

Low Pass  10000 Hz Slope: 6 dB N/A

Bass   100 Hz Boost/Cut: 0.0 dB Slope: 6 dB

Treble   8000 Hz Boost/Cut: 0.0 dB Slope: 6 dB

Parametric 1000 Hz Boost/Cut: 0.0 dB Q: 1.0

Filter Parameter Settings Range

Frequency 20 Hz to 20 kHz

Boost/Cut -24.0 dB to +24.0 dB

Q (Parametric EQ only) 0.707 to 15.000

Slope (HP & LP filters only) 1st Order (6 dB) and 2nd Order (12 dB)
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High Pass

The high pass filter allows all frequencies above the specified cutoff frequency to pass 
unattenuated. All frequencies below the cutoff are attenuated.  
The default cutoff is 100 Hz.

Figure 28.	 High Pass Filter Response Curve

In figure 28, all frequencies lower than the specified frequency, 100 Hz, are attenuated 
leaving the upper frequency response flat. Also note at the specified frequency (100 Hz), the 
signal is about 3 dB down, typical operation for high pass filters.
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Low Pass

The low pass filter is the opposite of the high pass filter. All frequencies above the specified 
frequency are attenuated allowing lower frequencies to pass.  
The default cutoff is 10 kHz.

Figure 29.	 Low Pass Filter Response Curve

Here, the frequencies higher than the specified frequency, 10 kHz, are attenuated leaving 
the lower frequency response flat. 
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Bass and Treble Shelving

Bass and treble shelving can be added to the filter. Known as shelving or tone controls, 
the separate bass and treble filters provide the ability to cut or boost gain linearly above 
or below a selected frequency, with the end-band shape giving the visual appearance of a 
shelf. 

If only a bass or only a treble filter is required, either bypass the unneeded control or set it to 
Unused in the selection box.

The bass default frequency is 100 Hz and the treble default is 8 kHz.

NOTE:	 Selecting Bass & Treble Filters inserts two separate filters.

 

Figure 30.	 Bass and Treble Shelving

The corner frequency of the controls can be selected to 0.1 Hz accuracy. Two slopes, 6 and 
12 dB/octave are available, along with the ability to boost or cut the signal up to 24 dB.
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Parametric (Equalizer)

The parametric filter is a frequency equalizer that offers control of all parameters, including 
amplitude (the amount of gain [boost], or gain reduction [cut] applied), center frequency 
(frequency), and range of affected frequencies (Q) around the center frequency. Q is the 
center frequency divided by the bandwidth. 

Up to five parametric filters can be placed in the filter block at one time, each set to a 
different frequency creating a five band parametric equalizer. The control can boost or cut 
the center frequency, and by changing the Q value, the range of affected frequencies can be 
widened or narrowed around the center frequency. In general, a higher Q value results in a 
narrower affected bandwidth. 

To demonstrate how Q affects the filter, the following filter block (see figure 31) contains five 
parametric filters centered at different frequencies, but with the same Q of 1.0. The filter in 
focus (3) has a center frequency of 1000 Hz boosting that frequency +12 dB over a Q of 
1.0. Note the markers on either side of the peak frequency are at about 300 Hz on the left 
and 3000 Hz on the right, a bandwidth of 2700 Hz.

Figure 31.	 Parametric Filter at 1000 Hz, Q: 1.000
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By increasing the Q to 10.000, the center frequency remains the same. The markers show 
the bandwidth of the filter narrowed to between 900 Hz and 1200 Hz, or about 300 Hz (see 
figure 32). Using the Q value, parametric filters can be used to notch out a very narrow, or 
very wide range of frequencies.

Figure 32.	 Parametric Filter at 1000 Hz, Q: 10.000

The dialog box above shows the frequency curve for a single active filter. To add its effect to 
the overall frequency response, remove the bypass on the other filters by clicking Bypass. 
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The overall frequency response is now shown as a solid red line with the filter in focus 
located in row 3 (see figure 33 below) shown in the color of its table row.

Figure 33.	 All Parametric Filters Active

The parametric filter allows frequency selection accurate to 0.1 Hz and either 6 or 12 dB of 
slope. 
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Acoustic Echo Cancellation (AEC) 
The DMP 128 C models provide one acoustic echo canceller processor for each of the 
first eight mic/line inputs. A single reference can be selected for each AEC from a list of the 
twelve line inputs. 

About AEC

Echo occurs when audio from a talker in the far end is received and amplified into the near 
end listener’s room, with that sound then being picked up by microphones in the near end 
acoustic space and sent back to the far end. The amount of signal sent back to the far end 
talker can be substantial, and with the added transmission delay, the result is an echo effect 
that seriously compromises communication in a teleconference or videoconference.

The Acoustic Echo Cancellation processor removes the potential echo signal at the near 
end mic channel by comparing it to the received signal from the far end, designated as the 
“reference,” and then creating an adaptive filter to cancel the potential echo before it is sent 
back to the far end. 

AEC Setup

Successful operation of the AEC processing block is a function of proper gain structure and 
selection of the AEC reference (see Optimizing Audio Levels on page 101). This section 
provides an overview of the two elements.

Proper gain structure involves the relationship between the signal at the selected reference 
and the signal at the mic input, within the context of proper levels for the reference and mic 
inputs independently. The mic input gain setting is naturally optimized for the voice level of 
the talker in that room; therefore the amount of signal from the far end that is picked up by 
the mic is dependent on how much that far end signal is being amplified in the near end 
room and the distance from the mic to the speakers.

The reference signal is the signal received from the far end, which is ultimately sent to a 
sound reinforcement system within the near end room. The output of the video codec might 
be connected to any of inputs 9 through 12.

In the AEC dialog, a reference can be chosen from any channel in one of three signal chains:

•	 Input Channels

•	 Virtual Return Channels

•	 Output Channels

Extron recommends using an input channel as the reference. An output channel or a virtual 
channel can also be used as a reference; however, doing so adds a little more delay to the 
signal being referenced. 

Using an output or virtual channel reference allows for the combining of input channels to a 
single reference, for example, in a conferencing setup where both a telephone and a video 
codec are used. In this case, both the telephone and video codec input channels can be 
routed to an output or virtual return, with that output or virtual return then chosen as the 
reference.

When using an output channel as a reference, the reference point is post volume control; 
therefore, changes to the listening volume in the room affects the AEC gain structure (see 
AEC Dialog, below). If you have an output channel on the DMP 128 that is not being used, 
you can isolate the reference channel from the channel being used for volume control by 
routing reference signals to the unused output channel. 
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If you do want the reference signal to track with changes in listening volume, and want more 
control over the actual reference level:

1.	 Route the far end signal to both the amplifier output and the virtual (unused) output.

2.	 Create a group master control that contains the amplifier output and virtual output. Set 
soft limits for the group master control, as desired.

3.	 Set optimal level for the amplified output. Set optimal level for virtual output. Relative 
levels between both settings will be maintained by using the group master control.

AEC Configuration

To insert and configure an AEC processor:

1.	 Insert an AEC processor on the desired input channel using one of the following 
methods:

•	 Double-click the AEC (filter) block in the DSP Configurator workspace.

•	 Right-click the AEC block to open the context menu and select Insert AEC.

•	 Click the AEC block to select it (or use the arrow keys to navigate to the AEC block) 
and press <Enter>.

2.	 Double-click the AEC processor to open it. Open the Select Reference drop‑down 
list and select a reference.

3.	 Click Bypass to disengage bypass. The AEC processor is now operational.

AEC Dialog

The AEC dialog contains a number of meters and indicator LEDs 
that are essential for gain structure setup and monitoring activity. 
The AEC reference must be selected from a list, otherwise the echo 
canceller will not work. Noise Cancellation, part of the AEC processor, 
is selected and adjusted here. Detailed descriptions of the AEC dialog 
components are included below.

Activity LEDs

•	 Far –  lights when activity is detected from the remote site.

•	 Near –  lights when activity is detected from the local site.

•	 Update –  lights when the AEC is updating, converging, or 
reconverging.

Meters

•	 ERL –  the ratio in dB between the signal at the reference and the signal at the AEC 
channel input. When ERL is a positive number, the signal level at the AEC channel input 
is lower than the signal at the selected reference (0 to +15 dB is desirable).

•	 ERLE –  the amount in dB of potential echo signal that the AEC algorithm, not including 
NLP processing, is cancelling.

•	 TER –  the sum of ERL + ERLE, in dB.
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Select Reference

Select the AEC reference from a drop-down list, populated with the 
following:

•	 Output channels (1 to 8)

•	 Input channels (1 to 12)

•	 Virtual Return channels (A to  H)

Noise Cancellation

Noise cancellation can be switched on or off from the AEC dialog. 
The noise canceller detects steady state noise, such as HVAC or 
other continuous system noise, and effectively remove it without 
causing audible artifacts.

Noise cancellation is engaged or disengaged using a checkbox. 
When the box is checked, noise cancellation is engaged, or 
switched on. When cleared, noise cancellation is disengaged, or 
switched off. The default setting is noise cancellation switched on 
and set to 15 dB of noise attenuation. 

Up to 20 dB of noise cancellation is available, in 0.1 dB increments. 

Setting Gain Structure for AEC

It is important to optimize the audio levels of the DMP 128 for AEC to be effective (see 
Optimizing Audio Levels on page 101).

Advanced AEC Controls
Click on the open/collapse icon at the bottom of the AEC dialog to reveal the advanced 
AEC controls.

Advanced control functionality is as follows:

Non-linear Processing (NLP) Controls

•	 Enable NLP — this box is selected by default. NLP is 
necessary for the removal of echo.

•	 NLP Presets — click a button to load pre-set values to 
the three NLP parameters; Max NLP Reduction, Attack 
Time, and Release Time. 

•	 Soft 

•	 Normal 

•	 Aggressive 

The default parameters (shown at right) match the Normal preset.

•	 Max NLP Reduction –  the maximum possible reduction in echo artifacts that can be 
applied. The range is 0.0 to 80.0 dB in 0.1 dB increments.  
Default is 50.0 dB.

•	 Attack Time –  the speed in which NLP is applied. The range is 0.0 to 100.0 msec in 
0.1 msec increments.  
Default is 6.0 msec.

•	 Release Time –  the speed in which NLP is released. The range is 1.0 to 3000.0 msec 
in 0.1 msec increments.  
Default is 150.0 msec.
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Additional Controls

•	 Double Talk Echo Reduction –  sets the amount of echo reduction applied during 
double-talk. The range is 0.0 to 20.0 dB in 0.1 dB increments.  
Default is 15.0 dB.

•	 Comfort Noise –  sets a comfort noise level in dB to eliminate states of complete 
silence, which could be perceived as a failed connection. The range is 0.0 to 40.0 dB in 
0.1 dB increments.  
Default is 0.0 dB which turns comfort noise off.

Dynamics (DYN)
A dynamics processor alters the dynamic 
range, the difference between the loudest to 
the quietest portions, of an audio signal. Each 
input channel provides two dynamics processor 
blocks that, when inserted, provide one of four 
types; AGC, Compressor, Limiter, or a Noise 
Gate processor. 

Once a processor is inserted, double‑click the 
processor block to change individual processor 
parameters in the dialog box. For comparison, 
click Bypass to bypass the block. 

All parameters are displayed in a text box and have a resolution to 0.1 increments. 
Parameters can be set by direct entry in the text box to replace existing text. Then press 
<Enter>, or <Tab>, or click to another area. Threshold, gain/attenuation, target, and ratio 
parameters have adjustment points on the graph display. Use the mouse to click+drag 
the graph point to the desired destination or value. All time values have a horizontal slider 
allowing adjustment in 1 ms increments. Either click+drag the slider handle, or focus 
on the slider and use the left or right arrow keys (the <Page Up> and <Page Down> keys 
adjust in increments of 10 ms). 

The table below lists each dynamics processor type, parameters, and factory default 
settings for the processor. 

Parameter AGC Compressor Limiter Gate

Threshold -40.0 dB -30.0 dB -10.0 dB -65.0 dB

Max Gain 12.0 dB

Target -10.0 dB

Window 12.0 dB

Attack Time 500.0 ms 5.0 ms 2.0 ms 1.0 ms

Release Time 1500.0 ms 100.0 ms 50.0 ms 1000.0 ms

Ratio 2.0 :1 20.0 :1

Hold Time 0.0 ms 100.0 ms 50.0 ms 300.0 ms

Max. Attenuation 25.0 dB

Soft Knee Off Off 

Details of the individual dynamics blocks follow. 
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AGC (Automatic Gain Control)

AGC adjusts the gain level of a signal based on the input strength to achieve a more 
consistent volume. Below the set threshold, the signal is not affected. Above the threshold, 
weaker signals are boosted up to the maximum gain setting to reach a user‑defined target 
level. As the signal level approaches the target level it receives less gain or no gain at all. 
Once the signal level reaches the target level all gain is removed. Click in each field or use 
the sliders to change the values.

Threshold — The input level where maximum 
gain is applied (after the attack time is exceeded). 
On the graph at right follow the red input level 
from the lower left to -40 dB where the first red 
circle is. Signal levels less than -40 dB remain at 
their original levels. Signal levels at or exceeding 
-40 dB have up to 12 dB of gain applied 
(Maximum Gain).  
The threshold level can be adjusted from -80.0 to 
0.0 dB in 0.1 dB increments.  
Default is -40.0 dB. 

Maximum Gain — The highest amplification 
applied to a signal exceeding the threshold and 
up to the lower limit of the window (see Window 
below).  
Maximum Gain can be set from 0.0 dB to +60 dB 
in 0.1 dB increments. 
Default is 12.0 dB.

Target — The desired average signal level of the 
output when AGC is applied. AGC can vary the 
gain according to the input signal level, specified 
target level and maximum gain. As the signal 
approaches the target level of – 10 dB, gain is 
reduced until at – 10 dB, gain is no longer applied.  
The target level can be adjusted from -40 dB to 
0.0 dB in 0.1 dB increments. 
Default is – 10.0 dB.

Window — Indicated by two yellow lines, is a specified range above and below the target 
level. Below the lower line maximum gain is always applied to the signal. When the signal 
reaches the window, gain control begins scaling in a linear fashion to achieve smoother 
results as the signal reaches the target level.
The window range can be set in 0.1 dB increments from 0.0 dB to 20.0 dB.
The default threshold is –  40 dB. The default target level is –  10.0 dB. The default window 
range is 12.0 dB.
Attack Time — Adjusts the time delay for AGC to engage after the input signal level 
reaches or exceeds the threshold level.  
Attack time can be adjusted from 0.0 to 3000.0 ms in 0.1 ms increments. 
Default is 500.0 ms.

Hold Time — Adjusts how long AGC continues to boost the signal after the input signal 
drops below the threshold and before release time begins.  
Hold time can be adjusted from 0.0 to 3000.0 ms in 0.1 ms increments. 
Default is 0.0 ms.

Release Time — Adjusts the time it takes to return the signal to normal (unprocessed) 
levels after the signal no longer exceeds the threshold level setting. Release time begins only 
after hold time is reached.  
Release time can be adjusted from 10.0 to 10000.0 ms in 0.1 ms increments. 
Default is 1500.0 ms. 
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Compressor

The compressor regulates signal level by reducing, or compressing, the dynamic range of 
the input signal above a specified threshold. The input level to output level ratio determines 
the reduction in the dynamic range beyond the threshold setting. For example, with a ratio 
setting of 2:1, for every 2 dB of input above the threshold, the compressor outputs 1 dB. 

Compression is commonly used to contain mic levels within an acceptable range for 
maximum vocal clarity. A compressor can also make softer sounds louder in one of two 
ways. The dynamic range can be reduced by compressing the signal above the threshold 
while raising the post‑compressor gain/trim (referred to as "make‑up gain"). Alternately, the 
input signal can be increased while the compression ratio above the threshold is increased 
correspondingly to prevent clipping. Both techniques have the effect of making louder 
portions of a signal softer while at the same time increasing softer signals to raise them 
further above the noise floor. 

Compression can also be used to protect a system or a signal chain from overload similar to 
a limiter. Click in each field or use the sliders to change the values.

The default threshold is -30 dB and default ratio is 2.0:1.

Threshold — The input signal level above 
which compression begins (subject to attack 
time) and below which compression stops 
(subject to hold and release time).  
The threshold level can be adjusted from -80.0 
to 0.0 dB in 0.1 dB increments.  
Default is -30.0 dB. 

Ratio — The input signal level reduction when 
compression is engaged.  
Ratio can be adjusted from 1.0 to 100.0 in 0.1 
increments.  
Default is 2.0:1.

Attack Time — Adjusts the time delay for 
compression to engage after the input signal 
level reaches or exceeds the threshold level.  
Attack time can be adjusted from 0.0 to 200.0 
ms in 0.1 ms increments. 
Default is 5.0 ms.

Hold Time — Adjusts how long compression 
continues after the input signal drops below 
the threshold and before release time begins.  
Hold time can be adjusted from 0.0 to 
500.0 ms in 0.1 ms increments. 
Default is 100.0 ms.

Release Time — Adjusts the time it takes to return the signal to normal (unprocessed) 
levels after the signal no longer exceeds the threshold level setting. Release time begins only 
after hold time is reached.  
Release time can be adjusted from 10 to 1000.0 ms in 0.1 ms increments. 
Default is 100.0 ms. 

Soft Knee — Select the Soft Knee checkbox to smooth and soften the transition from 
uncompressed to compressed output levels. There are no adjustments.
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Limiter

The limiter restricts the input signal level by compressing its dynamic range above a 
specified threshold. The limiter is most commonly used to prevent clipping, protecting a 
system against component or speaker damage. While the limiter is closely related to the 
compressor, it applies a much higher compression ratio of ∞:1 above the threshold. The 
ratio is fixed and cannot be changed. Click in each field or use the sliders to change the 
values.

Threshold — The input signal level above 
which limiting begins (subject to attack time) 
and below which compression stops (subject 
to hold and release time).  
Threshold level can be adjusted from –  80.0 to 
0.0 dB in 0.1 dB increments.  
Default is – 10.0 dB. 

Attack Time — Adjusts the time delay for 
limiting to engage after the input signal level 
reaches or exceeds the threshold level.  
Attack time can be adjusted from 0.0 to 200.0 
ms in 0.1 ms increments. 
Default is 2.0 ms.

Hold Time — Adjusts how long limiting 
continues after the input signal drops below 
the threshold and before release time begins.  
Hold time can be adjusted from 0.0 to 
500.0 ms in 0.1 ms increments. 
Default is 50.0 ms.

Release Time — Adjusts the time it takes 
to return the signal to normal (unprocessed) 
levels after the signal no longer exceeds the 
threshold level setting. Release time begins 
only after hold time is reached.  
Release time can be adjusted from 10 to 1000.0 ms in 0.1 ms increments. 
Default is 50.0 ms. 

Soft Knee — Select the Soft Knee checkbox to smooth and soften the transition from 
uncompressed to compressed output levels. There are no adjustments.
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Noise Gate

The noise gate allows an input signal to pass only when it exceeds a specified threshold 
level. Above the threshold level, the signal passes unprocessed; below the threshold the 
signal is attenuated at the rate set by the ratio adjustment. The typical setting of the noise 
gate threshold is just above the noise level of the environment or source equipment. That 
allows signals that are above the noise to pass, and attenuates the noise when there is no 
signal to eliminate background noise. Click in each field or use the sliders to change the 
values.

Threshold — is the input signal level below 
which attenuation (gating) begins (subject to 
attack time) and above which gating stops 
(subject to hold and release time).  
The threshold level can be adjusted from -80.0 
to 0.0 dB in 0.1 dB increments.  
Default is -65.0 dB.

Max Attenuation — is the maximum 
attenuation of the signal when it drops below 
the threshold.  
Maximum attenuation can be adjusted from 
0.0 to 80.0 dB in 0.1 dB increments.  
Default is 25.0 dB.

Ratio — is the input signal level reduction 
when gating is engaged.  
The ratio can be adjusted from 1.0 to 100.0 in 
0.1 increments.  
Default is 20.0:1.

Attack Time — adjusts the time delay for 
gating to engage after the input signal level 
drops below the threshold level.  
Attack time can be adjusted from 0.0 to 200.0 
ms in 0.1 ms increments. 
Default is 1.0 ms.

Hold Time — adjusts how long gating continues after the input signal drops below the 
threshold. If the signal is still below the threshold when hold time ends, release time begins.  
Hold time can be adjusted from 0.0 to 500.0 ms in 0.1 ms increments. 
Default is 300.0 ms.

Release Time — adjusts the time it takes to return the signal to normal (unprocessed) 
levels after the signal is no longer below the threshold level setting. Release time begins only 
after hold time is reached.  
Release time can be adjusted from 10 to 1000.0 ms in 0.1 ms increments. 
Default is 1000.0 ms. 
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Delay (DLY)
The delay processor block, when inserted, provides a means to delay the audio signal. 
Audio delay syncs audio to video or can time-align speakers that are placed at different 
distances from the listener. The DMP 128 can set delay by either of two criteria: time or 
distance (feet or meters). 

The default unit setting is time with a range of 0.0 ms to 200.0 ms adjustable in 0.1 ms 
steps. Default is 100.0 ms. 

Settings are controlled with a vertical slider and indicated in the readout field. Click within 
the readout field to change the value, or change the number and press <Enter>, or press 
<Tab>, or click away from the field. 

Figure 34.	 Delay Dialog

Slider adjustments made in feet or meters correspond incrementally to the distance required 
to make 1 ms, or 5 ms adjustments (detailed in the table below). If more precision is 
required, enter time in 0.1 ms increments into the readout field.

Method Time Feet Meters

Click + drag 1 ms ~1.1 feet ~0.3 m 

Focus + arrow 1 ms ~1.1 feet ~0.3 m 

Focus + Page Up/Down 5 ms ~5.6 feet ~1.7 m

When distance (feet or meters) is chosen, the conditions (temperature) field becomes 
available and can be set either by degrees Fahrenheit or Celsius by clicking the appropriate 
selection button. When entering a distance, time delay compensation is automatically 
modified based on differences in the speed of sound due to air temperature.  
Default is 70 degrees Fahrenheit.

NOTE:	 When using distance (feet or meters), set a temperature value first. Then set 
the distance.
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Ducking 
Ducking provides a means to duck, or lower, the level of one or more 
input signals when a specified source must take precedence. The 
ducking processor block, when inserted, provides a means to duck 
one or more mics and program material (ducking targets) when the processor detects a 
signal from the ducking source. Ducking lasts for the duration of the interrupting signal 
(ducking source) determined by the threshold setting (plus hold and release time) and 
restores the original levels of the ducked inputs once the other signal has ceased. 

NOTE:	 Ducking is not functional when an input chain includes active automixing. If the 
input to output mix-point is orange, indicating it includes automixing, ducking will not 
function for that input. To enable ducking either delete the automix processor in the 
signal chain or uncheck Includes Automixing at the mixpoint.

Ducking is useful when:

•	 Program material needs to be 
attenuated in order to more clearly 
hear a narrator voice.

•	 One microphone, such as one used 
by a master of ceremonies, needs 
to have priority over other mics, 
program material, or both.

•	 A paging mic needs to attenuate all 
other signals.

All ducking processor blocks are 
controlled via a common dialog box 
that opens when any of the ducking 
blocks are selected. All empty ducking 
processor blocks have no ducking 
source or target settings by default. 

When the first ducking source is inserted 
(shown at right), no ducking targets are 
selected. 

Ducker Configuration

Input #1

Enable Source Mic/Line

Duck:

Input #12

by (dB):

Input #2

Input #3

Input #4

Input #5

Input #6

Input #7

Input #8

Input #9

Input #10

Input #11

Vtr Send A

Vtr Send B

Vtr Send C

Vtr Send D

Vtr Send E

Vtr Send F

Vtr Send G

Vtr Send H

Settings:

Threshold

Attack Time

Hold Time

Release

dB

ms

ms

ms

Input #12

Input #2
Input #3
Input #4
Input #5
Input #6
Input #7
Input #8
Input #9
Input #10
Input #11

Input #1
Priority

20.0

20.0

20.0

20.0

20.0

20.0

20.0

20.0

20.0

20.0

20.0

20.0

20.0

20.0

20.0

20.0

20.0

20.0

20.0

-30.0

1.0

1000.0

1000.0

NOTES:	

•	 Signal reduction is not cumulative. Ducking reduces an input by the amount set 
in the by (dB): text box next to the input selection even if it is being ducked by 
another ducking source (see Ducking and Priority Ducking on page 54).

•	 Duck targets do not affect signals routed to expansion outputs 1 through 8.

•	 Duck targets do affect signals routed to expansion outputs 9 through 16.
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Ducking Configuration  

Ducking is configured in a dialog box that opens when an 
active ducking processor block is double-clicked.

A Current Source
Shows the input selected as the ducking source. Ducker 
settings affect the input channel shown here. When a 
ducker dialog is opened, the current source defaults to 
that channel. The current source can also be selected via 
the priority readout/source selector (see below).

B Enable Source Mic/Line checkbox 
When checked, ducking is enabled for the current source 
and the ducker processor block is lit. When cleared, 
ducking is disabled for the current source and the ducker 
processor block is unlit. 

C Duck: (targets) 
Shows all potential input targets. Only inputs checked are 
ducked. The current source is not available as a target (a 
source cannot duck itself). If the current source has been 
designated as a target of another input channel, that input 
channel is not available (a target cannot be the source).

D by (dB): 
Individual attenuation settings for each duck target in dB. 
The default is 20.0 dB. If additional attenuation of a target 
is required, increase this value. 
The attenuation range is 80.0 to 0.0 dB in 0.1 dB 
increments. 

E Priority 
Displays the hierarchy of ducking source to duck targets. 
Priority levels are displayed in tree fashion. Input channels 
that are targets being ducked by a source are shown as indented below the source. Any input channel 
displayed in the tree is an active link. Click an input channel to select that channel as the current source. 
The current source indicator (a) reflects the selected input channel.

F Settings: 
Used to configure the parameter settings for the ducker source. When a ducker block is copied, these 
settings are transferred.

Threshold — Sets the input signal level, in dB, the ducking source must exceed before ducking begins. 
If ducking does not occur quickly enough to avoid loss of speech or program material from the ducking 
source, decrease this setting. If ducking occurs too soon, allowing background noise to trigger ducking, 
increase the setting.  
The range is -60 to 0 dB in 1 dB increments. Default is -30 dB.

Attack Time — Adjusts the time to duck the targets once the threshold is exceeded.  
The range is 0 to 3000 milliseconds in 1 millisecond increments. Default is 1 millisecond.

Hold Time — Determines the time, in milliseconds, after a ducking source signal drops below the 
threshold before ducking ceases.  
The range is 0 to 10000 milliseconds in 1 millisecond increments. Default is 1000 milliseconds 
(1 second).

Release — Determines how long, in milliseconds, after the ducking source level is below the threshold 
and the hold time is met, the ducking targets take to restore signal levels. 
The range is 10 to 10000 milliseconds in 1 millisecond increments. Default is 1000 milliseconds 
(1 second).

AA
BB

CC DD

EE

FF
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Priority 

In some cases, multiple levels of ducking can be required to enable an input source to take 
precedence over all but one other input. 

In this example, Inputs 2 through 6 are set to duck when Input #1 has a signal above the 
ducking threshold. Input #2 is set to duck inputs 5 and 6. Since Input #1 has previously 
been set to duck Input #2, Input #1 is disabled to prevent contradictory priorities.

Figure 35.	 Ducker Configuration, Input Priority

Notice the priority tree on the right side of figure 35. The inputs are arranged by their priority 
status. Input #1 has all other ducked inputs under it, therefore if a signal is detected, it will 
trigger Inputs 2 through 6 to duck. If Input #2 detects a signal and there is no signal on Input 
#1, Input #2 will trigger inputs 5 and 6 to duck. However if the Input #1 signal exceeds the 
threshold, it will then duck all inputs including Input #2. 

NOTE:	 Ducking attenuation is not additive. When an input target is ducked, 
regardless of how far down the priority line it is, the maximum attenuation is that set 
for the individual input and virtual send in the “by (dB):” column near the center of 
the dialog box.

See Ducker Tutorials on the next page for additional information.
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To set an additional ducking source:

1.	 Insert a ducking processor on the additional ducking source. 

In this example input #2 is the second ducking source, with input #1, as shown above, 
as the first source. 

NOTE:	 Since it was previously selected as a 
ducking target, Input #1 is not available as a 
target of input #2.

2.	 Open the ducking dialog box for the input and select 
the desired duck targets. In this example inputs #5 and 
#6 are the ducking targets of input #2.

Any signal on input #2 that exceeds the ducking 
threshold now ducks inputs 5 through 6. The ducking 
targets can be changed at any time by double‑clicking 
the input #2 ducking processor block. 

Since input #2 is a target of input #1, if a signal on 
input #1 exceeds the ducking threshold, inputs 2 
through 6 are still ducked regardless of whether the 
signal on input #2 exceeds its ducking threshold.

NOTE:	 No input will be ducked more than the 
amount set in the by(dB): box.

Ducker Tutorials
The examples below are based on different input configurations. Insert a ducker from a 
ducker processor block using one of the following methods: 

Double-click the block, 
then click Ducker

Right-click the box to open context
menu, then click Insert Ducker

-or-

Once inserted, double-click on the ducker block to open the ducker configuration dialog 
box. The Enable Mic/Line Source box is checked. 

Ducking and Priority Ducking

The first inserted mic ducks all selected targets. 

To set a ducking source:

1.	 Insert a ducking processor on input #1. 

2.	 Open the ducker configuration dialog box and select 
the desired duck targets. In this example inputs #2 
through 6 are the ducking targets. 
Any signal on input #1 that exceeds the ducking 
threshold now ducks inputs 2 through 6. 

The ducking processor also provides a means to have 
an additional input duck other targets using the priority 
feature. The second input ducks its selected duck 
targets, and can also be ducked by the first ducking 
source. 
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Automix (AM)
An automixer manages multiple microphone sources, gating or varying input gain 
automatically. When properly set, the automixer system will improve use and performance 
when multiple mics are in use. The two basic types of automixer include gated and 
gain-sharing. 

A gated automixer attenuates an input channel when the signal level drops below a 
user‑defined threshold. DSP Configurator allows the user to divide these automixers into 
gating groups. Each gating group is effectively a separate automixer. 

A gain sharing automixer sets a maximum room gain and splits this among all open mics, 
based on their input levels. While a gain sharing mixer typically has less delay in reacting to a 
speaker, gated automixers will normally produce a better noise floor.

The DMP 128 allows the user to choose between a gating automixer and a gain sharing 
automixer. When the number of open mics (NOM) is set to zero, the automixer is 
gain‑sharing. When a NOM value is provided, the automixer is gated.

The DMP 128 uses an automix dialog box to configure the parameters of each channel and 
select an AM group.

Automix parameters:

•	 AM Group (Assignment) — Assigns 
the channel to a gating group. 
Selections are 1 through 8.  
Default is None. 

•	 Show AM Group Details  — 
Accesses a dialog box that details 
current groups and the parameter 
member assignments to each (see 
the following section).

•	 Last Mic Mode On/Off — Prevents 
all mics from gating off at the same 
time, ensuring there is always one 
active mic channel. There are four 
possible states:

•	 If not enabled on any mic input, all mics gate off.
•	 If enabled on all mics, the last active mic remains on.
•	 If enabled on one mic: 

•	 The enabled mic remains active if it is active when all other mics gate off, or 
•	 If the enabled mic is not active, it gates on when all other mics gate off.

•	 If enabled on some but not all mics: 
•	 If enabled on the last active mic, this mic remains active, or 
•	 If not enabled on the last active mic, the first enabled mic in the group gates on.

•	 Chairman Mode On/Off — One mic or multiple mics can be set to Chairman under 
the Gating Priority list. When a chairman mic is gated on, all non-chairman mics are 
gated off to the off reduction level. 

•	 Current NOM — Displays the selection of the maximum number of mics that may 
be gated open at any time, per gating group. The setting can be changed using the 
AM Groups dialog box. Current NOM range is 1 through 12.

•	 Gate Threshold — The signal level below which the mic channel gates off and above 
which it gates on. 
Range is – 60.0 dB to 0.0 dB.  
Default is – 50.0 dB.

Gating Threshold
Indicator

Channel Level
(RMS)
Channel Level
Readout
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•	 Off Reduction — The channel attenuation when a mic channel gates off.  
Range is 0.0 dB to 100.0 dB attenuation (0 to – 100 dB).  
Default: 60.0 dB.

•	 Attack Time — Sets the time at which gain is applied after a channel gates on. 
Range is 0.0 msec to 3000.0 msec in 0.1 msec increments.  
Default: 10.0 msec. 

•	 Hold Time — The time that a mic remains active after the signal drops below a 
user‑defined threshold.  
Range is 0.0 msec to 10000.0 msec in 0.1 msec increments. 
Default: 400.0 msec.

•	 Release Time — The time it takes to ramp the signal level to the Off Reduction value 
when the mic channel gates off.  
Range is 10.0 msec to 10000.0 msec in 0.1 msec increments. 
Default is 100.0 msec. 

•	 Gate Status Indicator and meter — The meter provides real-time sampling of the 
selected AM channel with a digital readout of the current level the meter. The indicator 
lights when the channel is shut off.

To insert an automix block into a channel:

1.	 Insert an AM processing block in the desired channel.  
Either: 
•	 Right-click the AM block and select Insert Automixer, 

or

•	 Double-click the AM block and select Automixer.

2.	 Double-click the inserted AM block to open it (see Automix parameters: on 
page 55).

The AM block defaults to Bypass (bypass button red). Click Bypass to toggle the AM 
block to active (bypass button gray).
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Automix Groups

Assigning individual automix channels to groups allows you to see and adjust all channels 
assigned to the group on one page. The automix group dialog provides details of all 
grouped and ungrouped inputs including the automix settings of each channel or mic. This 
provides an overview of all channels in the selected group at a glance. Individual settings 
can be changed without leaving the groups dialog. You can also select all Ungrouped 
items and see the channels currently unassigned to a group.

Figure 36.	 Automix Groups Dialog

To Configure an Automix Group:

A channel must first have an active automix block before it can be included in an automix 
group.

1.	 Insert an AM processing block in the desired channel. Either: 

•	 Right-click the AM block and select Insert Automixer.

•	 Double-click the AM block and select Automixer.

2.	 Double-click the inserted AM block to open it.

3.	 Select the group number from a range of 1 through 8.

4.	 Set the parameters for the channel.

5.	 Repeat steps 1 through 3 for all channels in the automix group.

6.	 Open any AM block and click Select AM Group Details to open the automix group 
configuration page.

7.	 Set NOM (the maximum number of gated mics) for the selected group.

8.	 Test the system and make adjustments as needed. 
Adjustments are made to individual automix channels using the rows by opening each 
individually, or globally to all channels using the AM group details page. Observe the 
Gate Status indicators to verify that channels gate on properly.

The AM Group Details dialog provides details of all grouped and ungrouped inputs including 
the automix settings of each channel or mic. This allows viewing of all channels in the 
selected group at a glance to provide an overview of the group. Individual settings can be 
changed without leaving the groups dialog.
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Pre‑mixer Gain (GAIN) 
The pre-mixer gain control provides gain or attenuation 
after the input processing signal chain. It includes a mono 
long-throw fader with a – 100.0 to +12.0 dB gain range, 
and a current level setting readout below the fader. Fader 
adjustments are in 1 dB increments, while adjustments can be 
entered manually to 0.1 dB resolution.  
Default is unmuted at unity (0.0 dB) gain. 

Selecting the fader handle with the mouse or clicking within 
the fader area brings focus to the fader. The input signal level 
is adjusted using any of the following methods:

•	 Select and hold the fader handle and drag it to desired 
level in 1.0 dB steps.

•	 Select or tab to the fader handle and use the up/down 
arrow to set the desired level in 1 dB steps.  
<Page Up> increases and <Page Down> decreases the 
level in 5 dB steps.

•	 Click in or tab to the level readout field. Type a new value and press <Enter>, or <Tab> 
to another area.

Configuring an Automix Channel

Before configuring automix, Extron recommends that you set proper gain staging for the 
input mics. This ensures that adequate signal is provided for automix to work properly. 

An automix block is inserted for each microphone, and the mic assigned to a group (see 
figure 37, Automix Groups Dialog on the previous page). Setting a reasonable NOM, 
(the maximum number of gated mics) for the microphone group will increase intelligibility 
by limiting the number of open mics that are allowed to gate on at once. A NOM of three is 
recommended. 

In events where a small number of talkers may need priority over other talkers (such as a 
presenter at a lectern) chairman mode can be enabled on the priority input channel. 

Last mic mode can minimize the frequency of gate changes. This prevents rapid switching 
of input mics by, ensuring that a talker is not gated off when their speech is paused.

After the automixer is configured, be certain to set the appropriate mix‑points to include 
automixing.

Fader Handle

Input
Signal Level 
Readout
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Telephone RX (DMP 128 C P and DMP 128 C P AT only)

Figure 39.	 Telephone Rx Signal Path

The DMP 128 provides a telephone interface with separate input and output signal 
processing paths. The telephone input (Rx) is identical to the other input processing paths 
except the AEC block is not used. See Telephone Interface on page 127 for additional 
information.

NOTE:	 The country code must be entered before connecting the DMP 128 to a 
phone system.

Line Output Channels
There are eight mono line output channels. Controls and processing 
blocks, identical for each output channel, are described in the 
following sections. 

Post-mixer Trim Control (TRIM) 
The post-mixer trim control provides a fader for fine adjustment of the 
program material prior to the output signal chain. The trim control has 
a range of – 12 dB to +12 dB in 0.1 dB increments. 

Default is unmuted at unity (0.0 dB) gain.

Loudness (LOUD)
The loudness processor block, when inserted, applies 
a filter compensation curve to the signal in an inverse 
relationship to the output volume control setting; the 
higher the output volume setting, the less compensation is 
applied (see Calibrating Loudness on the next page).

The loudness processor compensates for changes in human perception to varying volume 
levels by applying a filter compensation curve to the signal in an inverse relationship to 
the gain control setting. The higher the gain setting, the less loudness compensation is 
applied. Generally, as volume is lowered, perception of certain frequencies is progressively 
diminished, returning to a more flat response as volume is increased. Loudness will boost 
those diminished frequencies to the highest degree at low volume levels, decreasing the 
boost as volume increases.

Bypass must be disengaged for the loudness processor to function. The bypass button 
is red when engaged (loudness control defeated), and gray when disengaged (loudness 
control active). 
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When bypassed, the graph displays the current filter curve as a dotted line. When bypass is 
disabled, the current filter curve is displayed as a solid line.

Figure 37.	 Loudness Dialog Dialog box

The Loudness dialog box contains the following elements:

1.	 Graph — Displays the compensation curve currently applied to the signal. These 
curves are read-only, and not adjustable from the graph.

2.	 Loudness Compensation slider — From a center zero-point, the user can slide to 
the left for less loudness compensation (filter curve is reduced), or to the right for more 
(filter curve is increased). The slider position is translated into a dB value, displayed in 
the compensation readout box contained in the Advanced Calibration section. The 
slider has a 48 dB (±24 dB) range. 

3.	 Advanced Calibration — Provides a value that corresponds to the position of the 
compensation adjustment slider. The SPL box displays the summed value of the slider 
and the preceding trim control.

Calibrating Loudness

The user can fine‑tune the amount of loudness compensation using the compensation 
adjustment slider and adjusting “by ear,” or by measuring SPL levels in a particular room 
and using the slider to adjust the loudness filter relative to the SPL of the room and system 
gain structure.

Before calibrating loudness, set up the system gain structure (see Optimizing Audio 
Levels on page 101). A pre-recorded track of pink noise or pink noise from a signal 
generator is preferable for this purpose. Program material can also be used (using familiar 
material is recommended). 

When using a signal generator, set it to output - 10 dBu and set the input gain of the 
DSP Configurator so the input meter reads - 20 dBFS. If using a recorded source, the 
pink noise should be recorded at - 20 dBFS and the player output level setting control set 
to maximum, or 0 dB of attenuation. For program material, set the input level to meter at 
approximately -15 dBFS, with peaks safely below 0 dBFS. 
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Unmute the mix‑point from the pink noise source to the output connected to the room 
amplifier being calibrated. With the basic gain structure previously set up, loudness can be 
calibrated using an SPL meter or by ear. (Loudness can also be set using an SPL meter and 
fine-tuned by ear.)

To calibrate loudness, use a sound pressure level meter set to “C” weighting: 

1.	 Set the Loudness processor to Bypass (Bypass button red).

2.	 Place the meter in an average (but somewhat prominent) listening location. 

3.	 Generate pink noise, or start the program material playback.

4.	 Measure the SPL in the room. 

5.	 In the loudness dialog, adjust the slider until the value in the SPL readout box matches 
the reading on the SPL meter. 

NOTE:	 Theoretically, calibration can be performed with the output channel 
volume and post‑mixer gain level set to any comfortable listening level. But a 
relatively loud volume (well above the ambient noise in the room) that can be 
easily measured is preferred. 

Loudness is now calibrated. Disengage Bypass to hear the compensation.

Alternate method to calibrate loudness:  

1.	 Set up the procedure using steps 1 through 3 of the previous procedure.

2.	 Set the compensation adjustment slider to its default center position. 

3.	 Set the output channel volume fader to 0 dB (100% volume). 

4.	 Adjust the amplifier until the SPL meter reads 90 dB. 

Loudness is now calibrated. This method works if 90 dB is an acceptable amplifier volume 
limit for the room. 

Setting Loudness “By Ear”

When setting loudness by ear, it is essential the system gain structure be set up first. Sit in 
an average (but somewhat prominent) listening location. 

1.	 Set the loudness processor to Bypass.

2.	 Set the output volume fader in the DSP Configurator to a relatively quiet listening level. 
Filter compensation from the loudness processor is most prominent at low listening 
levels. Use familiar program material set to the levels described earlier.

3.	 Set the Calibrate slider to 0, the center point. Disengage the loudness Bypass. The 
result is a moderate enhancement to the program material, with more accentuated 
bass frequencies (below 500 Hz), and more brightness in the high frequencies that carry 
harmonic content (above 7 kHz). Engage and disengage the Bypass switch in order to 
“A/B” the difference between loudness off and on, respectively. 

4.	 To experiment with less loudness compensation, move the loudness compensation 
slider to the left (less). For more loudness compensation, move the slider to the right 
(more). 

5.	 Any adjustment made to the loudness compensation slider will carry through to all 
listening levels. Set the output volume fader in the DSP Configurator to a relatively loud 
listening level. 

6.	 Engage and disengage the Bypass switch in order to “A/B” the difference between 
loudness off and on. At a loud listening level, the difference should be minimal or barely 
perceivable.
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Delay Block (DLY) 
The delay processor block, when inserted, provides 
a means to delay the audio signal to compensate for 
loudspeaker placement in situations where speakers 
delivering the same signal are much farther away than 
others. The delay processor block is identical to the delay processor available on 
the input (see Delay (DLY) on page 50). Typically the near speakers would be 
delayed so that audio delivery time matches the speakers further away.

Filter Block (FILT) 
The filter processor block, when first inserted, provides one of four 
filter selections: High Pass, Low Pass, Bass & Treble filters and 
Parametric EQ. Up to nine filters can be added to each filter block. 
The output filter block is identical to the input filter processor block 
except that up to nine filters total can be selected (see Filter (FILT) 
on page 32).

NOTE:	 Selecting the Bass & Treble Filter inserts two separate filters.

Dynamics Block (DYN) 
A dynamics processor block, when inserted, 
provides one of four dynamics processors: 
AGC, Compressor, Limiter, and Noise Gate. 
The available processors are identical to the 
processors available on the input dynamics 
processor block and described in (see 
Dynamics (DYN) on page 45).
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Volume Control (VOL)  
Each output channel volume block provides a mono long‑throw fader 
and a volume setting readout (in dB) below the fader. Volume level 
adjusts with the slider or by entering the desired level directly into the 
volume setting readout in 0.1 dB increments. 

Click the fader handle or click within the fader area to bring focus to 
the fader. The input signal level is adjusted using any of the following 
methods:

•	 Click and hold the fader handle and drag it to desired level in 
1.0 dB steps.

•	 Click or <tab> to the fader handle and use the <up> and <down> 
arrow keys to change the desired level in 1 dB steps. <Page Up> 
(increase) and <Page Down> (decrease) the level in 5 dB steps.

•	 Click in or tab to the level readout field. Type a new value and 
press <Enter> or <Tab> to another area.

The default setting is unmuted, at 0 dB attenuation. A peak meter 
displays the real‑time audio level from -60 to 0 dBFS. 

Click OK to accept settings and close the dialog box. Click Cancel to ignore changes and 
close the dialog box.

The output volume control provides level control for each output. The output control is a trim 
control adjustable from -100.0 to 0 dB. The default setting is unity gain (0.0 dB).

The Polarity button, allows the polarity of the wires connected to the audio connectors 
(+/tip and -/ring) to be flipped in order to easily correct for miswired connectors.

The Mute button silences the post-meter audio output. When the audio output is muted, the 
mute button lights red, and red indicators in the block turn on. 

If the output has been grouped with other inputs or outputs, the group number is indicated 
on the right side of this button (see Line Output Channels on page 59).

Telephone Tx (DMP 128 C P and DMP 128 C P AT only)

Figure 38.	 Telephone Tx Signal Path

The DMP 128 provides a telephone interface with separate input and output signal 
processing paths. The telephone output (Tx) is identical to the other output processing 
paths. All signals routed to the Telephone Tx are also available on output 8. 

See Telephone Interface on page 127 for additional information.

NOTE:	 The country code must be entered before connecting the DMP 128 to a 
phone system (see Telephone Configuration on page 127).
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Virtual Bus Returns
There are eight mono virtual bus return inputs, fed by the virtual sends. Channel controls 
and processing blocks described in the sub-sections that follow are identical for each virtual 
bus return channel. 

The eight returns are divided into two similar paths. Channels A through D contain a 
feedback suppression processing block in each channel. Channels E through H are identical 
except there are no feedback processing blocks.

Virtual Bus Returns, A-D

The virtual bus is used when additional processing of an input signal is required. It is also 
useful to apply identical filtering, dynamics processing, loudness compensation, or signal 
gain/attenuation to multiple inputs.

Feedback Suppressor (FBS)

The Feedback Suppressor (FBS) is used when there is indication of feedback during 
live operation. Dynamic filters automatically detect feedback on a live mic channel, and 
engage a set of up to 5 fixed and 15 dynamic filters to counteract the frequency peaks at 
the detected feedback frequency. Up to 15 separate filters can be employed at any time. 
The 15 filters act in a FIFO, or first in, first out rotation. If all 15 filters are employed, when 
an additional feedback frequency is detected it overwrites the first detected feedback 
frequency and so on. 

To avoid a new feedback frequency overwriting a previously detected one, up to five of the 
dynamic feedback frequencies can be placed into fixed filters. Once written into the fixed 
filters, the feedback frequency can only be overwritten by manually writing a new frequency 
to the filter. 

The FBS dialog box has three tabs;  Settings, Dynamic Filters and Fixed Filters. 
Global settings and view options are controlled from the Settings tab. Dynamic to fixed 
filter allocations are handled from the Dynamic Filters tab. Filter parameters can be 
modified from the Fixed Filters tab. 
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The FBS dialog box provides the following global buttons: 

•	 Clear All — Clears all dynamic filter settings.

•	 Lock — Locks the dynamic filters to current settings, preventing automatic updates. 
This temporary mode is useful while testing the system, or during the time when 
dynamic filters are being converted to fixed filters. When the FBS dialog box is closed, 
lock mode is automatically disengaged.

•	 Bypass FBS — Turns off feedback detection when engaged (button is red). Only the 
dynamic filters are bypassed. Fixed filters remain active.

•	 Set Defaults — Click once to return the FBS to default settings. 

Figure 40.	 Feedback Suppressor
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FBS Settings Tab

The Settings tab enables selection of the feedback suppressor parameters. 

•	 For Composite View show: — The graph view is set by one of three radio buttons: 

•	 Only Dynamic FBS Filters

•	 Only Fixed FBS Filters

•	 Dynamic & Fixed FBS Filters (default)

•	 Mode: Q — Adjusts the notch filter Q used by dynamic filters. Similar to Q on the 
parametric equalizers, Q changes the bandwidth of the filter. The default setting can 
be modified in Tools > Options. The range is from 5 to 65. Larger values provide 
less change to the audio frequency response while lower values may provide greater 
feedback suppression but with more possible impact to the tonal response of the 
source audio.  
Suggested values for specific applications are:

Q Value Application

7 Voice with considerable feedback potential

30 Voice with less feedback potential 

65 Music with minimal feedback potential

•	 Attack Time — Sets the time at which dynamic filters are generated after feedback 
detection. A longer attack time (greater than 200 ms) reduces the chance that music or 
audio content will trigger the dynamic filters to respond. A shorter attack time (less than 
2 ms) reduces the time between when feedback is detected and suppressed.

•	 Hold Time — Expressed in hours:minutes:seconds up to 9 hours. Hold time sets 
the time a dynamic filter setting persists before the filter is cleared. When hold time is 
disabled (checkbox cleared) dynamic filters persist indefinitely unless cleared manually 
or the device is power cycled. 

Figure 41. FBS Settings Tab
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FBS Dynamic Filters Tab

This dialog contains the fifteen dynamic filters, with a scroll bar to display filters hidden due 
to the dialog box size. 

Dynamic filters are cut only notch filters, providing attenuation up to 30 dB at the specified 
Q. The default Q is set in the Tools > Options menu, but can be changed on the settings 
tab prior to engaging the FBS dynamic filters. 

NOTE:	 Changing the Q setting in the options menu after dynamic filters have been 
generated clears all dynamic filters.

AA

BB CC

Figure 42.	 FBS Dynamic Filters Tab

Frequency and cut values are read only. Dynamic filters are in auto-detect mode when the 
FBS block is active (see figure 42, A; Bypass FBS off). If testing reaches a point where no 
further changes are desired, the lock button can be engaged. The lock mode of operation is 
temporary, and is intended to be used during setup of the FBS. When the FBS dialog box is 
closed, lock mode is automatically disengaged.

If there are specific dynamic filters that you want to assure are not overwritten, press the 
Move to Fixed button (see figure 42, B) to write the designated filter settings to the first 
available filter in the Fixed Filter tab.

NOTE:	 When a dynamic filter setting is moved to the fixed filter, it automatically clears 
that frequency from the dynamic filter. 

The Clear button (see figure 42, C) removes a detected frequency from the corresponding 
dynamic filter. A cleared filter reverts to auto-detect mode unless Lock mode is engaged.

FBS Fixed Filters Tab

Fixed filters are notch filters with an adjustable center frequency and Q, and up to 30 dB 
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of cut. The fixed filters are typically set by converting dynamic filters to fixed, however 
adjustments to filter parameters can be manually made from the Fixed Filters tab.

Fixed Filters are inactive and the filter type is set to Unused by default (see rows 4 and 5 in 
figure 43). 

Figure 43.	 FBS Fixed Filters Tab

No filter parameters are displayed when the filter type is set to Unused. As a filter is moved 
to the fixed filter tab from a dynamic filter, the filter becomes active and displays Notch as 
the filter type. The parameters copied from the dynamic filter are displayed in the same line. 
Once a fixed filter is active, settings can be modified or adjusted as needed. Fixed filters can 
also be individually bypassed by clicking Bypass.

FBS Settings Ranges and Fixed Filter Defaults

FBS Parameter Settings Range Default Setting

Frequency 20 Hz to 20 kHz N/A

Q 5.000 to 65.000 30.000

Attack Time 0.0 ms to 1000.0 ms 10.0 ms

Filter Hold Time 0 seconds to 9 hours 00:00:00; Disabled

Fixed Filter Parameter Settings Range Default Setting

Frequency 20 Hz to 20 kHz 1000.0 Hz

Q 1.000 to 65.000 30.000

Cut Up to 30 dB cut 0.0 dB
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Filter (FILT)

Filter function and interface is identical to the mic/line input channel Filter block except that 
only three filters are provided (see Filter (FILT) on page 32).

Dynamics (DYN)

There is one dynamics processor block available on each virtual path. Dynamics function 
and interface is identical to the mic/line input channel Dynamics block,  
(see Dynamics (DYN) on page 45).

Loudness (LOUD)

There is one loudness processor available on each virtual path. The loudness function and 
interface is identical to the Output channel Loudness block (see Loudness (LOUD) on 
page 59).

Bypass must be disengaged for the loudness processor to function. The bypass button 
is red when engaged (loudness control defeated), and gray when disengaged (loudness 
control active). 

Delay (DLY)

Audio Delay syncs audio to video or to time-align speakers that are placed at different 
distances from the listener. The Delay function and interface is identical to the input channel 
delay block (see Delay (DLY) on page 50).

Gain (GAIN)

Each virtual input channel gain block provides a mono long-throw fader with a - 100.0 to 
+12.0 dB gain range, and a level setting readout below the fader. Fader behavior is identical 
to the Pre-mix‑point gain block, described in the mic/line input section  
(see Pre‑mixer Gain (GAIN) on page 58). Fader adjustments are in 1 dB increments, 
while adjustments can be entered manually to 0.1 dB resolution.  
Default is unmuted at unity (0.0 dB) gain.

Virtual Bus Returns, E-H
There are four additional mono virtual bus return inputs. Virtual Bus Returns E through H are 
identical to A through D except there are no feedback processors. 

As with virtual bus returns A through D, these returns are used when additional processing 
of an input signal is required. It is also useful to apply identical filtering, dynamics processing, 
loudness compensation, or signal gain/attenuation to multiple inputs.
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Output Mix Matrix
The DSP architecture contains an output mix matrix that connects all inputs to the line 
outputs, a virtual send mix matrix that connects all inputs to the virtual outputs, and an 
expansion (EXP) output mix matrix that connects the mic/line inputs and virtual bus returns 
to the expansion outputs (see figure 44 on page 71). 

The output mix matrix sets mix levels from the post processing inputs and post processing 
virtual returns, to each line output bus. 

Each mic/line input and virtual bus return is connected to a mix‑point for each of the eight 
line outputs. In general, mix levels are set relative to each other, achieving a desired blend 
of input signals at an optimal output level, close to, but not exceeding 0 dBFS at the line 
output volume block level meter (while accounting for processing that may occur in the line 
output signal chain). 

NOTE:	 Although the virtual output and return lines, A through H, are shown as end 
points on the DSP Configurator screen, they are connected A to A, B to B, C to C, D 
to D, E to E, F to F, G to G and H to H. These connections cannot be changed.

 

DMP 128 • Software Control 70



Virtual Send Bus Expansion Outputs1     2     3     4      5     6     7      8  

Expansion Outputs1     2     3     4     5     6     7     8  

1     2     3     4      5     6     7      8  

A     B     C     D     E     F     G     H  1     2     3     4     5     6     7     8  

9

10

11

12

13

14

15

16

A     B     C     D     E     F     G     H  

Inputs

Virtual Returns

Expansion Inputs

Outputs

1 - 8

9 - 16

Output 
Mix Matrix

Virtual Send
Mix Matrix

Expansion Output
Mix Matrix

Figure 44.	 Overview of DSP 128 Mix-matrix
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Mix‑point Behavior:
Mix-point color — There are three colors of mix-points:  

Teal indicates standard processing (default). 

Orange indicates that the signal chain includes an  
auto‑mix processor.

Green indicates that all signal processing has been bypassed, post 
input gain control.

No mix information — A faint transparent circle (teal, green, or orange) on 
the mix‑point indicates that it is muted (contains no mix information).

Mix information — A solid circle indicates that the mix‑point contains mix 
information (the mix-point is unmuted).

Mouse-over — The cursor changes to a hand when a mouse‑over occurs 
at a mix‑point whether the mix‑point contains mix information or not.

Single-click — A single-click (click) brings focus to (selects) the mix‑point, 
indicated by a dark green outline around the circle.

Double-click — A double-click opens the mix‑point dialog box. The focus 
outline turns light green to indicate the open dialog box. If the mix‑point is 
muted, the mix‑point circle is gray and the Mute button in the dialog box is 
red.  
If unmuted, the bubble is teal and the mute button in the dialog box is 
normal (typically gray for most color schemes).

Multiple open dialog boxes — When multiple mix‑point dialog boxes  
are open, the mix‑point for the most recently opened dialog box receives 
the light green focus circle, while previously opened dialog boxes  
relinquish their focus. Focus can be returned by a click on a previously 
opened dialog box, or by double‑clicking a mix‑point.

 

DMP 128 • Software Control 72



Click a mix‑point to focus it. A circle appears around the teal mix‑point, which remains 
transparent. Double-click a mix‑point to open a configuration dialog box with the following 
components:

•	 Mono Fader — Sets the signal level from the selected 
input to the output bus. Gain range is -35 dB to 
+25 dB. Fader behavior is identical to the input channel 
gain block described in the mic/line input section with 
the exception that course adjustment (<Page Up> 
and <Page Down>) increases or decreases in 5 dB 
increments.

•	 Mute — Mutes and unmutes the signal to the output 
bus. The mix‑point ball is transparent when muted 
(Mute button red) and solid when unmuted.

•	 No Automixing — When selected, bypasses all 
automix channel inputs. The mix-point is teal.

•	 Includes Automixing — When selected, includes the 
automix channel input. The mix‑point turns solid orange 
when the mix-point is unmuted and transparent orange 
when muted. 

•	 No Input Processing — When checked, bypasses all 
processing for the preceding input string. This allows a 
direct comparison of sound between the unprocessed 
signal and fully processed. The mix‑point turns green 
when unmuted and transparent green when muted. 
Default is cleared.

•	 OK/Cancel — click OK to accept changes and close 
the box. Cancel ignores changes and closes the dialog 
box.

The title above the fader reflects the input and output 
channel names for the mix‑point. The example on the right 
is the Input #1 to Output #1 mix‑point set to 0.0 dB. 

The input level text below the mute button indicates the input level setting for the input gain 
control or mute status of the selected input signal path, in this example 0 db.

Only when the mix‑point is unmuted does the circle become solid.

NOTE:	 The No Input Processing and Includes Auto‑mixing buttons are mutually 
exclusive. You cannot select both. If you are including an automix channel in the signal 
path, when you select No Input Processing, Include Auto‑mixing clears and 
does not turn back on even when No Input Processing is unselected. If you want to 
continue to have an automixing channel in the signal path, it must be selected again.

Mix-point

Input #1
Output #1

-35
0.0 dB

25

Mute

No Automixing
Includes Automixing
No Input Processing

Input level is set to 0 dB.

OK Cancel
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Mix-point Examples
In order to better understand how mix‑points work, the following diagrams provide 
examples of mixes. 

NOTE:	 To simplify the diagrams not all input and output lines are shown. 

Figure 45.	 Input 1 to Output 1

In the first example (see figure 45) input audio from Input 1 is processed and arrives at the 
output 1 matrix mix‑point. Double-click the mix‑point to open the dialog box. When the 
mix‑point is unmuted, the mix junction turns teal with a light green circle to indicate the open 
mix‑point dialog box is the focus (see Mix‑point Behavior: on page 72), and the signal 
is routed to output 1. 

The mix level is adjusted using the slider or by direct input of a value between - 35.0 and 
25.0 dB into the dialog box below the slider.

 

DMP 128 • Software Control 74



Figure 46.	 All Inputs to Output 1

In the next example (see figure 46), input audio from all twelve mic/line inputs are processed 
individually and arrive at their output 1 mix‑points. As each mix‑point mute button is 
released, its output 1 mix‑point junction turns teal, and the signals are all routed to Output 1. 
Since all the signals are now on output signal line 1, open the individual mix‑points to adjust 
the individual signal levels for the desired balance. Open the output 1 trim, processing, or 
volume blocks to change the signal levels or effects for the signals from the mix-points. 

In this manner, any single input, or any number of inputs can be routed to any single output 
or any number of outputs.
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Figure 47.	 Input 1 to All Outputs

In the example in figure 47, input 1 is routed to all eight outputs by unmuting the mix‑point 
for Input 1 for each output (1 through 8) bus. The example also shows the mix‑point for 
output four with input processing bypassed (green) and the mix-point for output eight with 
active automix. 
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Virtual Send Bus Mix Matrix
The DSP architecture contains a Virtual Send Bus mix matrix that connects the inputs and 
virtual bus return signals to the virtual sends. There is an additional mix matrix to route EXP 
input signals to the virtual sends. 

The DSP Configurator main screen provides control of the virtual bus mix matrix, used to 
set levels from input signals to the virtual sends. Each of the twelve mic/line and eight virtual 
return inputs are connected to a mix‑point for virtual bus A through H (and the EXP inputs). 
Each mix‑point is muted and set to 0.0 dB (unity gain) by default. In general, mix levels are 
set relative to each other, achieving a desired blend of input signals at an optimal level close 
to, but not exceeding 0 dBFS at the output volume level meter. 

The virtual mix matrix contains a section (see figure 48) that allow the virtual bus returns 
to be routed back to the virtual bus matrix for further processing using an additional virtual 
bus processing block. To prevent feedback loops, a virtual channel is prevented from being 
routed back to itself by eliminating the mix‑point that would allow that to occur. 

In situations requiring extra processing, the virtual bus return output is routed back to the 
virtual bus send mix matrix, which then routes the signal back to a processing signal chain 
other than the one it was routed from.

Virtual Send Bus Mix-points
(from Mic/Line Inputs)

Virtual Send
Bus Mix Matrix

Virtual Send Bus Mix-points
(from Virtual Bus Returns)

EXP Inputs to Virtual Bus 
Sends

A

B

C

Figure 48.	 Virtual Bus Mix Matrix (EXP inputs 9-16 not shown)
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In the example in figure 49 below, input 1 is sent to the virtual send bus by muting all eight 
signals on the Input 1 output mix‑points and unmuting virtual send bus output 1. The 
virtual bus now serves as additional signal processing for the input. The signal routes from 
virtual send A through the virtual bus A signal chain before it is sent to the virtual bus return 
mix‑point and finally to output 1.

This configuration is useful when more than one input requires identical processing. For 
example if all inputs were normalized but required a uniform gain to bring them up to 
adequate output levels, rather than changing each pre-mix gain control by a similar amount, 
all twelve inputs can be routed to a virtual bus (in this case virtual bus A). Then, using the 
virtual bus A return gain control, a single adjustment can apply the same gain to all twelve 
inputs before sending the signal to the desired output.

In other cases, when multiple mic inputs are mixed with program material, only the program 
material might require loudness contouring. So the mics are routed directly to the output but 
the program material input is routed to the virtual bus return where loudness contouring is 
applied. The program material is then routed to the same output as the mics. 

Figure 49.	 Input 1 to Virtual Bus A
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Expansion Outputs Mix Matrix
The DSP architecture contains a third mix matrix that supports connection of a second 
DMP 128 using the included shielded CAT 6 cable. If the included cable is not long enough 
use shield CAT 6 wired in a straight through configuration up to 35 feet (10 meters). The 
output connects the mic/line inputs and virtual returns to the Expansion Outputs. The 
DSP Configurator main screen provides all necessary control of the mix matrix.

Expansion Outputs
Mix Matrix

Inputs to
EXP Sends
(1-8)

Virtual Returns
to
EXP Sends
(9-16 only)

Exp Inputs
to
Outputs

EXP Inputs
to
Virtual Sends

Figure 50.	 Expansion Bus Mix Matrix 
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Extron EXP Bus
Using the Extron Expansion port (EXP), two DMP 128 units can be connected together for 
bi-directional communication of 16 audio channels. 

The expansion bus mix matrix can route any or all of the mic/line inputs to any or all of 
the expansion outs (1 through 8). In addtion, there are eight channels (expansion outs 9 
through 16) directly connected to the virtual bus returns. 

Connecting the EXP Ports
Minimal setup is required for EXP port communications. One DMP 128 must be set as the 
Primary Unit, and the other as the Secondary Unit to synchronize the sampling clocks of 
the two units. This has no bearing on how audio is transported from unit to unit, making it 
unimportant which unit is set to primary. 

NOTE: You can connect a DMP 128 AT to a non-AT unit by the EXP ports, however 
be aware that the AT unit defaults to the primary unit and cannot be changed. 

You cannot connect a DMP 128 AT model to another AT model by the EXP ports 
because there is no option to set one as primary and the other as secondary as 
required.

To enable the expansion bus between two units:

The EXP bus requires one device be configured as the primary unit and the other as the 
secondary unit. The tools menu is used to configure the connection. 

1.	 Power on both units. Open DSP Configurator and connect Live to the first unit. From 
the main menu, select Tools > Expansion Bus > Primary Unit. 

A checkmark appears beside the active unit.

Figure 51.	 Expansion Bus Unit Selection

2.	 Select Tools > Connect to Device and connect Live to the second unit. 

3.	 Select Tools > Expansion Bus >S econdary Unit.

A checkmark appears beside Secondary Unit.
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4.	 Connect the EXP port of one unit to the EXP port of a second unit 
using the included shielded (or similar) CAT 6 cable.

NOTE:  The front panel EXP LED indicates device to device 
connection and configuration status as follows:

•	 (non-AT models)

•	 Off — The unit is not connected to a second DMP 128.

•	 On — The unit is connected to another DMP 128 and 
configured as the primary unit.

•	 Blinking — The unit is connected to another DMP 128 
and is currently configured as the secondary unit.

•	 (AT Models) 

•	 Off — Dante device is not responding.

•	 On — The EXP port is connected to a non-AT DMP 128 
and configured as the primary unit.

•	 Blinking — The EXP port is not connected.

Using the Expansion Bus
After configuration and connection, the two units have 16x16 channels of bi-directional 
audio communication.

•	 The expansion bus from the primary unit (see figure 52, A) sends audio to Expansion 
inputs 1 to 16 of the secondary unit (see figure 52, B). 

•	 At the same time, the expansion bus from the secondary unit sends audio to Expansion 
inputs 1 to 16 of the primary unit. 

0
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2

3

4

5

6

EXP Bus Connection
Primary (1) to Secondary (2)

AA BB
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Figure 52.	 EXP Bus Connections
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The mic/line inputs and the virtual bus returns make up the expansion bus mix matrix that 
feed EXP outputs 1 through 8 (see figure 52, Î, on the previous page) of the primary unit. 
They are connected to EXP inputs 1 through 8 of the secondary unit (Ï), respectively.

The primary unit EXP outputs 9 to 16 (see figure 52, Õ) are direct feeds from virtual bus 
returns A – H (post processing). They are connected to EXP inputs 9 to 16 of the secondary 
unit (Ö)

Device Manager
When multiple DMP 128s are connected, use the Device Manager to select the device open 
in the DSP Configurator dialog box.

From the menu bar, select Tools > Device Manager to open the Device Manager dialog 
shown in figure 53.

ABCD

Figure 53.	 Device Manager Dialog

The icons function as follows:

A	 Add Device –  Brings up the opening DSP Configurator connection dialog  allowing the 
selection of the model number of the secondary device.

B	 Clone Device –  Provides the option to duplicate the primary device configuration to 
the connected secondary device.

C	 Delete Device –  Deletes the highlighted device

D	 Expand or Collapse Device –  If the device connection tree is collapsed, allows it to 
be expanded. If the device tree is collapsed, expands it.

The icons for the devices are unavailable if the device is offline.

AT (Dante) Bus 
For connection and software operation of the AT bus and Dante Controller software, see  
Dante Controller Software Installation on page 114.
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Group Masters
There are 32 Group Masters that can each be configured to simultaneously control up 
to 16 group members. Group masters are configured in DSP Configurator and saved in 
the device. Working in emulate mode, group masters are saved in a configuration file and 
pushed to the device upon connection. 

A group master can either be a gain control or a mute control. Only one control type can 
be selected as group members for control by a group master. For example, a group master 
can be configured to control post-matrix gain levels, but not post-matrix gains plus input 
gain block. A group member can, however, be controlled by multiple group masters. It is 
recommended this feature be used cautiously, as “overlapping” membership can quickly 
become unmanageable. 

Group master gain controls can send specific values, such as those sent by a fader control. 
Group master gain can also be set by increment and decrement (see Tools on page 87). 

Group Members
Once a group has been created, the group members — the individual controls that 
comprise the group — update to indicate they are now part of a group. Group members 
can be controlled individually, allowing for relative levels between members to be fine‑tuned. 
Group member levels can also be set by a preset recall.

Grouped Controls
Grouping is convenient when multiple controls require muting at the same time or when 
multiple signal levels need to be increased or decreased simultaneously. For example, in 
a system with several audio outputs dedicated to a single room, the operator can want all 
outputs to change at the same rate and at the same time. The output 1 through 4 volume 
controls are grouped into a master so that one group volume control, controls the volume 
throughout the room.

For further flexibility, individual volume controls in the group are set for an output level based 
on its use. When the group fader moves, all four output control faders move in tandem while 
retaining their levels relative to each other.

Grouped faders move together at relative levels to the top or bottom of their travel (see 
figure 54, next page). If one fader reaches the limit of its travel first, it retains that position 
while the other faders continue to travel. When the grouped faders travel in the reverse 
direction, the fader that was at its limit reverts to its position relative to the other faders. 

NOTE:	 If a block was previously muted when the group mute is activated, that block 
remains muted when the group mute is released.

TIP:	 When including a control in multiple groups, do so with care. Overlapping group 
membership can quickly become unmanageable. Use presets to set individual faders 
to known levels.
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Figure 54.	 Sample Gain Group Master and Associated Gain Controls

Mute controls within the blocks can also be grouped (see figure 55). 

Figure 55.	 Sample Mute Group Master and Muted Outputs
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Configuring a Group Master
To configure a group:

1.	 Click Tools > Configure Groups (see figure 55 on the previous page) to open the 
Configure Groups dialog. 

or click View > Group Controls > Add a Group.

2.	 Click the Select Group drop-down list (see figure 56). The list defaults to the first 
empty group. Select an empty group, or an existing group to overwrite.

Figure 56.	 Configure Groups, Add Group Dialog Box

NOTE:	 <empty> groups have no group members assigned. Numbered groups 
(such as <Group #1>) have controls assigned that can be overwritten.

3.	 In the Select Control Type panel, expand the tree for the type of control, Gain or 
Mute and select the desired control type. When a selection is made, the Available 
Group Members panel populates with all possible members for the selected control 
type. 

NOTE:	 Potential group members in step 4 that are already assigned to a different 
group are displayed in blue.

4.	 In the Available Group Members panel, click the checkbox to make appropriate 
selections. When a plus sign (+) exists, click to expand the tree and select individual 
controls. Up to 16 group members can be added.

5.	 Click Apply to create or configure the group.

6.	 Repeat steps 2 through 5 to create or configure up to 32 groups.

7.	 Click Close to exit the configure groups dialog.
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Deleting a Group Master
To delete a group:

1.	 Click Tools > Configure Groups (see figure 57) to open the configure groups dialog 
box 

or click View > Group Controls and then click Add a Group.

2.	 In the Select Group drop-down list, click a numbered group (such as Group #1).

3.	 Click Delete Current Group in the lower left area.

4.	 Click Yes in the Confirm Deletion dialog box.

Viewing and Using a Group Master
Click View > Group Controls to open the group controls dialog box (see figure 58). The 
group controls dialog contains two menu items:

•	 Add a Group allows you to add additional groups.

•	 Tools enable you to perform various functions from the Group Controls dialog box.

In addition, once groups are created, a single mute button or a group fader plus the current 
setting readout and any soft limits are visible.

Figure 57.	 Group Controls Dialog Box

The group fader controls function as follows:

•	 Slide a group fader up and down to adjust all gain controls in the group.

•	 Click and drag a soft limit ( ) to set the ceiling and floor for the group.

NOTE:	 Soft limits cannot be dragged beyond the current setting of the group fader.

Add a Group
To launch the Configure Groups dialog box from group controls, click Add a Group. When 
a new group is added and the Add New Group dialog is closed, the Group Controls dialog 
box refreshes to display the added control.

NOTE:	 If a block is previously muted, that block remains muted when the group mute 
is released.

 

DMP 128 • Software Control 86



Tools
The Tools menu (see right) contains these selections:

•	 Clear All Groups — clears 
all group members and group 
master parameters. Soft limits 
are also cleared.

•	 Increment/Decrement 
Simulator — allows the user to 
test increment/decrement values 
(see below for more information)

•	 Refresh All Group Data — 
Updates group members and group master parameters.

•	 Group Details Report — generates a report, listing all group masters and 
membership (see Group Details Report on page 88).

Increment/Decrement Simulator

The Increment/Decrement Simulator provides a control for increment and decrement, with 
the ability to set increment and decrement values. The control is temporary, since the value 
is not remembered in the device. 

To use the Increment/Decrement Simulator:

1.	 Select Tools > Increment/Decrement Simulator.

2.	 Select the group to be controlled from the Select Group drop-down list. The following 
dialog box opens:

Figure 58. Increment/Decrement Simulator Dialog Box

NOTE:	 The Number of Group Members: readout indicates the number of controls 
affected.

3.	 Enter an increment value and a decrement value. The default value is 1. 

NOTE:	 The size of the increment can be changed by typing a value in the 
Increment Value or Decrement Value field. Values can be as large as the 
maximum range of the control or as fine as 0.1 dB. For groups controlling mute, 1 
is the only valid value.

4.	 Click Increment and Decrement as needed. The group master control increases or 
decreases by the set value to the top or bottom of its soft limit range.

NOTE:	 When set, soft limits cannot be exceeded.
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Group Details Report

Select Tools > Group Details Report to create a text file that details all created groups 
(see figure 59).

 GROUP DETAILS REPORT
Group #1
 Processor Type: Output Volume
 Current Mute status: Unmuted
 Current Group Members:
  Main Amp (Output#1) Left Channel
  Stage Mixer (Output#2) Right Channel
  House Video (Output#3) Left Channel
  Prgm Record (Output#4) Right Channel

Group #2
 Processor Type: Pre-mixer Trim
 Current Gain value: 2 dB
 Current Group Members:
  Mic #1 (Input#1)
  Mic #2 (Input#2)
  Mic #3 (Input#3)
  Mic #4 (Input#4)
  Mic #5 (Input#5)
  Mic #6 (Input#6)

Figure 59.	 Sample Group Details Report

Soft Limits
Each gain type control provides upper and lower soft limits used to limit the range of the 
group master control. Soft limits ( ), shown at left, limit group controls from exceeding an 
upper limit or going below a lower limit. They are easily adjustable and provide the ability to 
set a ceiling and floor for the group. When a group master is created, the soft limits default 
to the hard limits (maximum and minimum) of that group of controls. 

Soft limits are defined using the mouse. Click on and drag the  
Soft Limit icon. The resolution is 0.1 dB.  
For more precise setting use the keyboard as follows:

Click within the group master fader to bring focus and use the following key combinations: 

To move the upper limit:

•	 <Shift + Up/down arrow> moves in 0.1 dB increments.

•	 <Shift + Page Up/Page Down> moves in 10 dB increments.

•	 <Shift + Home> moves limit to upper default. <Shift + End> moves limit to the current 
fader position.

To move the lower limit:

•	 <Ctrl + Up/down arrow> moves in 0.1 dB increments.

•	 <Ctrl + Page Up/Page Down> moves in 10 dB increments.

•	 <Ctrl + Home> moves limit to the current fader position. <Ctrl + End> moves limit to 
lower default.
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Digital I/O Ports
The DMP 128 provides twenty digital I/O ports that can trigger external events from 
DMP 128 actions, or allow external events to trigger DMP 128 actions. DSP Configurator 
provides pre-configured scripts with a fixed set of common trigger or event combinations. 
When selected, the script is compiled and placed onto the File Management system of the 
device. For more advanced or custom scripts, contact an Extron Electronics Applications 
Engineer.

When there are no scripts active, the digital I/O ports default to DI (digital input) and inactive 
(‘Logic Hi’ ≈  +5 VDC). The DI detects a Logic Hi as +5 VDC and Logic Low (active) as less 
than +1 VDC. 

A DO (digital output) sends a Logic Lo as less than +1 VDC and a Logic Hi as +5 VDC. For 
every script that involves a DO, two versions are available to provide either a Logic Hi or a 
Logic Lo response to any action. The alternate script is designated as “Reverse DO”.

To build a script and place it into the DMP 128 File Management system:

1.	 From the main menu, click Tools > Configure Digital I/O > Build Digital I/O 
Configuration. 

Figure 60.	 Build Digital I/O Configuration Tool

A dialog box opens with a list of pre-configured scripts.

2.	 Select a script from the Select a Digital I/O Configuration section. The 
Event Description panel describes the script and how the digital I/O ports act while 
the script is running.  

Figure 61.	 Configure Digital I/O Dialog

3.	 Highlight the desired script and click OK.

A dialog box opens, verifying the file successfully uploaded to the device. 

NOTE:	 When performing this procedure in Emulate mode, the connection dialog 
opens. The DSP Configurator connects and then disconnects during the 
procedure, returning to Emulate mode when completed.
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Reinitialize Digital I/O
Should the script stop running for any reason, select  
Tools > Configure DigitalI/O > Reinitialize Digital I/O.  
This option is only available in live mode.

To remove a digital I/O script from the DMP 128:

Only one digital I/O configuration can be active at a time. If the I/O activity requires 
modification, remove the current configuration by:

1.	 From the main menu, select Tools>Configure Digital I/O > Remove Digital I/O 
Configuration from the Device and click OK.

2.	 If the DSP Configurator is connected to a device, the I/O configuration is removed. If it is 
not connected, a connection dialog box appears. 

3.	 Make certain the connection information is correct and click OK. The I/O configuration 
script is removed and a confirmation dialog box appears. 

Emulate Mode and Live Mode
DSP Configurator has two operational modes, Live and Emulate. In live mode, the program 
has established a connection and is synced with the DMP 128. Changes affect the device 
in real-time and changes in the current state of the device are reflected in DSP Configurator. 
In contrast, emulate mode allows the user to work offline, creating or editing configurations 
that do not immediately affect DMP 128 operation.

DSP Configurator always starts in Emulate mode. In Emulate mode, all functions of 
DSP Configurator are available without connecting to the DMP 128. The user can build 
a configuration from the blank screen, or open an existing file that contains the last 
configuration displayed plus saved presets. Settings and adjustments are saved to a 
configuration file on the PC. When the saved file is opened in DSP Configurator, all settings 
are restored as the current configuration (emulated if in Emulate mode or live if in Live 
mode).

Live mode can be entered at any time after program launch, either with a blank 
configuration, after creating a configuration, or after loading a previously saved configuration 
file. 

In emulate mode, the current state is titled Current Emulation. In live mode, the current 
state is titled, Current State. 

Synchronizing: Pull from or Push to the Device
When switching to live mode, either:

•	 Pull data from the device and update the program configuration. This 
option downloads device settings from the DMP 128 and synchronizes it with 
DSP Configurator overwriting the current DSP Configurator settings, or

•	 Push data from DSP Configurator to the device, overwriting settings in the DMP 128.

Live mode is also used to tailor audio settings in real time while listening to the audio output.
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Selecting Live Mode and Pushing or Pulling Data
To switch from Emulate to Live mode:

1.	 Select the desired connection to the DMP 128 and make the proper connections. 

NOTE:	 Extron recommends connection via the Ethernet LAN port when using 
DSP Configurator.

2.	 Click Live (see figure 62, 2). The communication type selection dialog opens.
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Figure 62. Selecting Live Mode

3.	 To select the connection method, click:

•	 TCP/IP (for connection of the LAN port (preferred) — proceed to step 4 

•	 RS-232 (for connection of the rear panel RS-232 port — proceed to step 5

•	 USB (for connection of the front panel configuration port — proceed to step 6

4.	 If TCP/IP is selected in step 3:

a.	 Observe the IP address field in the IP connection dialog box. The field displays 
the last IP address entered.

•	 If the IP Address field is correct, proceed to step 4b

•	 If the address is not correct, either click in the IP Address field and enter 
the correct IP address or click ( ) to open a drop-down list and select from 
among recently used addresses. Proceed to step 4b

NOTE:	 If the local system administrators have not changed the value, 
the factory‑specified default, 192.168.254.254, is the correct value for 
this field.

b.	 If the device is password protected, click in the Password field and enter the 
appropriate administrator password

c.	 Click OK.

The Synchronize with Device dialog box (see figure 63 on page 93) opens. 
Proceed to step 7.
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5.	 If RS-232 is selected in step 3:

a.	 Click the Com Port drop-down list and select the port connected to the rear panel 
RS-232 port.

b.	 Check the baud rate displayed in the port selection dialog box. If the baud rate 
does not match the device rate, click the Baud Rate drop-down list and select the 
desired baud rate. The default is 38400.

c.	 Click OK.

The Synchronize with Device dialog box (see figure 63 on next page) opens. 
Proceed to step 7.

6.	 If USB is selected in step 3:

a.	 Click the USB Device drop-down list and select DMP 128 (or Extron USB device, if 
a DMP 128 is not available),

b.	 Click OK.

The Synchronize with Device dialog box (see figure 64 on next page) opens. 
Proceed to step 7.
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Figure 63. Selecting Live Mode (Continued)

7.	 Click either:

a.	 Pull to configure DSP 
Configurator to match the 
device — proceed to step 9

-or-
b.	 Push to configure the device to 

match DSP Configurator  
— proceed to step 8

8.	 To push all of the gain and processor 
block adjustments (configuration), 
and all presets to the DMP 128, proceed to step 9.

To tailor the push (push only the configuration, only the 
presets, or the configuration and selected presets), 
click Advanced and proceed to step 8a.

a.	 Select the Custom radio button.

b.	 Select the desired checkbox or checkboxes; Push 
Configuration and/or Push Presets. If Push 
Configuration is the only box checked, click OK 
and proceed to step 9.

NOTE:	 Push Configuration includes 
all mix‑point, gain and processor block 
settings. It does not include partial presets.

c.	 If Push Presets was selected in step 8b, click 
All to select all presets or Selected to choose 
specific presets.

•	 If Selected is clicked, click OK and proceed to 
step 8d.

•	 If All is clicked (equivalent to a standard push), 
click OK and proceed to step 9.

d.	 If Selected is clicked in step 8c, the Synchronize 
with Device dialog box (7b) reopens. Click OK. 
The presets dialog box opens.

e.	 Select the desired partial presets to push by 
clicking the appropriate checkbox or checkboxes.

f.	 Click OK. — Proceed to step 10.

9.	 Click OK. The DSP Configurator program is connected live to the device and the processors and 
presets are pushed or pulled as selected, completing the selection of Live mode.

10.	 If changes are made to the DSP parameters (including mix‑point, gain or processor blocks) since the 
last file save, DSP Configurator prompts to save the file. Click Yes or No.

If a password is required and not entered or if an incorrect password is entered, the program prompts 
for the password.

The configuration and presets are uploaded to the DMP 128.
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Presets
Presets recall a group of frequently used settings. Presets created by DSP Configurator 
can contain all elements (gain blocks, processor blocks, and mix‑points) or a portion of the 
elements available within the program. In Emulate mode, up to 32 partial presets can be 
created and uploaded as a set and stored to the device or stored to disk as a configuration 
file. In Live mode, presets can be created one at a time from the current state. They can be 
saved to a chosen preset number in the device, with the option to name or rename, or save 
to disk.

When recalled, a preset overwrites only elements contained in the preset. Presets are useful 
when settings for a particular room or only certain elements of a configuration need to be 
changed regularly.

Presets can be created in Live or Emulate modes. In Emulate mode, presets are created, 
saved to a file and pushed to the DMP 128 when connecting Live. 

When a pull data synchronization method is performed, preset data remains in the 
DMP 128, with only the list of preset names pulled from the device. Presets in this state are 
marked with an asterisk until that preset is recalled (which pulls the preset data from the 
device), or until a backup is performed (see Backup on page 28). Presets pulled from the 
device cannot be saved to disk until they have been recalled, at which time the preset data 
is pulled into the DSP Configurator. Presets with no asterisk can be saved to disk. 

Saved presets can be recalled via the DSP Configurator, or a control system sending an SIS 
preset recall command. Presets may also be saved and recalled via the embedded Web 
page. Presets saved via the Web page contain input gain, output volume, and the output 
mix‑point settings. 

Previewing and Recalling a Preset
A preset is previewed in either Live or Emulate mode by selecting the preset from the 
preset drop-down list. 

The program indicates a view-only preset configuration by displaying each preset element 
with a translucent green mask over the block. 

Figure 64.	 Preset Preview

Behavior for previewing and applying presets is as follows:

•	 Live Mode –  After selecting a preset, DSP Configurator displays the preset elements 
that are affected by a preset recall with a translucent mask over the element, and leaves 
all other DSP Configurator elements unaltered. Elements without a translucent mask 
represent elements in the current state that are unaffected by a preset recall. Real-time 
changes to the current state are not reflected while previewing a preset, and the user 
cannot alter those elements. To apply the preset, click Recall. The preset reverts to 
Current State. 

•	 Emulate Mode –  After selecting a preset from the list, DSP Configurator displays the 
elements affected by a preset recall with a green translucent mask, leaving all other 
elements (which represent the current emulation) unaltered. Click Recall to apply 
the viewed preset to the current emulation. The preset number reverts to Current 
Emulation. 
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Building a Preset
Only elements of the preset highlighted (given focus) are saved as a preset. <Ctrl + A> 
highlights all elements within DSP Configurator.

To build a preset, highlight the desired DSP Configurator elements (gain/processor blocks, 
mix‑points) using standard Windows keyboard and mouse actions as follows:

1.	 Click on the desired block to select a single block, 

2.	 <Ctrl + click> to select multiple blocks that are not adjacent,

3.	 <Shift/hold + click> on the first block and click on the last block in either a vertical 
column or horizontal row to select multiple blocks, and

4.	 Click and drag a selection rectangle to select multiple adjacent blocks in either the 
vertical or horizontal direction.

5.	 Select Tools > Presets > Mark All Items or press <Ctrl + A>. This marks all 
elements within DSP Configurator, which saves a “full” preset,

6.	 To save the selection see Save Preset below.

Save Preset

A preset is saved in either Emulate mode or Live mode.

Saving a preset in Emulate mode stores that preset in the currently open file. The 
DSP Configurator file is saved to disk using File menu > Save (recommended), and pushed 
to the device after a connection is established. This differs from Live mode where the 
created preset is saved in real‑time to the device and becomes part of the configuration file. 

To save a preset:

1.	 Use click, <Ctrl + click>, <shift + click> or drag around the blocks to highlight the 
desired preset blocks.

2.	 Select Tools > Presets > Save Preset.

Figure 65.	 Select Save Preset Tool

3.	 Select a preset number. In the Preset Name dialog box, unused presets are named 
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unassigned. To create a new preset, select an unused preset number and type a 
preset name. If no name is entered, a default name is assigned. To overwrite an existing 
preset, select a preset with a name other than unassigned.

Figure 66.	 Save a Preset Dialog

4.	 Click OK to save the preset, or Cancel to stop the operation.

Managing Presets
Once the preset is created (whether or not the DSP Configurator file is saved) it appears in 
the preset list, available from the DSP Configurator screen. 

In Live and Emulate mode, after a preset is selected from the list, action buttons are 
available next to the presets bar.

The user can either Recall (make the preset active), Cancel (return to the current 
emulation or state) or Delete the preset. 

In Live mode, select Recall to apply the currently displayed preset elements (“marked” 
elements) from the stored preset and overwrite that portion of the current state. The 
drop‑down list switches to read Current State. 

In Emulate mode, the Recall action button applies the currently displayed preset 
elements (“marked” elements) from the file and overwrites the information contained in 
the DSP Configurator as the current emulation. It then changes the drop‑down list to read 
Current Emulation.

When a preset is previewed, in either Live or Emulate mode, the Delete button is 
available. In Live mode, the preset is deleted from the hardware, which is reflected in 
software (it is removed from the preset list). After disconnecting from the device and before 
exiting the program, the file must be saved to retain this change. In Emulate mode, the 
preset is deleted from the file in software, which must then be saved (before exiting) to 
retain this change. In either Live or Emulate mode, Cancel defeats the preview action and 
returns the user to current state or current emulation, respectively.
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Presets: Pull, Push, or Create Live
When a preset is pulled from the device, the preset data remains in the device until the 
preset is recalled. DSP Configurator pulls the names of the presets only. These presets 
cannot be saved to disk until recalled. 

An asterisk next to the preset name indicates that only the preset name has been pulled 
from the device, and the preset data exists only in the device (it has not been recalled). 
Presets pushed to the device or created in DSP Configurator in live mode, have no asterisk. 
Presets with no asterisk can be saved to disk.  

Protected Configuration
A protected configuration is secured with PIN protection. The protected configuration can 
be recalled by any user, but can only be written or overwritten using the assigned (up to) 
4-digit PIN. Utilities for save/recall/change PIN, separate from preset save, are accessed 
from the tools menu as three sub-menus under a protected configuration menu item.

Protected configuration menu items are available only in Live mode from the 
Tools>Protected Configuration menu. These functions can only be performed in Live 
mode, and are unavailable in Emulate mode.

•	 Save 

•	 Recall

•	 Change PIN

Save Protected Configuration
The default PIN is 0000. The user enters the default PIN or can use the Change PIN (see 
below) dialog to create a new one. 

Recall Protected Configuration
The dialog prompts the user to continue. Click OK to continue or Cancel the operation.

Change PIN
The change PIN utility changes a current protected configuration PIN. The current PIN must 
be entered before changes are allowed.

 

DMP 128 • Software Control 97



DSP Configurator Windows Menus
Keyboard Navigation

DSP Configurator is fully navigable using the computer keyboard. Some keyboard 
navigation behaviors match Windows standards, while other behaviors are specific to DSP 
Configurator.
<Tab> jumps to the various sections outlined in red in figure 67, below. When the program 
starts, the cursor defaults to the Emulate button (1). 
Within the sections, the <navigation arrows> move one processor block or mix‑point right, 
left, up, or down within the section.

Virtual Returns

Expansion Returns

Exp. Inputs 1 - 8

Exp. Inputs 9 - 16

Outputs

Inputs

22 1133

44

66

££

¨̈
©©
ªª §§¦¦¥¥¤¤

88 99 ¢¢77

55

Figure 67.	 DSP Configurator Program

Standard Windows Navigation
The keyboard keys navigate and function as follows:

•	 Tab key — Press to jump focus to the next area, then the next, and the next in teh 
following order.  

1	 Emulate mode ¢	Expansion Send bus mix‑points

2	 Live mode £	 Virtual Returns minimize button

3	 Presets (Down arrow can select presets) ¤	 Virtual Return signal path (defaults to FBS)

4	 Outputs minimize button ¥	 Virtual Return bus mix-points

5	 Output signal path (defaults to trim) ¦	 Virtual Return bus to Virtual sends

6	 Input minimize button §	 Virtual Return bus to EXP sends

7	 Input signal processing (defaults to gain) ¨	 EXP Returns bus minimize button

8	 Main mix-points ©	 EXP Inputs bus 1 to 8 maximize button

9	 Virtual Send bus mix-points ª	 EXP Inputs bus 9 to16 maximize button
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NOTE:	 The first selection in any area is always the minimize/maximize button. If the area is hidden, 
the next <Tab> moves the highlight to the minimize/maximize button of the next section. If the area 
is maximized, the next <Tab> moves to the signal processing chain or mix‑points (depending on 
the section) before leaving the area for the next section in order.

•	 Shift+Tab key combination —  
Reverses the direction of the Tab key function.

•	 Arrow ( , , , ) keys —  
Navigate up, down, left, and right within any of the areas outlined in 
figure 67 on page 98.

•	 Enter Key — Performs the same action as a mouse double-click. For 
example, opens the context menu from which a processor type is selected 
or opens a dialog box when applicable. When an action button is highlighted, <Enter> 
executes the button action or toggles the button as applicable.

•	 Control key — <Ctrl> is used in the following shortcuts.

•	 <Ctrl+X> — Cut the selected elements.

•	 <Ctrl+C> — Copy the selected elements.

•	 <Ctrl+V> — Paste the selected elements from a previous cut or copy.

•	 <Ctrl+A> — The first press of the <Ctrl+A> combination highlights all A/V matrix 
block nodes. 

•	 Alt key — <Alt> is used with specific letter keys to open and navigate task bar menus. 
When the <Alt> key is pressed and released, the File menu opens. When the Alt key is 
pressed and held, the first letters in the menu titles (File, Edit, View, Tools, Window, or 
Help) become underlined. Press the underlined letter key to open that menu.

•	 Once a task bar menu is open, use the up and down arrow keys to move up and down 
in the menu or submenu, use the right key to open a submenu (if applicable), and use 
<Esc> to back out of an active menu or submenu.

DSP Configurator-unique Navigation

Highlighting and marking items, cutting or copying, saving a preset:

When an item within the program is selected, it is highlighted by a green boundary box. One 
or more highlighted items can be cut, copied, pasted, or saved as a preset. The cut, copy, 
and paste functions can be performed using the task bar menus (see the <Alt> key, above) 
or the shortcuts described on the previous page.

NOTE:	 When an item is cut, it is not removed from its original location until it has been 
pasted in its new location.

Highlight multiple elements for cut, copy, paste, or a preset as follows:

1.	 Use the navigation ( , , , and ) keys to move to the first block. 

2.	 To highlight a block:

a.	 Press and hold the <Shift> key and use the navigation keys to move away from 
the selected block.

b.	 To highlight additional sequential blocks, continue to hold <Shift> and use the 
navigation keys to move away from the selected block. Additional blocks are 
highlighted as long as <Shift> is held down. When the last element is highlighted, 
move the highlight box one additional block and release the <Shift> key.

 

DMP 128 • Software Control 99



3.	 To move away from the highlighted block or set of sequential blocks, or to highlight 
non‑sequential blocks:

a.	 After highlighting blocks in step 2, press and hold <Ctrl> and use the navigation 
keys to move to the next desired element. As long as <Ctrl> is held down, the block 
moved away from is not highlighted. If the block is highlighted, it is unhightlighted.

b.	 Release <Ctrl>, but do not press any navigation keys.

4.	 To highlight another element or group of elements, repeat steps 2 and 3 as required.

5.	 To cut or copy, press <Ctrl+X> or <Ctrl+C>.

6.	 To save a preset, press <Alt+T>. The toolbar Tools menu list opens with the Presets 
submenu highlighted.

7.	 Press the right arrow to open the Presets submenu.

8.	 Press the down arrow to highlight Save Preset.

9.	 Press <Enter> (see figure 68).

10.	The Save a Preset dialog box opens.

11.	<Tab> to the preset number field and enter a specific preset number.

12.	<Tab> to the preset name field and enter a preset name.

NOTE:	 Unless entering a specific number and name, DSP Configurator enters 
the next sequential unused preset number.

13.	<Tab> to highlight OK and press <Enter>.

Alt T Enter+

Figure 68.	 Saving a Preset Using Keyboard Navigation
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Optimizing Audio Levels
The DMP 128 uses floating point DSP technology, processing data using a combination 
of 32- and 128-bit algorithms. The analog to digital converters (ADC) and digital to analog 
converters (DAC) sample at 48kHz, with 24-bit resolution. 

With floating point DSP it is extremely difficult to clip the audio signal within the DSP audio 
signal chain, after the ADC input and before the DAC output. That means the audio signal 
must not be clipped at the input ADC. Clipping gives audibly undesirable results and once 
the audio is clipped at the input, there is no way to correct it further down the signal chain. 
If audio clipping occurs at the output DAC (that is not a result of clipping at the input ADC) 
there are ways to address it within the DSP audio signal chain.

The DSP Configurator meters indicate clipping at a user-definable point, with the default 
setting at – 1 dB. This means the meter indicates clipping when it reaches – 1 dBFS, or 1 dB 
below actual clipping (0 dBFS). Setting the clipping meter below actual clipping provides 
a “safety net”, allowing the user to reduce input gain before clipping actually occurs. This 
safety net can be increased or decreased by selecting Tools > Options > Processor 
Defaults > Defaults > Meter Clipping, and setting the Clip Threshold to a number 
between 0 and –  20 (dB). 

NOTE:	 When the Clip Threshold is set to 0 (dB), clipping is indicated only when 
clipping occurs.

Meters within DSP Configurator are peak-type meters, referenced to full scale, or 0 dBFS. 
For the DMP 128 outputs, 0 dBFS corresponds to +21 dBu, the maximum output level of 
the device. Maximum input level is +24 dBu. Gain from –  3 dB to +80 dB is applied in the 
analog domain, while attenuation from –  3 dB to – 18 dB is applied in the digital domain. The 
input meters are post-ADC, while the output meters are pre-DAC.
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The remainder of this section references the gain, trim and volume controls outlined in 
figure 69. 

A B C D E

Figure 69.	 Gain, Trim and Volume Controls

A	 Mic/Line input gain C	Mix‑point gain E	Output volume

B	Pre-mixer gain D	Post-mixer trim

About Setting Gain Structure
There are two approaches the system designer can take in setting up gain structure 
depending upon where output volume is controlled. The output volume of the DMP 128 is 
controlled by either of the following two gain blocks:

•	 Output volume (E) 

•	 Pre-mixer gain (B) 

NOTE:	 While the pre-mixer gain control is not in the output signal chain, it can be 
used to control program level independent of mix‑point levels.

In the following instructions, setup is described for output volume and pre-mixer gain when 
appropriate.
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Setting Input Gain
Floating point DSP technology is internally more flexible than fixed point. However, the input 
ADCs and output DACs always run as fixed point, so it is important to optimize the audio by 
setting the input level as close to 0 dBFS as possible. This maintains the resolution at 24-
bit. Within the DSP it is not critical to maintain audio levels at 0 dBFS in order to secure the 
resolution at 24-bit.

Input gain is set using the intended input source device and typical source material. When 
source material is not available, it can be set using pink noise obtained either from a 
pre‑recorded track on a DVD or CD, or a signal generator. 

For program material, set the input gain level (figure 69 on page 102, A) so the meters 
reach approximately –  15 to –  12 dBFS, with peaks at approximately –  5 to –  3 dBFS. This 
setting provides enough headroom to accommodate transients or unanticipated loud events 
in the program material to avoid possible clipping. 

Use pink noise recorded at –  20 dBFS. If the player has an output level setting control, 
set the output of the player to maximum, or 0 dB of attenuation. If the maximum output 
setting provides gain, back off slightly from the maximum setting. Using a signal generator, 
set the output at – 10 dBu. Whichever pink noise source is used, set the input gain in the 
DSP Configurator so the input meter reads –  20 dBFS. 

Setting a Nominal Output Level
In order to set up a gain structure to include signal processing, listening to the audio can 
be advantageous. Route the audio that carries program material from the source to the 
speakers in the room. With the output volume control (see E on the previous page) set 
to –  20 dB, set the external amplifier so the source material plays at a volume level that is 
reasonably loud but tolerable. 

NOTE:	 To use the volume control for this purpose, set post-mixer trim (see figure 
69, D) to 0 dB. To use the post-mixer trim for this purpose, set volume to 0 dB 
(100%).

Verify the amplifier is not clipping by observing the amplifier clip indicator. This sets the 
amplification/volume nominal level of the system, and if desired, allows listening while 
making adjustments. Adjust or mute the volume control as necessary  
(see Setting Volume Control for the Amplifier Stage on page 105). 
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Adjusting Pre-mixer Gain
After setting input gain, add desired processors into the input signal chain. The pre‑mixer 
gain control (see figure 69 on page 102, B) is used to compensate for level changes 
due to processing. Adding a compressor generally reduces the signal level, while a filter can 
boost or cut the overall signal level. When changes are made to filter settings after setting 
dynamics processors, re‑check the levels in the dynamics processors to make certain they 
are still valid.

NOTE:	 This procedure is valid only when there is no active processing in the output 
signal path, and if the post-matrix trim value is set to 0 dB, unity gain. If processors 
are inserted in the output signal path, engage Bypass to temporarily remove them.

To adjust pre-mixer gain:

1.	 Open the line input gain (A), output volume (E), and pre-mixer gain (B) dialog boxes 
(figure 69). 

2.	 Connect program material (or pink noise) to the input,

3.	 Set the output volume to 100% (mute if necessary). 

4.	 Adjust pre-mixer gain (B) so the meter level of the input gain matches the meter level of 
the output volume. This maintains the audio at an optimal level in the input signal chain. 

This sets a good starting point. After setting up the mic input gain and mix‑point levels, 
output processing, and trim levels, if more headroom is required to prevent clipping at the 
outputs, return to the pre-mixer gain controls (B) and lower each one by specific amounts. 
Further minor adjustments to the pre-mixer gain controls help to balance perceived audio 
levels of the different inputs.

Using the pre-mixer gain for output volume control, the procedure can be reversed. Set 
pre-mixer gain to 0 dB. With program material (or pink noise) present at the input, adjust the 
output volume until the output volume meter level is below clipping (or ideally, matches the 
level at the input gain meter).

Setting Output Gain Structure
Add all desired processors into the output signal chain. Keep in mind that a filter can boost 
or cut the overall signal level and adding a compressor generally reduces the signal level. 
Inserting either or both can require resetting of the output volume. 

Since a limiter is the most likely choice for output processing and can only reduce the signal 
to prevent overload, a reduction of output level does not have to be considered. Loudness 
boosts the overall signal level, but only at lower volume settings 

After adding processors to the output signal chain, the output volume level can clip when 
set to 100% (or less). Floating point DSP can overcome clipping by lowering the output 
volume (E). Unless a user is prevented from changing the volume setting to 100% (or to 
any position where clipping occurs), it is best to adjust the pre-mixer gain (B) or post-mixer 
trim (D) control to prevent any possible clipping. 

Alternately, use the post-mixer trim controls to adjust output volume. Post-mixer trim 
controls provide 12 dB of gain, so use a group master with soft limits to control levels, 
setting an upper limit of 0 dB or less. Mic levels can also contribute to clipping at the 
outputs, and can need lowered to maintain the balance between program material (line 
outputs) and voice.
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Setting Mic/Line Input and Mix Levels
In this example, the mic/line input 1 signal is sent to output 1. To set the mic/line input and 
mix levels:

1.	 Connect a microphone to Input #1.

2.	 Double-click the mix‑point (see figure 69 on page 102, B) for mic/line input 1 to 
output 1 to open the dialog box for that mix‑point, and unmute the mix‑point to place 
that signal into the mix. 
The default level for the mix‑point is 0 dB, or unity gain.

3.	 Open the input 1 Gain (A) dialog box and set gain to 0 dB (turn on phantom power if 
the mic requires it) and unmute the channel. 

4.	 While testing the mic, raise the fader level until the mic is clearly audible. The amount of 
gain and the meter level reading vary at this point, but as a general guideline the input 
gain level is adjusted to 40 to 50 dB, with the meter averaging somewhere around 
–  20 dBFS. 

Although audio is optimized here, voice levels at mic inputs can vary greatly and further 
adjustment can be necessary. When the meters average around –  20 dBFS, enough 
headroom is available to accommodate sudden changes to voice levels.

Adjusting Trim
This is where setting gain structure becomes a balancing act. The following sections 
provide guidelines, but it may take a bit of going back and forth to correctly set levels for 
the installation. For example, output level can be controlled and kept below clipping using a 
compressor or limiter in the output dynamics block. However, adjusting the post-matrix trim 
will affect how the compressor or limiter works.

1.	 Apply program material (or pink noise) at the input being adjusted. 

2.	 Open the output Volume (E) and post-matrix Trim (D) dialog boxes. 

3.	 Set output Volume to 100% (mute if necessary). 

4.	 Adjust the post-matrix trim until the meter level in the output volume dialog is below 
clipping (or ideally, matches the level at the input gain meter). 

This maintains the audio at an optimal level in the output signal chain and prevents clipping 
at the output. 

Setting Volume Control for the Amplifier Stage
The maximum output of the DMP 128 is +21 dBu. As an example, assume the maximum 
input level of a power amp is +4 dBu with its input attenuator fully open. If using the output 
Volume control (E) of the DMP 128 to control volume levels, to ensure clipping does not 
occur at the amplifier, turn down the input attenuator of the power amp the equivalent 
of 17 dB (21 –  4 = 17). That puts the amplifier input level at – 13 dB (+4 – 17 = -13). If the 
amplifier setting (when the output volume controls of the DMP 128 are at maximum) is too 
loud for the room, it may need further reduction. If it is not loud enough for the room, a more 
powerful amplifier may be required.

Extron recommends using the output volume or post-mixer trim control on the DMP 128 for 
controlling output volume. If using loudness processing on the unit, it works in conjunction 
with these controls. 

Using the power amplifier input attenuation to control volume (using the same power amp 
maximum input level) set the output volume or post-mixer trim control of the DMP 128 
to -17 dB. This is another way that clip points of the two devices are matched. Verify the 
amplifier is not clipping by observing the amplifier clip indicator. 

NOTE:	 Using the amplifier input attenuation to control volume compromises the 
signal-to-noise ratio of the DMP 128, and is not recommended.
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Signal Path Building Blocks
The discrete signal paths (mic/line input, virtual return input, and line output) can be 
individually loaded with pre-configured, modular templates called building blocks. These 
blocks are designed for specific microphones, source devices or speaker destinations 
and can greatly streamline initial configuration. The blocks are configurable and are more 
versatile than a global template. 

The building blocks are loaded to a selected input (see figure 70, A) or output (B) by 
clicking the signal path label to open the building blocks dialog box. Building Blocks

AA

BB

Figure 70.	 Building Blocks

Slightly different dialog boxes are available according to the selected signal path, mic/line 
input, virtual return input, or line output.

Figure 71.	 Building Blocks Dialog Box
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The following steps select a lavalier microphone configuration for input #1.

1.	 Click the Input 1 box. 

11

Figure 72.	 Select Input 1 Building Block

The Building Blocks dialog opens (see figure 73).

2.	 Place the mouse over the text Lavalier to select it.

22

Figure 73.	 Building Blocks Dialog

The selected text changes color and is underlined. Click the selection (2).

3.	 The input channel loads the pre-configured processor blocks, sets the gain, and names 
the channel Lavalier. 

Figure 74.	 Building Block, Input 1

The building blocks can be renamed and processor blocks further customized according to 
the requirements of the system.

Adding a Building Block
Custom building blocks are created using a signal path configured for a specific device.

For example, when a new mic is connected to Input #3, the signal path might be tailored 
specifically for that mic. 

11

Figure 75.	 Input Selection Box

In this example a gain setting is applied and a noise gate inserted. They are then stored as a 
custom building block.
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To create a building block for the new microphone:

1.	 Click inside the input number box (see Figure 72, 1 on page 107). 
The Building Blocks dialog opens. 

2.	 Select the Add Block icon in the upper left (see figure 76, 2).

22

Figure 76.	 Add a Building Block Dialog

The Add a Building Block dialog box opens.

3.	 Enter a name for the new device in the dialog box Name: field, (see figure 77, 3).

33

44

Figure 77.	 New Device Naming

4.	 Select a folder for the new device (see figure 77, 4).

5.	 Click Add (see figure 78, 5).

55

Figure 78.	 Add a New Device
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6.	 The new mic configuration is now a building block used to quickly configure new 
devices (see figure 79).

Figure 79.	 New Device Building Block

A new configuration can also overwrite existing templates.

To Overwrite an Existing Configuration:

1.	 Click the desired input number box (see figure 70 on page 106).

2.	 In the dialog that opens, select the Add Block icon in the upper left (see figure 80, 2).

22

Figure 80.	 New Device Naming

3.	 In the Add a Building Block dialog box, enter an existing name for the new device 
(see figure 81, 3).

33

44

Figure 81.	 Enter the New Name Dialog

4.	 Select a folder for the new device (4).
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5.	 Click Add.

55

6.	 A dialog box prompts to warn an existing configuration is about to be overwritten.  
Click Yes.

66

7.	 The new mic configuration overwrites the existing template and is ready to use.

Organize Building Blocks
The Tools menu contains a utility that allow building 
blocks organization and rearrangment to suit an 
application. Individual blocks and folders are moved or 
deleted and new folders created.

The general categories of folders follow the main screen 
of DSP Configurator and include the main inputs, virtual 
return inputs and the line outputs.

You can also import and export a building block file so 
the building blocks can be used on other computers 
and DMP 128 devices.

Organizing Listed Building Blocks

Building blocks are organized within default folders or 
within new folders. You can move individual building 
blocks or a folder with all of its contents to a new 
location.

To create a new folder in the Organize Building Blocks 
dialog box:

Click the New Folder icon (see figure at right, 1) in the 
upper right corner. The folder opens within the currently 
selected group in the organizational tree. 

To move a building block or a folder, click and drag the 
desired item to the new location.

Click beside the folder name to expand the view of the 
associated building blocks. 

11
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Delete a Building Block

Delete a building block to remove it from the list. If you delete a default building block, you 
can restore it if needed (see Restore Default Building Blocks below).

To delete a building block:

1.	 From the main menu, select Tools > Organize 
Building Blocks.  
The Organize Building Blocks dialog box 
opens.

2.	 To delete a folder and the associated building 
blocks, select the folder from the list and click the 
icon as shown on the right. 

3.	 To delete an individual building block, select the 
building block and click the icon or right-click the 
listed building block and select Delete from the 
drop-down menu.

Restore Default Building Blocks

If one of the default preconfigured building blocks 
has been deleted, it can be restored. The default 
building blocks are those blocks installed with 
DSP Configurator. User-defined building blocks are 
not affected.

To restore default building blocks:

1.	 From the menu, select Tools > Organize 
Building Blocks. The Organize Building 
Blocks dialog opens.

2.	 Click the Restore Default Building Blocks 
icon. The default building blocks and original 
folders are restored to the list.

Importing or Exporting Building Blocks

Building blocks can be imported from another computer running DSP Configurator or 
exported from the current computer for use elsewhere. Building blocks files are saved with 
an XML file extension.

To export a building blocks file:

1.	 From the menu, select Tools > Organize 
Building Blocks. The Organize Building 
Blocks dialog opens.

2.	 Click the Export Building Blocks File icon. 
The “Export to...” dialog opens.

3.	 Browse to the location where the file is to be 
saved.

4.	 In the File name field, leave the current file name 
or enter a new file name.

5.	 Click Save. 
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To import a building blocks file:

1.	 From the menu, select Tools > Organize 
Building Blocks. The Organize Building 
Blocks dialog opens.

2.	 Click the Import Building Blocks File icon. The 
“Import from...” dialog box opens.

3.	 Browse to and select the desired building blocks 
file.

4.	 Click Open. The selected building blocks file is 
imported into the Organize Building Blocks 
dialog.
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Dante Installation 
and Operation  
(AT Models)

DMP 128 AT Bus
DMP 128 devices equipped with an AT bus use Dante technology to provide high 
performance digital audio networking over standard TCP/IP networks. Dante allows audio 
channels to be transported across a switched Ethernet data network while meeting the 
quality requirements of professional audio. 

Audio signals are converted by the DMP 128 AT models, processed and routed to the AT 
bus for availablity over the network. The audio network can be shared with control traffic or 
unrelated data traffic. Audio channels can be unicast or multicast to make the best use of 
available bandwidth.

The DMP 128 AT models are both a transmitter (source), and receiver (destination) for 
signals on a Dante network. Transmitters and receivers can be located anywhere on the 
Ethernet network and can be relocated without reconfiguring the DMP 128 AT or the 
network.

This section describes the DMP 128 AT network installation, configuration, and control using 
Dante Controller for Windows and includes:

•	 DMP 128 AT Bus

•	 Dante Controller Software Installation

•	 Creating a Physical Dante Network

•	 Dante Controller Configuration

•	 Selecting Inputs and Outputs for Dante

•	 Signal Routing with Dante

•	 Using the Extron Expansion Bus with DMP 128 AT Devices

•	 Viewing AT Channels with AT Meters
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Dante Controller Software Installation
The DMP 128 AT uses Dante Controller for Windows from Audinate to select and route 
inputs and outputs for all connected DMP 128 ATs and other Dante-compatible audio 
devices.  

Download and install the latest version of Dante Controller for Windows from the included 
software DVD or from the Dante Controller product page at www.extron.com .

Dante Network Audio Setup
The following procedure is recommended for configuring DMP 128 AT devices on a Dante 
network. When configuring multiple DMP 128 AT models, follow this procedure for each 
device, connecting them to the host computer one at a time.
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Figure 82.	 Rear Panel, AT Switch (K)

NOTE:	 A connection to both the Dante (AT) Ethernet switch and the DMP 128 LAN 
port is required for this setup. 

•	 If the control computer has only one Ethernet port, connect it to a rear panel AT 
port (see figure 82, K). Then connect a short Ethernet cable from the LAN port 
(I) to an unused AT port (K). 

•	 Alternately use an Ethernet switch to connect the control computer to both the 
LAN and AT ports.

1.	 Connect the control computer to an AT (Dante) port 
on the DMP 128. Also connect the control computer 
to the DMP 128 LAN port. 

2.	 Start DSP Configurator in Live mode (see 
Selecting Live Mode and Pushing or Pulling 
Data on page 91). 

3.	 From the DSP Configurator menu bar, select 
Tools > Device Settings (see figure 83, right).

Figure 83.	 Tools, Device Settings
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4.	 In the Unit Name: field, enter a descriptive name for the DMP 128 (typically the device 
name and location) to enable easy identification on the network (see figure 84, 1).

DMP128-ConfRoom1

Unit name can be up to 24 characters drawn from the
alphabet (A-Z), digits (0-9), and minus sign/hyphen (-).
No spaces are permitted and it is not case sensitive.
The �rst character must be an alpha character. The last
character must not be a minus sign/hyphen.

11

2233

Figure 84.	 Device Settings - Unit Name

5.	 Click Apply (2). 

6.	 Click OK to close the dialog box (3).

7.	 Open the Dante Controller (see Start Dante Controller on page 119).

8.	 From the Dante Controller menu bar, select Device > Device View (see Rename a 
Dante Device on page 121).

9.	 Choose the device. The DMP 128 appears as DMP128, plus the last six digits of the 
Dante MAC address.

NOTE:	 Connect DMP 128 units to the Dante network one at a time to easily 
identify which one is being named. To confirm the proper device, compare the 
Dante MAC address printed on the rear panel of the unit with the MAC address 
shown in figure 85.

10.	Select the Device Config tab in Dante Controller.

11.	Rename the device to match the DSP 128 name given in DSP Configurator (see step 4 
above) and press <Enter>. 

12.	Select Yes to confirm the new name.

13.	To connect additional DMP 128s, repeat this procedure with the next device.
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Dante Device Discovery
The Tools menu also provides a way to locate other Dante devices on your network. Once 
the device is named (see Dante Network Audio Setup on page 114), it can easily be 
identified as a Dante host from any other Dante device.

Once the device is located, select the device. The input expansion channel names from the 
device are imported from Dante Controller into DSP Configurator.

To locate Dante devices on an audio network:

1.	 Select Tools > Device Settings. The Device 
Settings dialog opens.

2.	 Select the Dante Device tab.

3.	 Dante devices are found by either:

a.	 Entering the name in the AT name: field,

-or-

b.	 Click Search for Dante components to 
start a search.  
The search may take a few minutes.

As new devices are discovered, they are listed in 
the window.

4.	 If you are using the EXP port to connect to 
a non AT DMP 128, check the Use Extron 
Expansion Bus for channels 41-56 box 
(see Using the Extron Expansion Bus with 
DMP 128 AT Devices on page 126).

5.	 Click Apply or OK. 

DMP128MASTER

Dante Device

Search for Dante Components

To identify your AT component, enter the
name below or click the button below to
search your local network.

AT name:
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Creating a Physical Dante Network

Basic Configuration
A physical network is required to share Dante audio channels between DMP 128 AT 
devices. Each DMP 128 AT contains a 4-port Gigabit switch with four RJ‑45 connectors 
located on the back panel to accept standard network cables. The 4-port switch can 
operate as a standard switch described in this section or in redundant mode (see 
Redundant Configuration on page 118) that switches between duplicate audio streams 
during a single network failure, preventing audio stream interruption.

NOTE:	 The Dante Controller network configuration defaults to switched mode (basic) 
making star and daisy‑chain configurations possible. When configured for redundant 
operation, different connection rules apply (see Redundant Configuration on 
page 118).

A DMP 128‑based Dante network can be configured in a daisy‑chain or Star network 
topology using the four port switch and the Dante Controller in Switched mode.

Star network topology has one DMP 128 AT as the central unit, which is then directly 
connected to up to three other units. Alternatively, a larger network switch can be used in 
place of the central DMP 128 AT, allowing more than three units to be connected in the star 
configuration (see figure 85).
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Star Network TopologyFigure 85.	 Star Network Topology

A daisy chain configuration can also be used. Each unit is connected to both the previous 
unit and the next unit in the chain (see figure 86). 
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Daisy Chain Network TopologyFigure 86.	 Daisy Chain Topology

Hybrid versions combining the star and daisy chain topologies can also be built, but a ring 
topology, or any topology that creates a duplicate connection causes a connection failure in 
the Dante Controller software. Redundant connections are possible using the primary and 
secondary port interface structure (see Redundant Configuration on page 118).

NOTE:	 Connections between DMP 128 AT ports in either a star or daisy chain network 
do not need to be sequential, (port 1 to port 2, port 2 to port 3, port 3 to port 4...), nor 
do they need to be made between the same port numbers (port 1 to port 1, port 2 to 
port 2, port 3 to port 3...).

 

DMP 128 • Software Control 117



Redundant Configuration
Redundant network configurations can be employed, however, you must observe the 
proper order of rear panel AT port connections. In redundant mode the 4‑port switch acts 
as two separate 2-port switches that duplicate audio traffic (see figure 87). The two sets of 
switches (primary and secondary) cannot be connected together anywhere in the system.

100-240V ~ 0.6A MAX

50/60 Hz LANEXP

RS-232

Tx Rx G

RESET

MIC +48V

5 6 7 8

1 2 3 4 8

4 1

1 2 3 4 5 G 6
1 2 3 4

7 8 9 10 G

11 12 13 14 15 G 16 17 18 19 20 G

2 3 4

5 6 7 8

9 10

11 127

3

6

2

5

1

M
IC

/L
IN

E
 IN

P
U

T
S

O
U

T
P

U
T

S

D
IG

IT
A

L 
I/

O

R
E

M
O

T
E

A
T

DMP 128 C AT 

Secondary
Ports

Primary
Ports

Figure 87.	 AT Ports—Primary and Secondary Ports Configuration

At least two separate network systems are required for redundancy. The primary ports 
(3 and 4) are connected to one network and the secondary (1 and 2) to another.  

The redundant mode must be selected with Dante Controller (see Start Dante Controller 
on page 119). 

1.	 Launch Dante Controller

2.	 Access the Device View. 

3.	 Double-click the device name from the 
Routing View (see right, 1).

4.	 Select the Network Config tab (2).

5.	 In the Dante Redundancy panel, select 
Redundant (3) from the drop-down list. 

The Dante Controller PC must always be 
connected to one of the two primary ports on 
the DMP 128 AT switch (see figure 87).

NOTES:	

•	 In redundant mode, control information is carried only by primary ports 3 and 4. If a 
control PC is connected running Dante Controller, it must use port 3 or port 4.

•	 AT connections follow the same distance limitations as standard Ethernet 
connections. 

•	 Potential issues of network flooding can occur. Check the Audinate Website  
(www.audinate.com) for FAQs regarding managing network traffic.

Managing Network Traffic
Because Dante devices prefer to use multi-cast to distribute audio channels, it is 
recommended that, if possible, the audio network be kept separate from the local business 
network. For more information on strategies to manage audio network traffic in an integrated 
system, refer to the Dante Controller manual (Multicast Transmit Flow Configuration).

Switched
Redundant

Dante Redundancy

Current: Switched

New:

Network Config

Switched

11

22

33
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Dante Controller Configuration
Now that the DMP 128 ATs are configured for network operation and the Dante software is 
installed, Dante Controller must be configured.

Start Dante Controller
To launch Dante Controller.

From the DSP Configurator menu bar, select Tools > Network Audio Control (see 
figure 88, 1).

11
Figure 88.	 Network Audio Control

Dante Controller opens. If the network has a DHCP server, it receives its IP configuration 
using the standard DHCP protocol. On a network without a DHCP server, a Dante-enabled 
device automatically assigns itself an address using link local protocols. 

Once connected, Dante Controller begins to auto-discover other Dante devices. While 
scanning the network, it also advertises itself to allow other Dante‑enabled devices to see 
and communicate with it. 
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When the network scan is compete, Dante Controller opens in Network View.

Dante 
Transmitters

Dante 
Receivers

Connection
Points

Figure 89.	 Dante Network View

Receivers, representing Dante device inputs, are on the left side running vertically. 
Transmitters, representing Dante device outputs, are along the top running horizontally. The 
connection points form a large matrix in the center of the screen.
The name initially shown in the first column is extracted from the Dante interface of the 
connected device. The DMP 128 AT expansion inputs are Dante receivers and labelled 
EXP_In-01 to EXP_In-56 (or the maximum available from each connected device). 
The output names are labelled from Output-01 to Output-08 to mirror the DMP 128 
line outputs, and from EXP_Out-01 to EXP_Out-08 that correspond to the DMP 128 
expansion outputs and EXP_Out‑09 to EXP_Out-16 that correspond to the DMP 128 virtual 
returns 9 to 16.
Dante provides a way to rename the connected device and to re-label each input and 
output (Dante Controller does not automatically use the DMP 128 AT device name). Follow 
the setup procedure (see Dante Network Audio Setup on page 114) keeping both 
names identical or at least as similar as possible to avoid confusing device names during 
operation. Inputs and outputs can also be renamed as necessary before proceeding.

Dante Controller Naming Conventions:	
•	 Device labels follow Domain Name System (DNS) hostname rules. Legal characters 

are A-Z, a-z, 0-9, and dash or hyphen (-). Device labels must begin with a letter.
•	 Dante Tx and Rx labels can be up to 30 characters in length. Label comparisons 

are not case-sensitive; “OUTPUT01” and “output01” are treated the same. Unicode 
and non-roman characters are not supported.

•	 Tx channel labels can use any character except equals (=), period (.), or ‘@’. Tx 
channel labels must be unique on a device but do not need to be unique on the 
network. On the network, channel IDs are prefaced with the device (“channel01_
DMP128-01”, or “channel01_DMP128-07”).

•	 Rx channel labels follow the same rules as Tx channel labels.
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Rename a Dante Device

22
33

44

Figure 90.	 Dante Controller - Rename Device

To rename a connected device:

1.	 From the toolbar, select Device > Device View or use <Ctrl+D>.

2.	 From the Device View dialog box, select Device Config.

3.	 From the pulldown list, select the device to rename.

4.	 In the Rename Device field, type the new name for the device following the naming 
conventions note on the previous page.

5.	 Repeat steps 2 to 5 for each connected device.

6.	 When all devices have been renamed, from the toolbar, select Device > Device View 
to return to the network view screen.

AT Expansion Bus Organization
With 56 inputs and 24 outputs for each DMP 128 AT device, the Dante connection points 
can quickly become unmanageable in large systems. To better organize the various 
inputs and outputs, it is highly recommended to name each input and each output using 
descriptions of the device they belong to, the location of the device, and even the purpose 
of the input or output. 

•	 Receiver channels (Inputs) 1-56 (from Dante)

•	 Transmitters (Output) 1-8 are the DMP 128 line outputs one to eight.

•	 Transmitters EXP-Out-01 to EXP-Out-08 are the DMP 128 AT expansion outputs.

•	 Transmitters EXP-Out-09 to EXP-Out-16 are the DMP 128 Virtual Sends, 
post processing.

•	 Names from the Dante Controller are read by the DMP 128 AT and assigned to the 
proper input or output.

 

DMP 128 • Software Control 121



Rename an Input or Output
To simplify setup and operation of large matrix systems, rename the input (receiver) and 
output (transmitter) lines to a label indicating the input a source device is connected to or 
the output a receiver is connected to.

33
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44

 

Figure 91.	 Dante Controller - Rename Inputs and Outputs

To rename an input:

1.	 From the menu, select Device > Device View or use <Ctrl+D>.

2.	 From the drop-down list in the upper center of the screen, select the device.

3.	 From the Device View screen, select the Receive tab.

4.	 Click inside the input text box to rename. A cursor appears.

5.	 Type the new name (up to 30 characters) using any combination of letters, numbers, 
and special characters. 

6.	 Press <Enter>, or click in another input text box.

7.	 Repeat steps 4 to 6 for each input line.

8.	 When all Inputs have been renamed, close the dialog box.

To rename an output:

1.	 Follow steps 1 and 2 above.

2.	 From Device View, select the Transmit tab.

3.	 The transmit tab has an extra column for naming the outputs. Click inside the Channel 
Label text box to rename an output. A cursor appears.

4.	 Type a new name (up to 30 characters) using any combination of letters, numbers, and 
special characters. 

5.	 Press <Enter> or click in another output Channel Label field.

6.	 Repeat steps 3 to 5 for each input to be renamed.

7.	 When all outputs have been renamed, close the dialog box.
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Selecting Inputs and Outputs for Dante
Dante Controller is used for all network level signal routing, however DSP Configurator 
assigns the input and output channels to the AT bus. The line outputs, expansion outputs, 
and virtual returns are available on the AT bus outputs.

DMP 128 AT Bus Outputs

Virtual Send Bus Expansion Outputs1     2     3     4      5     6     7      8  
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Figure 92.	 DSP Configurator AT Outputs (Dante Transmitter Channels)

In figure 93, the three areas that provide signal on the AT bus for the Dante transmitter 
channels (see figure 93, next page) are outlined. All DMP 128 AT EXP outputs (see figure 93, 
1, 2, and 3) appear to Dante Controller as transmitters. The audio from these outputs 
is always available to Dante compatible devices on the same network, and appear as 
transmitters (see figure 93, 4 on the next page) in Dante Controller.
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The DMP 128 output lines are always the first eight transmitter lines (Outputs 01 through 08 
in figure 93, 4). The eight expansion outputs (see figure 92, 2 on the previous page) 
appear in the Dante transmitter list (see figure 93, 4), as EXP_Out-01 to EXP_Out-08). The 
eight virtual sends of the DMP 128 (3) appear as EXP_Out-09 through EXP_Out-16.

Dante 
Transmitters

Dante 
Receivers

Connection
Points5 6

44

Figure 93.	 Dante Transmitters

DMP 128 AT Expansion Bus (AT Inputs)
There are a total of 56 DMP 128 EXP inputs that can be routed.

DMP Outputs 1-8
to Dante Transmit (Tx)
Outputs 1-8

DMP EXP Outputs 1-8
to Dante Transmit (Tx)
EXP Outputs 1-8

AT Inputs 17 to 
AT Inputs 56 

Dante Receivers (Rx) DMP Expansion Bus AT Inputs

Figure 94.	 DSP Configurator Expansion Inputs (Dante Receiver EXP_In)

In figure 94, expansion inputs that accept signals on the AT bus from the Dante receiver 
channels are outlined. 

NOTE:	 Figure 94 shows only the first 16 of 56 total expansion inputs. Routing of inputs 
not shown is the same.
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Signal Routing with Dante
Channels either transmitted to the network, or received from the network are routed using 
the main Dante network view (see figure 95).

Figure 95.	 Dante Routing View

There are several icons used to communicate the status of both the transmitter and receiver 
channels and the connections made. 

Icon Description

Indicates an active connection

Indicates waiting for a connection to be made

Indicates a broken connection

The transmitters along the top, and receivers down the side form a matrix on the screen 
whose intersection is the connection between the two. Click once at this intersection to 
make the connection. Click again to break the connection.

See the Dante Controller Manual at www.audinate.com for additional information.
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Using the Extron Expansion Bus with DMP 128 AT Devices
A DMP 128 AT model can be connected to a non-AT model by the Expansion (EXP) ports 
with the following exceptions:

•	 Two AT models cannot be connected together using their EXP ports.

•	 AT models are always the primary unit. The non-AT model must be set as the secondary 
unit.

•	 The sixteen EXP outputs from the non-AT secondary unit connect to the AT primary unit 
at inputs 41 through 56.

•	 The secondary DMP 128 or DMP 128 C EXP inputs are routed as they normally would 
be. 

DMP 128 AT devices are set as the Primary unit by default. This setting cannot be changed 
because the expansion bus primary and secondary selections in Device Settings are not 
available on AT models (see Dante Network Audio Setup on page 114). When an AT 
device is connected to a non-AT device by the Expansion port, the non-AT device must be 
set as the secondary unit.

To configure Expansion port connectivity using a DMP 128 AT:

1.	 Power on both units. Open DSP Configurator and connect Live to the non-AT model 
DMP 128.

2.	 From the menu, select Tools > Expansion Bus > Secondary Unit.

3.	 Connect the DMP 128 AT EXP port to the non-AT model DMP 128 
EXP port using the included shielded one foot CAT 6 or similar CAT 6 
cable. When connectivity is established, the front panel EXP LED on 
the primary unit (AT) lights solid and the EXP LED on the secondary 
unit blinks.

In DSP Configurator, EXP bus channels appear as EXP Inputs 
41 through 56 on AT models, and 1 through 16 on non-AT models. 

NOTE:	 When two non-AT models are connected, channels received on the 
Expansion bus appear as Expansion Inputs 1 through 16. 

Configuration of the EXP channels can be done at this time. You can also add additional AT 
models to the digital audio network. Always make the Expansion port connection between 
the two units before adding AT units to the digital audio network (see Dante Network 
Audio Setup on page 114). 

NOTE:  The Dante Controller software is required for configuration of the AT expansion 
bus (see Dante Controller Software Installation on page 114).

When connected to a non-AT device, all 56 receive channels of the DMP 128 AT still 
appear on the Dante digital audio network. However, Expansion inputs 41 through 56 are 
connected to the secondary (non-AT) device by the EXP bus, and are not operational on the 
Dante audio network.

Viewing AT Channels with AT Meters
The AT meters allow the user to see the signal levels of any attached Dante device. See 
View menu on page 24 for information on accessing the meters.

A connected Dante device is selected and all active transmit and receive channel real‑time 
signal levels for that device are monitored.
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Telephone Interface

This section describes the telephone interface and control, including:

•	 Telephone Configuration

•	 Telephone Dialer

The DMP 128 provides a telephone interface with separate input and output signal 
processing paths. The telephone input (Rx) is identical to the other input processing 
paths except the AEC block is not available (see Telephone Rx (DMP 128 C P and 
DMP 128 C P AT only) on page 59). The telephone output (Tx) is tied to Output 8 and 
has separate but identical processing. This allows the same signal on the telephone output 
to be monitored by output 8.

NOTES:	

•	 Change the mode to Live to access the phone dialer application.

•	 Enter the country code before connecting the DMP 128 to a phone system.

Telephone Configuration
The phone settings dialog provides selection of the country code, updating and importing 
new country codes, and setting the dialer to generate a ring tone on the telephone Rx 
channel.

NOTE:	 Extron recommends the included building blocks for the phone Tx and Rx 
channels be inserted as the starting point for phone input and output processing (see 
Signal Path Building Blocks on page 106).

To generate a ring tone:

Select the Allow device to generate ring tone. 
checkbox to enable (checked) the ringtone. Select 
again to disable (unchecked) the ring tone.

To set or change the country code:

1.	 From the DSP Configurator menu bar, select 
Tools > Device Settings. 

2.	 Select the Phone Settings tab.

3.	 If the correct country code is not listed after 
Selected Country:, click Change Phone’s 
Country Code and select the correct country code 
for your region from the dropdown list.

4.	 Click Apply and close the dialog box.
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To dial a number:

Perform one of the following:

•	 Enter a phone number using the keyboard or the 
number keypad and click the off/on hook button 
to place the phone off hook.

•	 Click the off/on hook button to place the phone 
off hook and enter the phone number using the 
number keypad.

The dialer dialog has the following features:

•	 Caller ID readout field — Displays the caller ID of 
an incoming call.

•	 Phone Number readout field — Displays the last 
outgoing number dialed.

•	 Off/On Hook button — Toggles the phone 
between “Off” hook (green-connected) or “On” 
hook (shown at right, red-disconnected or hang 
up).

•	 Number keypad — A number can be dialed 
before or after engaging “Hook Off”.

•	 Flash button — A single press enables call waiting 
or conference dialing.

•	 Clear — Clears current phone number.

•	 Line Status readouts

•	 Line Voltage — Measures the line voltage of a 
connected phone line.

•	 Loop Current — Measures the closed loop 
current of a connected phone line.

•	 Pulse Dialing check box — Select to switch from 
tone to pulse dialing.

•	 Auto-hangup check box — Select to 
automatically hang up after the far end has 
terminated the call.

Figure 97.	 Phone Dialer

Telephone Dialer
A telephone dialer is provided to aid setup and troubleshooting.

To use the telephone dialer:
From the main DSP Configurator menu bar, select Tools > 
Phone Dialer (see figure 96).

The Phone Dialer dialog box opens (see figure 98, below).

The phone dialer uses the connected telephone lines and 
provides the same features as a normal dialing interface to 
assist the installer with setup and testing.

Figure 96.	 Select Phone Dialer
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SIS Programming 
and Control

This section describes SIS programming and control of the DMP 128, including:

•	 Connection Options

•	 Host-to-Device Communications

•	 Command and Response Tables

Connection Options
The DMP 128 Digital Matrix Processor can be remotely connected via a host computer or 
other device (such as a control system) attached to the rear panel RS‑232 port or LAN port, 
or the front panel USB Config port. 

The DMP 128 can be set up and controlled using SIS commands, embedded Web 
pages, or DSP Configurator software. See Installation on page 5 for pin assignments 
and details on the configuration and control port connections. For information on 
DSP Configurator, see DMP Software on page 12 and for the embedded Web pages, 
see HTML Operation on page 156.

SIS commands can be executed using the Extron Electronics DataViewer program available 
on the Extron Website.

DMP 128 RS-232 protocol: 

•	 38400 baud •	 no parity •	 1 stop bit

•	 8 data bits •	 no flow control

NOTE:	 The rear panel configuration port requires 38400 baud communication. This is 
a higher speed than many other Extron products use. The DMP 128 control software 
automatically sets the connection for the appropriate speed. When using DataViewer 
or similar application, make sure the PC or control system connected to the port is set 
for 38400 baud.

See RS-232 Port on page 130 for additional details on connecting the RS‑232 port.

USB port details: 
The Extron USB driver must be installed before use (see Installing the USB Driver on 
page 17).

LAN port defaults: 

DMP 128 IP address: 192.168.254.254

Gateway IP address: 0.0.0.0

Subnet mask: 255.255.0.0

DHCP: off
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RS-232 Port
The DMP 128 has a serial port that can be connected to a host device such as a computer 
running the HyperTerminal utility, or the DataViewer utility. The port makes serial control of 
the switcher possible. Use the protocol information listed above to make the connection 
(see Host-to-Device Communications on page 132).

USB Port (Front Panel)
The DMP 128 has a front panel USB port that can be connected to a host device such as 
a computer running the HyperTerminal utility, or the DataViewer utility. The port makes serial 
control of the switcher possible. Once the connection is established, SIS programming can 
begin (see Host-to-Device Communications on page 132)

Ethernet (LAN) Port
The rear panel LAN connector on the device can be connected to an Ethernet LAN or WAN. 
Communication between the device and the controlling device is via Telnet (a TCP socket 
using port 23). The Telnet port can be changed, if necessary, via SIS. This connection 
makes SIS control of the device possible using a computer connected to the same LAN or 
WAN. The SIS commands and behavior of the product are identical to the commands and 
behavior the product exhibits when communicating by serial port or USB.

Ethernet connection

The Ethernet cable can be terminated as a straight-through cable or a crossover cable and 
must be properly terminated for your application (see figure 98).

•	 Crossover cable — Direct connection between the computer and the DMP 128.

•	 Patch (straight) cable — Connection of the DMP 128 to an Ethernet LAN.

12345678

RJ-45
Connector

Insert Twisted
Pair Wires

Pins:

A cable that is wired as TIA/EIA T568A at one 
end and T568B at the other (Tx and Rx pairs 
reversed) is a "crossover" cable.

A cable wired the same at both ends is called 
a "straight-through" cable because no pin/pair 
assignments are swapped.

T568A T568B T568B T568B

Straight-through Cable
(for connection to a switch, hub, or router)

 End 1 End 2
 Pin Wire Color Pin Wire Color

  1 white-orange 1 white-orange
 2 orange 2 orange
 3 white-green 3 white-green
 4 blue 4 blue
 5 white-blue 5 white-blue
 6 green 6 green
 7 white-brown 7 white-brown
 8 brown 8 brown

Crossover Cable
(for direct connection to a PC)

 End 1 End 2
 Pin Wire Color Pin Wire Color

 1 white-orange 1 white-green
 2 orange 2 green
 3 white-green 3 white-orange
 4 blue 4 blue
 5 white-blue 5 white-blue
 6 green 6 orange
 7 white-brown 7 white-brown
 8 brown 8 brown

Figure 98.	 RJ-45 Ethernet Connector Pin Assignments
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To Establish a Network Connection to the DMP 128:

1.	 Open a TCP socket to port 23 using the mixer IP address.

NOTE:	 If the local system administrators have not changed the value, the 
factory‑specified default, 192.168.254.254, is the correct value for this field.

2.	 The DMP 128 responds with a copyright message including the date, the name of the 
product, firmware version, part number, and the current date/time.

•	 If the DMP 128 is not password-protected, the device is ready to accept SIS 
commands immediately after it sends the copyright message.

•	 If the DMP 128 is password-protected, a password prompt appears below the 
copyright message. Proceed to step 3.

3.	 If the device is password protected, enter the appropriate administrator or user 
password. 

NOTES:	

•	 The factory configured passwords for all accounts on this device have been set 
to the device serial number. Passwords are case sensitive.

•	 If the device is reset, the password reverts to the original password 
configuration, which is no password.

•	 If the password is accepted, the device responds with Login User or Login 
Administrator.

•	 If the password is not accepted, the Password prompt reappears.

Connection timeouts

The Ethernet link times out after a designated period of time of no communications. By 
default, this timeout value is set to 5 minutes but the value can be changed (see Ethernet 
data port on page 137).

NOTE:	 Extron recommends leaving the default timeout at 5 minutes and periodically 
issuing the Query (Q) command to keep the connection active. If there are long idle 
periods, disconnect the socket and reopen the connection when another command 
must be sent.

Verbose Mode
Telnet connections are used to monitor for changes that occur, such as SIS commands 
from other Telnet sockets or a serial port. For a Telnet session to receive change notices, 
use verbose mode 1 or 3 (see the Verbose mode SIS command on page 136). In verbose 
mode 1 or 3, the Telnet socket reports changes in messages that resemble SIS command 
responses.
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Host-to-Device Communications
The commands listed in the following tables perform the same functions, but are encoded 
differently to accommodate the requirements of each port (Telnet or browser).

DMP 128-Initiated Messages
The DMP 128 initiates messages under specific conditions. No response is required from 
the host. The DMP 128-initiated messages are listed here (underlined).

The switcher initiates the Copyright message when it is first powered on or when a 
connection via Internet protocol (IP) is established.

© Copyright 201x, Extron Electronics, DMP 128 {string}, Vn.nn, 60-nnnn-nn] 
Day, DD MMM YYYY HH:MM:SS]

•	 Vn.nn is the firmware version number.

•	 {string} is the full model number of the DMP 128.

•	 60-nnnn-nn is the DMP 128 part number.

The DMP 128 sends the boot and copyright messages under the following circumstances:

•	 If the DMP 128 is off and an RS-232 connection is already set up (the PC is cabled to 
the DMP 128 and a serial communication program such as HyperTerminal is open), the 
connected unit sends these messages via RS-232 when first powered on.

•	 A Telnet connection to the DMP 128 is first opened. The day of the week, date, and 
time are shown when the DMP 128 is connected via Telnet, but not via RS-232. If 
using a Telnet connection, the copyright message, date, and time may be followed by a 
password prompt.

Password Information
The “]Password:" prompt requires a password (administrator level or user level) followed 
by a carriage return. The prompt is repeated if the correct password is not entered.

If the correct password is entered, the unit responds with "] Login Administrator ]" 
or "] Login User ]", depending on the password entered. If passwords are the same for 
both administrator and user, the unit will default to administrator privileges.

NOTES:	

•	 The factory configured passwords for all accounts on this device have been set to 
the device serial number. Passwords are case sensitive.

•	 If the device is reset, the password reverts to the original password configuration, 
which is no password.

Using the Command and Response Tables
SIS commands consist of a string (one or more characters per command field). No special 
characters are required to begin or end a command sequence. When the DMP 128 
determines a command is valid, it executes the command and sends a response to the host 
device. All responses end with a carriage return and a line feed (CR/LF = ]), signaling the 
end of the response character string.
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When programming, certain characters are more conveniently represented by their 
hexadecimal rather than ASCII values. The table below shows the hexadecimal equivalent of 
each ASCII character:

• 

Space

l

I

ASCII to HEX  Conversion Table

Figure 99.	 ASCII to Hex Conversion Table

The Command and Response tables list valid ASCII (for Telnet or RS-232) command codes, 
the corresponding URL (uniform resource locator) encoded (for Web browsers) command 
codes, the DMP 128 responses to the host, and a description of the command function or 
the results of executing the command.

Symbol Definitions

] = Carriage return/line feed

} = Carriage return (no line feed)

• = Space character 

E or W = Escape key  

NOTE:	 For Web encoding only: data is directed to the specified port and must be 
encoded (URL encoding) if it is non-alphanumeric. Change any non‑alphanumeric 
character (%, +, }) within the data section into the corresponding hexadecimal 
equivalent, %xx, where xx represents the two‑character hex byte. For example, 
a space (hex: 20) would be encoded as %20 and a plus sign (hex: 2B) would be 
encoded as %2B.

Error Responses
When the DMP 128 is unable to execute the command, it returns an error response to the 
host. The error response codes and their descriptions are as follows:

E11 - Invalid preset E24 - Privilege violation

E12 - Invalid port number E25 - Device is not present

E13 - Invalid parameter (number is out of 
range)

E26 - Maximum connections 
exceeded

E14 - Not valid for this configuration E27 - Invalid event number

E17 - System timed out E28 - Bad filename or file not found

E22 - Busy
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Simple Control Port Commands - Telnet and Web-Browser Accessible
Upper and lower case text can be used interchangeably except where noted. Port 23 
is default for Telnet. Port 80 is default for Web browsers. They both can be mapped to 
different ports.

There are minor differences when implementing these commands via Telnet or via URL 
encoding using a Web browser. All commands listed will work using either connection 
method but due to some limitations of Web browsers, the encapsulation characters must be 
modified to be certain the Web browser properly handles them. All examples are shown in a 
proper implementation of a Telnet or Web browser session. 

NOTE:	 When using Web browsers, some non-alphanumeric characters must be 
represented as their hex equivalent such as %xx where xx equal the two character 
representation of the hex byte that needs to be sent (a comma ‘,’ would be 
represented as %2C). Characters such as ‘%’ (percent), ’+’ (plus) and ‘ ‘ (space) should 
also be encoded in Hex. 

Telnet Web Browser

Escape (Hex 1B) W [must not be encoded]

Carriage Return (Hex 0D) Pipe Character (|) [must not be 
encoded]

When describing the use of SIS commands via a Web browser, the [URL] reference is used 
to shorten the examples. [URL] would be the full URL of the control interface and Web page 
reference including all path information  
(http://192.168.254.254/mypage.HTML).

To send commands using a Web browser, prefix them with the full URL followed by ?cmd= 
(http://192.168.254.254/mypage.html?cmd=WSF>).

Although the DMP 128 uses the same structure for SIS commands, there are two variations. 
One is the global command structure noted above and documented in the Command and 
Response Tables that immediately follows.

The second set of tables, “DSP SIS commands,” uses the command structure outline 
beginning with DSP SIS Commands on page 141.  

Generally, the basic SIS commands are for global configuration such as setting IP addresses 
or date and time, while the DSP SIS commands address audio processing functions.
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Command and Response Tables

Basic SIS Commands

Command ASCII command
(host to device)

Response
(device to host)

Additional description

Information 
requests

Firmware Version Q X(]

Firmware and 
build version

*Q X(]

Kernel firmware 
and build

**Q X(]

Verbose version 
info

0Q Sum of 2Q-3Q-4Q]

Firmware version 1Q X(]

Bootstrap Version 2Q X(]

Factory Firmware 
Version

3Q X( plus Web ver.-desc-
UL date/time]

Updated firmware 
version

4Q X( plus Web ver.-desc-
UL date/time]

NOTE:	 An asterisk (*) after the version number indicates the currently running version. Question marks (?.??) indicate that only factory 
firmware is loaded. A caret (^) indicates the firmware version that should be running, but a Mode 1 reset was executed and the 
default factory firmware is running. An exclamation point (!) indicates corrupted firmware.

Query part number N DMP 128:  60-1211-01
DMP 128 AT:  60-1211-10
DMP 128 C:  60-1178-01
DMP 128 C AT: 60-1178-10
DMP 128 C P: 60-1179-01
DMP 128 C P AT: 60-1179-10

Query model 
name

I V00x00•A12x08]

Query model 
name

1I DMP •128•] 
DMP •128•AT] 
DMP •128•C] 
DMP •128•C•AT] 
DMP •128•C•P] 
DMP •128•C•P•AT]

Query model 
description

2I Digital•Matrix•Processor]

Query system 
memory usage

3I #Bytes used out of #KBytes]

Query user-
memory usage

4I #Bytes used out of #KBytes]

KEY:	 X( = Version number	 Firmware version number to second decimal place (x.xx) 
				    Version and Build number adds four digits (x.xx.xxxx) 
				    to the Version number 

2I response changes depending on the model number queried.
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Command and Response Table for Basic SIS Commands (continued)
Command ASCII command

(host to device)
Response
(device to host)

Additional description

IP Setup Commands

Set unit name E X1@CN} Ipn•X1@ ]

View unit name ECN} X1@ ]

Set name to 
factory default

E•CN} Ipn•X4( ]

Set time and date E X1#CT} Ipt•X1# ]

View time and 
date

ECT} X1# ]

Set GMT offset E X1^CZ} IpzX1^]

View GMT offset ECZ} X1^]

Set Daylight 
Savings Time

E X3$CX} IpxX3$]

Read Daylight 
Savings Time

ECX} X3$]

Set IP address E X1$CI} IpiX1$]

Read IP address ECI} X1$]

Read hardware 
address (MAC)

ECH} X1*]

Set subnet mask E X1(CS} IpsX1(]

Read subnet mask ECS} X1(]

Set gateway IP 
address

E X1$CG} IpgX1$]

View gateway IP 
address

ECG} X1$]

Set DHCP on E1DH} Idh1]

Set DHCP off E0DH} Idh0]

NOTE:	 Changing DHCP from On to Off resets the IP address to the factory default (192.168.254.254).

View DHCP status EDH} X%]

Set verbose mode E X2@CV} VrbX2@]

View verbose 
mode

ECV} X2@]

Get number of 
connections

ECC} [number of connections]]

KEY:	 X% = On/Off status		  0=off/disable 
					     1=on/enable 
X1@ = Unit name			   Alphanumeric up to 24 characters. No special characters except hyphen (-) 
					     No upper/lower case distinction, no blanks or spaces, first character must be 
					     alpha, last character cannot be hyphen. 
X1# = Local date/time		  Set: MM/DD/YY-HH:MM:SS 
					     Read: day of week, date, month, year HH:MM:SS  
					     (for instance; Fri, 21 Jun 2002 10:54:00) 
X1$ = IP Address			  default 192.168.254.254 
X1^ = Greenwich Mean Time offset	 GMT offset value (– 12:00 to 14:00) representing hours and minutes 			 
					     (HH:MM) local time is offset from GMT time 
X1* = Hardware MAC address	 00-05-A6-xx-xx-xx 
X1( = Subnet mask		  Default 255.255.0.0 
X2@ = Verbose response mode	 0=clear (default for IP), 1=verbose (default for serial and USB),  
					     2=tagged responses, 3=verbose + tagged responses 
X3$ = Daylight Saving time		  0=off/ignore;  
					     1= USA (begins second Sunday in March/ends first Sunday in November);  
					     2= Europe (begins last Sunday in March/ends last Sunday in October); 
					     3= Brazil (begins third Sunday in October/ends third Saturday in March). 
X4( = Default unit name       	 Combination of model name and last three pairs of MAC address
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Command and Response Table for Basic SIS Commands (continued)

Command ASCII command
(host to device)

Response
(device to host)

Additional description

Password and security settings

Set administrator 
password

E X3#CA} Ipa•X4!]

View administrator 
password

ECA} X4!]

Reset (clear) 
administrator 
password

E•CA} Ipa•]

Set user password E X3#CU} Ipu•X4!]

View user password ECU} X4!]

Reset (clear) user 
password

E•CU} Ipu•]

Query session 
security level

ECK} X5@]

NOTES:	

•	 The factory configured passwords for all accounts on this device have been set to the device serial number. Passwords 
are case sensitive.

•	 If the device is reset, the password reverts to the original password configuration, which is no password.

Ethernet data port

Set current port 
timeout

E0*X1%TC} Pti0*X15]

View current port 
timeout

E0TC} X6(]

Set global IP port 
timeout

E1*X1%TC} Pti1*X1%]

View global IP port 
timeout

E1TC} X1%]

File Commands

Erase user‑supplied 
Web page file

EfilenameEF} Del•filename]

Erase current 
directory

E/EF } Ddl] Also deletes files inside directory.

Erase current 
directory and 
sub‑directories

E //EF } Ddl]

List files from 
current directory

E DF } filename x•date/time•length] 

filename x•date/time•length] 

filename x•date/time•length] 

... space_remaining•Bytes Left]]

List files from 
current directory 
and below

E LF } filename x•date/time•length] 

filename x•date/time•length] 

filename x•date/time•length] 

... space_remaining•Bytes Left]]

NOTE:	 LF has the same response from unit as the DF command, except path and directory precedes filenames for files from directories 
below current directory.

KEY:	 X1% = IP connection timeout	 1 to 65000 steps, 1 step=10 seconds, default=30 (300 seconds) 
X3# = Password	  
X4! = alphanumeric password	 If a password exists, returns four **** to mask password 
X5@ = Security level of connection	 0=anonymous, 11=user, 12=administrator
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Command and Response Table for Basic SIS Commands (continued)
Command ASCII command

(host to device)
Response
(device to host)

Additional description

Serial Port

Send data string E1*X1&*X2)*X2!RS}X@ response]

Configure 
parameters

E1*X2%,X2^,X2&,X2*CP} Cpn1•CcpX2%,X2^,X2&,X2*]

View serial port 
parameters

E1CP} X2%,X2^,X2&,X2*]

Configure receive 
timeout

E1*X1&*X2)*X2#*X2! CE} Cpn1•CceX1&,X2),X2#,X2!]

View receive 
timeout

E1CE} X1&,X2),X2#,X2!]

Digital I/O Port

View I/O mode X![ X4)]

View I/O state X!] X4#]

KEY:	 X! = Port number		  01 to 99  
X1& = Command string wait time	 0-32767 in tens of milliseconds 
X2) = Character wait time		  0-32767 in tens of milliseconds 
X2! = Length of stream or delimiter	 L=Byte count (00 –  32767), D=decimal value for ASCII character  
					     (0-00255) 
X2# = Priority status for receiving	 0=Send data string command parameters if they exist 
	        timeouts (default: 0)		  1=Configure receive timeout command parameters. 
X2% = Baud rate	 (default: 9600)	 300,600,1200,1800,2400,3600,4800,7200,9600,14400,19200 
					     38400,57600,115200 
X2^ = Parity (default: N)		  O=odd 
					     E=even 
					     N=none 
					     M=mark 
					     S=space 
X2& = Data bits 			   7, 8 (default=8) 
X2* = Stop bits 			   1, 2 (default=1) 
X2( = Command data section	 For Web encoding only: Data will be directed to specified port and must be 
					     encoded if non-alphanumeric. Since data can include either command  
					     terminator, they must be encoded as follows when used within the data section:  		
					     Space (Hex: 20) is encoded as %20 and Plus sign (Hex: 2B) is encoded as %2B. 
X4) = I/O mode 			   0=input 
					     1=output 
X4# = I/O state 			   0=off 
					     1=on
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Command ASCII command
(host to device)

Response
(device to host)

Additional description

Event Control

Read event buffer 
memory

EX3%,X3^,X3&,X3*E } X5$]

Write event buffer 
memory

EX3%,X3^,X3(,X3*E } Evt X3%,X3^,X3&,X3(]

NOTE:	 Response to the write event command is padded with leading zeros for X3% and X3&.

Read string from 
event buffer

EX3%,X3^,X3&,X4$FE} {string}]

Write string to 
event buffer

E{string}*X3%,X3^,X3&FE} Evt X3%,X3^,X3&, {string}]

NOTE:	 ‘F’ must be capitalized to read and write strings to event buffer memory. 

Response to the write event command is padded with leading zeros for X3% and X3&.

Start events E 1AE } Ego]

Stop events E 0AE } Est]

Query # of running 
events

E AE } #####] (5 digit number)

KEY:	 X3% = Event number		  00 to 99 
X3^ = Event buffer		  0=receive 	1=Unified 
					     2=data		  3=NVRAM 
X3& = Event buffer offset		  0 to max buffer size 
X3* = Event data size (case sensitive)	 b=bit, B=Byte (8-bit), S=short (16-bit), L=long (32-bit) 
X3( = Event data to write	      
X4$ = Number of Bytes to read	 1to 127 
X5$ = Data element read		  ASCII digits representing numeric value of data elements read from buffer 
					     (leading zeros suppressed)
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Command and Response Table for Basic SIS Commands (continued)

Command ASCII command
(host to device)

Response
(device to host)

Additional description

Presets, I/O Names

Write preset name EX1),X1!NG} NmgX1),X1!]

Example: E1,Security 1NG} Nmg01,Security 1] Name preset 1: Security 1.

Read preset name EX1)NG} X1!]

Example: E2NG} Security 2]

Recall a preset X1). RprX1)] Command character is a period

Example: 5. Rpr5] Recall preset 5, which becomes the 
current configuration.

Write input name EX#,X1!NI} NmiX#,X1!]

Example: E9,Podium camNI} Nmi09,Podium cam] Name input 9: Podium cam.

Read input name EX#NI} X1!]

Write output name EX@,X1!NO} NmoX@,X1!]

Example: E1,Main PJ1NO} Nmo01,Main PJ1] Name output 1: Main PJ1.

Read output name EX@NO} X1!]

Resets

Reset presets and 
names

EZG} Zpg] Clear all presets and their names.

Reset an individual 
preset

EX1)ZG} ZpgX1)] Clear preset X1).

Reset a group EZX6%GRPM} GrpmZ X6%] Delete all members from group X6%, 
reset parameters and soft limits.

NOTE:	 See Group Masters, for more information about audio group masters.

Reset flash EZFFF} Zpf] Reset flash memory 
(erase user-supplied files).

System reset 
(factory defaults)

EZXXX} Zpx] Resets all processors, level controls 
and mixers to default.

Reset all device 
settings and 
delete files

EZY} Zpy]

NOTE:	 This reset excludes IP settings such as IP address, subnet mask, gateway IP address, unit name, DHCP setting and port mapping 
(telnet/Web/direct access) in order to preserve communication with the device.  
This reset is recommended after a firmware update.

Absolute reset EZQQQ} Zpq] Similar to System Reset, plus sets 
the IP address to 192.168.254.254 
and the subnet mask to 255.255.0.0.

KEY:	 X@   = Output number		  01 to  08 (C P and C P AT models 01 to  09) 
X#   = Input number		  01 to  12 (C P and C P AT models 01 to  13) 
X1) = Preset #			   32 maximum (0 = current configuration) 
X1! = Name			   12 characters maximum 
X6% = Group master group number	 01 to  32
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DSP SIS Commands
Many digital signal processor (DSP) functions: gain, mute, group masters, and a protected 
configuration can be controlled using SIS commands. These commands follow the same 
general rules as basic SIS commands, but the variables (X/) tend to be more complex. 
Also, an understanding of the audio signal flow is helpful to understanding the commands. 
Figure 101 shows the specific DSP functions available for SIS commands. 

NOTE:	 Signal flow is described in greater detail in the section, Audio level, 
Mix‑point, Processing Blocks, and Signal Chains on page 29.

A B C D E

Figure 100.	 DSP Processors Addressable via SIS Commands

A	 Mic/line input gain controls block (including gain and mute)

B	 Input pre-mixer gains block (including gain and mute)

C	 Virtual returns pre-mixer gains

D	 Output trim control (post-mixer trim), gain only

E	 Output volume controls (including gain and mute)
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Symbol Definitions

] = Carriage return/line feed

} = Carriage return (no line feed)

• = Space character 

E or W = Escape key  

X6) = Gain and trim control See table 1 on page 148.

X6! = Level value: See table 2 beginning on page 150.

Mic/line input gain controls (A) -18.0 dB to +80 dB, (1868 to 2848 ) in 0.1 dB increments.

Input pre-mixer gains (B)  -100.0 dB to +12.0 dB, (1048 to 2168) in 0.1 dB increments.

Virtual returns, pre-mixer gains (C) -100.0 dB to +12.0 dB, (1048 to 2168) in 0.1 dB increments.

Output trim control (post-mixer trim) (D) -12.0 dB to +12.0 dB, (1928 to 2168) in 0.1 dB increments.

Output volume controls (E) -100.0 dB to +0.0 dB, (1048 to 2048 ) in 0.1 dB increments.

X6$ = Mute status 0 = unmute 
1 = mute

X6% = Group master group number 01 to  32 
X6^ = Group fader setting dB value, in 0.1 dB increments using a 10x multiplier and negative 

numbers, but not decimal places. The valid range depends on 
the type of gain block that is assigned to the group number (X6%) 
specified in the command: 
A = -180 to 800  -18.0 dB to +80.0 dB) 
B = -1000 to 120  (-100.0 dB to +12.0 dB) 
C = -1000 to 120  (-100.0 dB to + 12.0 dB) 
D = -120 to 120  (-12.0 dB to +12.0 dB) 
E = -1000 to 000  (-100.0 dB to +0.0 dB)

NOTE:	 Leading zeros are ignored.

X6& = Group fader increment dB value, in 0.1 dB increments, to raise or lower a group fader
X6* = Group fader soft limit dB value, in 0.1 dB increments. The valid range X6^ must be within 

the range for the gain block grouped in X6%.
X6( = Group type 6= gain 

12 = mute
X7) = Personal identification number (PIN) Four numeric digits, default = 0000
X7! = Protected configuration status 0 = no protected configuration saved 

1 = protected configuration saved

Special Characters
The HTML language reserves certain characters for specific functions. The device will not 
accept these characters as part of preset names, the device’s name, passwords, or locally 
created file names.

The DMP 128 rejects the following characters: 
{space (spaces are OK for names)}  + ~ , @ = ‘ [ ] { } < > ’ “ ; : > \ ?
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Command and Response Table for DSP SIS Commands

Command ASCII command
(host to device)

Response
(device to host)

Additional description

Audio level control, and mix‑point selection
NOTES:	 The command format is the same, regardless of the control to be set; the acceptable adjustment range varies depending on the 

control or mix‑point:

	 •  The mic/line input gain range is – 18 dB to +80 dB, in 0.1 dB increments. 
•  The pre-mixer gain and virtual return gain range is – 100 dB to +12 dB, in 0.1 dB increments. 
•  The post-mixer trim range is – 12 dB to +12 dB, in 0.1 dB increments. 
•  The output volume range is – 100 dB to 0 dB, in 0.1 dB increments.

	 All responses are shown with the DMP 128 in Verbose mode 2 or 3.

Set a trim or gain EGX6)*X6!AU} DsGX6)*X6!] Set trim or mix control X6) to a value 
of X6! dB.

Example 1  
(pre-mixer gain):

EG40105*2040AU} DsG40105*2040] Set the #6 pre-mixer gain to a value 
of -0.8 dB.

Example 2  
(mic/line input 2):

EG40001*2288AU} DsG40001*2288] Set the mic/line input 2 gain to a level 
of +24.0 dB.

Read a trim or gain 
(excluding mic/line 
inputs)

EGX6)AU} DsGX6)*X6!] DSP trim or mix control X6) is set to 
a value of X6! dB.

Example 1  
(post mixer gain 
control):

EG60101AU} DsG60101*2103] Output 2, post mixer trim is set to a 
value of +5.5 dB.

Example 2 
(mic/line input 1):

EG40000AU} DsG40000*2598] Mic/line input 1 gain is set to a value 
of +55.0 dB.

Audio mute
NOTES:	 •	 The post-mixer trim cannot be muted. 

•	 All responses are shown with the mixer device in Verbose mode 2 or 3.

Audio mute EMX6)*1AU} DsMX6)*1] Mute audio at X6).

Example: EM60000*1AU} DsM60000*1] Mute output 1.

Audio unmute EMX6)*0AU} DsMX6)*0] Unmute audio at X6).

Read audio mute EMX6)AU} DsMX6)*X6$] X6$: 0 = mute off,  
        1 = mute on.

KEY: X6) = Gain and trim control See table 1 on page 148

X6! = Level value: post-mixer trim, mic/line gain, 
pre‑mixer gain, virtual return gain, and output 
volume

See table 2 beginning on page 150.

X6$ = Mute status 0 = unmute 1 = mute
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Command and Response Table for DSP SIS Commands (continued)

Command ASCII command
(host to device)

Response
(device to host)

Additional description

Audio group master commands

NOTES:	 •	 See Group Masters,on page 83 for more information about audio group masters. 
•	 A group must have assigned members for these commands to have an effect. 
•	 For X6^, a positive (+) value is assumed unless a negative (-) value is specified. 
•	 If entering a X6^ value outside the valid range for the group or outside the soft limits, the DMP 128 responds with an  
    “invalid parameter” (E13) error. 
•	 X6^, X6&, and X6* values can be sent without leading zeroes; responses are always 5 digits.

Set a group fader 
control

EDX6%*X6^GRPM} GrpmDX6%*X6^] Set a group fader to a value of X6^.

Example: Ed2*-293GRPM} GrpmD02*-00293] Set the group 2 fader control to 
-29.3 dB.

Raise a group 
fader control

EDX6%*X6&+GRPM} GrpmDX6%*X6^] Increase the level of the X6% group 
fader by X6& dB.

Example: Ed2*30+GRPM} GrpmD02*-00263] Raise the group 2 fader 3 dB (from 
-29.3 dB to -26.3 dB, starting from 
the level set in the “Set a group fader 
control” example, above.

Lower a group 
fader control

EDX6%*X6&-GRPM} GrpmDX6%*X6^] Decrease the level of the X6% group 
fader by X6& dB.

View the group 
fader control level

EDX6%GRPM} GrpmDX6%*X6^] In verbose modes 1 and 2, the 
response is simplified to X6^].

Mute a group 
mute control

EDX6%*1GRPM} GrpmDX6%*+00001] Mute all blocks in group X6%.

Clear (unmute) a 
group mute control

EDX6%*0GRPM} GrpmDX6%*+00000] Umute all blocks in group X6%.

View a group mute 
control

EDX6%GRPM} GrpmDX6%*X6$] For group masters, X6$ is always 
expressed as a positive or negative 
5-digit value.

Set soft limits ELX6%*X6*upper*X6*lowerGRPM} Set the groups soft limits to X6* and 
X6*.GrpmLX6%*X6**X6*]

Example: EL2*+60*-60GRPM} GrpmL02*+00060*-00060] Set the upper soft limit for the group 
2 fader to +6.0 dB and the lower limit 
to -6.0 dB.

View soft limits ELX6%GRPM} GrpmLX6%*X6**X6*] In verbose modes 0 and 1, the 
response is simplified to X6**X6*].

View group type EPX6%GRPM} GrpmPX6%*X6(] Show the group type (X6() for group 
X6%. In verbose modes 0 and 1, the 
response is simplified to X6(].

View group 
members

EOX6%GRPM} GrpmOX6%*X6)1*X6)2* 
...*X6)16]

X6) is the control address. 
In verbose modes 0 and 1, 
the response is simplified to 
X6)1*X6)2*...*X6)16].

KEY:	 X6) = Gain and trim control			  See table 1 on page 148. 
X6% = Group master group number		  01 to 32 
X6^ = Group fader level			   dB value, in 0.1 dB increments, using negative numbers and eliminating 
						      decimal places using a 10x multiplier. -100.0 dB to +80.0 dB is  
						      represented by -1000 to 800. 
						      The valid range depends on the type of gain or trim block assigned 
						      to the group number (X6%). 
X6& = Group fader increase and decrease	 dB value, in 0.1 dB increments, to raise or lower a group fader. 
X6* = Group fader soft limit			  dB value, in 0.1 dB increments. The valid range must be within the 
						      range for the gain block grouped in X6%. 
X6( = Group type			     6 = gain 
						      12 = mute
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Command ASCII command
(host to device)

Response
(device to host)

Additional description

Protected configuration

NOTE:	 The DMP 128 can save and recall a personal identification number (PIN)-protected configuration, which includes all processing 
and levels in the current coinfiguration, with the exception of the IP address). The protected configuration is useful to establish the 
DMP 128 in a known state, either as a troubleshooting tool or as a baseline configuration.

Save the 
configuration

E S X7) PCFG} PcfgS] Save the configuration to the 
protected memory location.

Recall the 
configuration

E RPCFG} PcfgR] Recall the protected configuration

Change the PIN E P X7)old*X7)newPCFG} PcfgP X7)new] Overwrite the old PIN  
(X7)old) with the new one (X7)new).

Query configuration 
saved status

E QPCFG} X7!]

KEY:	 X7) = PIN				    Four numeric digits, default = 0000 
X7! = Protected configuration status		  0 = no protected configuration saved 
						      1 = protected configuration saved

Command and Response Table for DSP SIS Commands (continued)
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Command ASCII command
(host to device)

Response
(device to host)

Additional description

Telephone commands
NOTES:	 Prior to using the the modem, ensure the country code is set using DSP Configurator (see Telephone Configuration on 

page 127). To receive proper responses, place the DMP 128 in verbose mode 3.

	 The following commands require firmware version 1.05 or greater. Verify your firmware version before continuing (see the firmware 
query command on page 135 or see the Status Tab on page 158).

Dial number string E D X@ ,PHON} PhonOffHook] 
PhonDialing] 
PhonDialDone]

Send DTMF string X@ to modem

Off hook E OFFHOOK,PHON} PhonOffHook] Connects line

On hook E ONHOOK, PHON} PhonOnHook] Disconnects line

Flash E F,PHON} PhonFlash ] Flashes line

Phone state E O,PHON} PhonSts X! ]

Dial single digit E S X# ,PHON} PhonDialDigit ] Send single DTMF pulse X# to 
modem

Enable auto 
hang‑up

E AH X$ ,PHON} PhonAH X$ ]

Query auto 
hang‑up status

E AH ,PHON} PhonAH X$ ]

Set single digit 
gain

E DG X% ,PHON} PhonDG X% ] Set single digit gain to X% 

Query single digit 
gain

E DG ,PHON} PhonDG X% ]

Set ring gain E RG X% ,PHON} PhonRG X% ]

View ring gain E RG ,PHON} PhonRG X% ]

Set incoming ring 
tone

E RT X$ ,PHON} PhonRT X$ ]

Query incoming 
ring tone

E RT,PHON} PhonRT X$ ]

KEY:	 X! = Hook status			  On hook, Off hook 
X@ = Numeric string		  Numeric string. Valid characters are: 0 through 9,*,#, no spaces   
X# = Single character		  Valid characters are: 0 through 9,*,#, no spaces 
X$ = Enable and disable		  0 = disable 
					     1 = enable 
X% = Single digit dial gain		  0 to 1000, default: 0400 (4 digit response)
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Command ASCII command
(host to device)

Response
(device to host)

Additional description

Telephone responses (unsolicited)

NOTE:	 The following unsolicited responses alert the DMP 128 control system of an incoming call, line status changes, or an incoming Caller 
ID. To receive proper responses, place the DMP 128 in verbose mode 3.

PhonDial_Tone ] Line is off hook, dial tone 
present

PhonRinging_Tone ] Far end ringing

PhonBusy_Tone ] Far end busy

PhonLine_Intr ] Far end has terminated the call

PhonError ] Unrecognized phone command

PhonRING ] Incoming call

PhonDATE = X^ ] From Caller ID of incoming call,  
X^ = Current Date

PhonTIME = X& ] From Caller ID of incoming call,  
X& = Current time

PhonNAME = X* ] From Caller ID of incoming call,  
X* = Name

PhonNMBR = X@ ] From Caller ID of incoming call,  
X@ = Phone Number

KEY:	 X@ = Numeric string		  Numeric string. Valid characters are: 0 through 9,*,#, no spaces   
X^ = Date			   Date in mmdd format	  
X& = Current time			  Caller ID current time in hhss format 
X* = Character string		  Up to 10 characters
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Table 1:  Level Control

A Input Gain Control X6) Level B Pre-Mixer Gain X6) Level

Mic/Line Input 1 40000 X6! Mic/Line Input 1 40100 X6!

Mic/Line Input 2 40001 X6! Mic/Line Input 2 40101 X6!

Mic/Line Input 3 40002 X6! Mic/Line Input 3 40102 X6!

Mic/Line Input 4 40003 X6! Mic/Line Input 4 40103 X6!

Mic/Line Input 5 40004 X6! Mic/Line Input 5 40104 X6!

Mic/Line Input 6 40005 X6! Mic/Line Input 6 40105 X6!

Mic/Line Input 7 40006 X6! Mic/Line Input 7 40106 X6!

Mic/Line Input 8 40007 X6! Mic/Line Input 8 40107 X6!

Mic/Line Input 9 40008 X6! Mic/Line Input 9 40108 X6!

Mic/Line Input 10 40009 X6! Mic/Line Input 10 40109 X6!

Mic/Line Input 11 40010 X6! Mic/Line Input 11 40110 X6!

Mic/Line Input 12 40011 X6! Mic/Line Input 12 40111 X6!

Telephone Rx 40012 X6! Telephone Rx 40112 X6!

D Post-Mixer Trim X6)  Level E Volume Out Control X6)  Level

Output 1 60100 X6! Output 1 60000 X6!

Output 2 60101 X6! Output 2 60001 X6!

Output 3 60102 X6! Output 3 60002 X6!

Output 4 60103 X6! Output 4 60003 X6!

Output 5 60104 X6! Output 5 60004 X6!

Output 6 60105 X6! Output 6 60005 X6!

Output 7 60106 X6! Output 7 60006 X6!

Output 8/Telephone Tx 60107 X6! Output 8 60007 X6!

Telephone Tx 60008 X6!

C Virtual Return Gain X6) Level

Virtual Return A 50000 X6!

Virtual Return B 50001 X6!

Virtual Return C 50002 X6!

Virtual Return D 50003 X6!

Virtual Return E 50004 X6!

Virtual Return F 50005 X6!

Virtual Return G 50006 X6!

Virtual Return H 50007 X6!

NOTES:	

•	 For expanded coverage of setting audio levels, including comprehensive tables of 
mix‑point address, see DSP SIS Commands for Mix-Point Level and Mute Control 
on page 170.

•	 Telephone Tx and Rx commands available on DMP 128 P models only.

 

DMP 128 • SIS Programming and Control 148



Setting Audio Levels
The audio dB to SIS conversion values in table 2, beginning on the next page, are the same 
for all signal level blocks. However, the minimum and maximum levels differ depending upon 
the individual level control. The following table determines those minimum and maximum 
levels for the individual controls. Once the range and a value within that range are selected, 
use table 2 on page 150 to find the SIS value for the desired dB level.

SIS Title Function Range

X6! Mic/line gain (A) Attenuation/Gain - 18.0 to +80.0 dB

Pre-mixer gain (B) Attenuation/Gain - 100.0 to +12.0 dB

Virtual return gain (C) Attenuation/Gain - 100.0 to +12.0 dB

Post-mixer trim (D) Attenuation/Gain - 12.0 to +12.0 dB

Output volume (E) Attenuation - 100.0 to +0.0 dB

Alternately, the following formula is used to convert a desired dB value into the proper SIS 
value:

(Desired dB x 10) + 2048 equals the SIS value.

Examples:

SIS value for 0 dB:

•	 (0 x 10) + 2048 = 0 + 2048 = 2048

SIS value for +7.0 dB:

•	 (+7.0 x 10) + 2048 = 70 + 2048 = 2118

SIS value for +22.5 dB:

•	 (+22.5 x 10) + 2048 = 225 + 2048 =  2273

SIS value for -12.0 dB:

•	 (-12.0 x 10) + 2048= -120 + 2048 = 1928
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HTML Operation

This section describes HTML operation and control of the DMP 128, including:

•	 Download the Startup Page

•	 Status Tab

•	 Configuration Tab

•	 File Management Tab

•	 Special Characters

The DMP 128 can be accessed by a PC or controller from a LAN or WAN using the 
Ethernet port and a Web browser such as the Microsoft® Internet Explorer. This chapter 
describes the factory-installed HTML pages, which are always available and cannot be 
erased or overwritten.

NOTE:	 If the Ethernet connection to the device is unstable, try turning off the proxy 
server in the Web browser. In Microsoft Internet Explorer, click  
Tools > Internet Options > Connections > LAN Settings, uncheck the "Use a 
proxy server..." box, and then click OK.

Download the Startup Page
Access the device using HTML pages as follows:

1.	 Start the Web browser program.

2.	 Click in the browser Address field.

3.	 Enter the device IP address directly into the address field.

NOTE:	 If the local system administrators have not changed the value, the 
factory‑specified default IP address is 192.168.254.254.

4.	 If a custom display page is available, enter a slash (/) and the file name to open.

NOTE:	 The browser address field should display the address in the following 
format: xxx.xxx.xxx.xxx/{optional_file_name.HTML}. The following 
characters are invalid in file names: 
{space}  + ~ , @ = ‘ [ ] { } < > ’ " ; : > \ ?
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5.	 Press <Enter>. The device checks to see if it is password-protected.

•	 If the device is not password-protected, it checks and downloads the HTML pages 
(proceed to step 7).

•	 If the device is password-protected, the device opens the Connect To dialog box (see 
figure 101).

Figure 101.	 Connect To

6.	 Click in the Password field and type the appropriate administrator or user password. 
Click OK.

NOTE:	 A User Name entry is not required.

7.	 The device checks several possibilities in the following order and responds accordingly:

a.	 Does the address include a specific file name, such as 10.13.156.10/file_
name.HTML?  If true, the device downloads that HTML page.

b.	 Is there a file in the device memory named "index.HTML"? If true, the device 
downloads "index.HTML" as the default startup page.

c.	 If neither of the above conditions is true, the device downloads 
the factory‑installed default startup page, "nortxe_index.HTML" (see 
figure 103 on the next page), also known as the System Status page. 
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Status Tab
The System Status page (see figure 102) provides an overall view of the status of the 
device, including system information, power supply status, and serial port settings. The 
System Status page is the default page when a connection to the device is established. 
Click the Status tab to access the System Status page.

Figure 102.	 System Status Page

Configuration Tab

System Settings Page
Click the Configuration tab to open the System Settings page (see figure 103). The 
screen consists of fields to view and edit IP administration and system settings. Passwords 
and Firmware Upgrade pages are accessed by clicking the appropriate link on the left. 
See Ethernet (LAN) Port on page 130 for basic information about IP addresses and 
subnetting.

Figure 103.	 System Settings Page
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On password-protected connections, there are two levels of protection: administrator and 
user. Administrators have full access to the passwords and firmware upgrade pages. Users 
have view only access.

•	 Ethernet connection to the device, either entering SIS commands  
(see SIS Programming and Control on page 129) or using the Extron 
DSP Configurator Program, (see DSP Configurator Program Basics on page 18), 
is password-protected.

•	 Connection via any RS-232 port is not password-protected.

IP Settings panel

The fields in the IP Settings panel provide a location for viewing and editing settings 
unique to the Ethernet interface. After editing any of the settings on this page, click Submit 
at the bottom of the panel.

Unit Name field

The Unit Name field contains the name of the device. This field can be changed to any valid 
name, up to 24 alphanumeric characters.

NOTE:	 The following characters are invalid in the matrix name: 
+  ~  ,  @  =  ‘  [  ]  {  }  <  >  ’  "  ;  :  >  \  and ?.

DHCP radio buttons

The DHCP On button directs the device to ignore any entered IP addresses and to obtain 
its IP address from a Dynamic Host Configuration Protocol (DHCP) server (if the network 
is DHCP capable). The DHCP Off button turns DHCP off. Contact the local system 
administrator for additional information on your network.

IP address field

The IP Address field contains the IP address encoded in the flash memory of the 
connected device. 

Valid IP addresses consist of four 1-, 2-, or 3-digit numeric subfields separated by dots 
(periods). Each field can be numbered from 000 through 255. Leading zeroes, up to 3 digits 
total per field, are optional. Values of 256 and above are invalid.

The factory-installed default address is 192.168.254.254, but if this conflicts with other 
equipment at the installation site, change the IP address to any valid value.

NOTE:	 IP address changes can cause conflicts with other equipment. Only local 
system administrators should change IP addresses.

Gateway IP address field

The Gateway IP Address field identifies the address of the gateway to the mail server to be 
used if the device and the mail server are not on the same subnet.

The gateway IP address has the same validity rules as the system IP address.

Subnet mask field

The Subnet Mask field determines whether the device is on the same subnet as the mail 
server when setting up a subnet. 
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MAC Address field

The media access control (MAC) address is hardcoded in the device and cannot be 
changed.

Firmware field

The Firmware field displays the current firmware version being used by the device.

Model field

The Model field displays the Extron model number of the device.

Part Number field

The Part Number field displays the Extron Electronics part number of the device.

Date/Time Settings panel

The fields in the Date/Time Settings panel (see figure 104) provide a location for viewing 
and setting the time functions.

Figure 104.	 Date/Time Settings Panel

Change the date and time settings as follows:

1.	 Click the desired drop-down list. Adjustable settings include month, day, year, hours, 
minutes, AM/PM, and (time) zone (the year drop-down list is shown in figure 104).

2.	 If the desired value is not visible, click and drag the slider or click the scroll up  or 
scroll down  button until the desired value is visible.

3.	 Click the desired value.

NOTE:	 When setting the time, set the local time. The Zone drop-down list allows 
you to select the offset from Greenwich Mean Time (GMT). 

	 The zone identifies the standard time zone selected and displays the amount 
of time, in hours and minutes, the local time varies from GMT international time 
reference.

4.	 Repeat steps 1 through 3 for other changes.

5.	 If appropriate, click the Daylight Saving button to turn on the daylight savings time 
feature.

NOTE:	 When Daylight Saving Time is on, the device automatically updates its 
internal clock between Standard Time and Daylight Saving Time in the spring and 
fall on the date the time change occurs in the country or region selected. When 
Daylight Saving Time is turned off, the device does not adjust its time reference.

6.	 Click Submit.
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Passwords Page
Click the Passwords link to access the Passwords page (see figure 105, 1).

11

22 33

44

Figure 105.	 Passwords Page

The fields on the Passwords page enter and verify administrator and user passwords. 
Passwords are case-sensitive and limited to 12 upper case and lower case alphanumeric 
characters. Each password (administrator and user) must be entered twice: once in the 
password field (see figure 105, 2) and then again in the Re-enter Password field (3). 
Characters in these fields are masked by asterisks (*****). If password protection is not 
desired, leave the password fields and the re-enter password fields blank. After entering the 
desired password in the releated fields, click Submit (4).

NOTE:	 An administrator password must be created before a user password can be 
created.

Change or add a password

To change a password, type the new password in both the Password and Re-enter 
password fields for the desired user type and click Submit.

Clear a password

To clear an existing password so that no password is required, enter a single space in the 
password and re-enter password fields and click Submit.
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Firmware Upgrade Page

NOTE:	 The DMP 128 firmware can be updated using the HTML pages or using a 
firmware loader utility. Extron recommends using the firmware loader utility available at 
www.extron.com (see Firmware Loader on page 168).

The Firmware Upgrade page provides another way to verify the current firmware version 
and to replace the firmware. 

To update the device firmware using the HTML pages:

NOTE:	 The Firmware Upgrade page is only for replacing the firmware that controls 
device operation. To insert custom HTML pages, see File Management Tab on 
page 164.

1.	 On the Extron website, and click the Download tab (1).

11

22

33

44

55

The Downloads page opens. 11

22

33

44

55
2.	 On the left sidebar, click the Firmware link (2).

The Firmware page opens.11

22

33

44

55

3.	 Locate the appropriate firmware file. Ensure the available firmware version is a later 
version than the current one on your device.

NOTE:	 The firmware release notes provide details about the changes between 
different firmware versions. The file can be downloaded from the same page as the 
firmware.

5.	 Click the Download link to the right of your device (3). 
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6.	 Enter the requested information.

11

22

33

44

55

Figure 106.	 Download Center

7.	 Click Download to copy the firmware to your computer.  

8.	 Follow the directions. The PC downloads the firmware update and starts the installation 
program to extract the firmware file.

NOTE:	 The download folder can change depending on the operating system. 
Always note the folder where the firmware file is saved.

9.	 Accept the license agreement and click Finish to complete the download.

To update your firmware:

1.	 Connect the PC to the DMP 128 via the Ethernet port.

2.	 Access the device using the HTML pages (see Download the Startup Page on 
page 156).

3.	 Click the Configuration tab (see figure 108).

4.	 Click the Firmware Upgrade link on the Configuration page.

The current firmware version is displayed above the upload field for reference.

Firware Upgrade
Passwords

System Settings

Current Firmware Version: 1.02

33

44

55

Figure 107.	 Firmware Upgrade Page

5.	 Click Browse. An Open File dialog box opens.

6.	 Navigate to the firmware file you downloaded and select the firmware file.

NOTE:	 Valid firmware files must have the file extension .S19. Any other file 
extension is not a firmware upgrade. The original factory-installed firmware is 
permanently available on the device. If the attempted firmware upload fails for 
any reason, the device automatically reverts to the factory-installed firmware.

7.	 Click Open.

8.	 Click Upload. The firmware upload to the device can take a few minutes.
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File Management Tab
To delete files such as HTML pages from the connected device or to upload custom files to 
the device, click the File Management tab. The device downloads the File Management 
page (see figure 108).

Figure 108.	 File Management Page

NOTE:	 The files listed in figure 108 are shown for example only.

To delete a file, click Delete at the right of that file.

Upload files as follows:

1.	 Click Browse.

2.	 Browse through the system and select the desired files.

NOTE:	 If you want one of the pages that you create and upload to be the default 
startup page, name that file "index.HTML".

3.	 Click Upload File. The selected files appear in the list.

Special Characters
The HTML language reserves certain characters for specific functions. The device will not 
accept these characters as part of preset names, the name of the device, passwords, or 
locally created file names.

The device rejects the following characters: 
{space}  +  ~  ,  @  =  ‘  [  ]  {  }  <  >  ’  “  ;  :  >  \  ?
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Reference 
Information

This section contains reference information for the DMP 128, including:

•	 Mounting the DMP 128

•	 Firmware Loader

•	 DMP 128 Hardware Reset Modes

•	 DSP SIS Commands for Mix-Point Level and Mute Control

•	 SIS Command Mix-Points

Mounting the DMP 128
The 1U high, full rack width, 8.5 inch deep DMP 128 Digital Matrix Processor can be set or 
mounted in one of the following methods:

•	 Set on a table 

•	 Mounted on a rack shelf

•	 Mounted under a desk or tabletop.

Tabletop Use
Each DMP 128 is supplied with rubber feet (not installed). For tabletop use, attach a 
self‑adhesive rubber foot to each corner of the bottom of the unit.

Rack Mounting
The DMP 128 is delivered with rack mounting brackets attached. For rack mounting, do not 
install the rubber feet. Use the rack ears to mount the DMP 128 in a standard equipment 
rack. The DMP 128 can be mounted on a 19 inch Universal 1U or Basic rack shelf. 

UL Rack Mounting Guidelines
The following Underwriters Laboratories (UL) guidelines pertain to the safe installation of the 
DMP 128 in a rack.

1.	 Elevated operating ambient temperature — If installed in a closed or multi-unit rack 
assembly, the operating ambient temperature of the rack environment may be greater 
than room ambient temperature. Therefore, install the unit in an environment compatible 
with the maximum ambient temperature (Tma = +122 °F, +50 °C) specified by Extron. 

2.	 Reduced air flow — Install the equipment in a rack so that the amount of air flow 
required for safe operation of the equipment is not compromised. 

3.	 Mechanical loading — Mount the equipment in the rack so that a hazardous 
condition is not achieved due to uneven mechanical loading.
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4.	 Circuit overloading — Connect the equipment to the supply circuit and consider the 
effect that circuit overloading might have on overcurrent protection and supply wiring. 
Appropriate consideration of equipment nameplate ratings should be used when 
addressing this concern.

5.	 Reliable earthing (grounding) — Maintain reliable grounding of rack-mounted 
equipment. Pay particular attention to supply connections other than direct connections 
to the branch circuit (such as the use of power strips). 

To rack mount the DMP 128 on a rack shelf:

1.	 If rubber feet are installed on the bottom of the DMP 128, remove them.

2.	 Mount the DMP 128 on the rack shelf, using two 4-40 x 3/16 inch screws in opposite 
(diagonal) corners to secure the unit to the shelf. In a standard equipment rack, mount 
the DMP 128 using the installed rack mounting brackets.

MBU 149
Mounting Bracket

#8 Screw
(4) Places
Each Side

Supplied Rack Mounting Bracket

Mounting Screws
(2) Places
Each Side

or

Figure 109.	 Mounting the DMP 128 on a Universal Rack Shelf

3.	 Install blank panels or other units on the rack shelf.
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Table or Wall Mounting
The table or wall mounting brackets extend approximately 1/4 inch (6.4 mm) above the top 
surface of the enclosure. This design allows for an air space between the enclosure and the 
surface to which it is mounted. 

Table or wall mount the DMP 128 as follows:

1.	 Remove the rack mounting brackets and attach the MBU 149 brackets in their place.

2.	 Hold the unit with the attached brackets against the underside of the table or other 
furniture, or against the wall. Mark the location of the screw holes of the bracket on the 
mounting surface.

3.	 Drill 3/32 inch (2 mm) diameter pilot holes, 1/4 inch (6.4 mm) deep in the mounting 
surface at the marked screw locations.

4.	 Insert #8 wood screws into the four pilot holes. Tighten each screw into the mounting 
surface until just less than 1/4 inch of the screw head protrudes.

5.	 Align the mounting screws with the slots in the brackets and place the unit against the 
surface, with the screws through the bracket slots.

6.	 Slide the unit slightly forward or back and tighten all four screws to secure it in place.

MBU 149
Mounting Bracket

#8 Screw
(4) Places
Each Side

Mounting Screws
(2) Places
Each Side

Figure 110.	 Table or Wall Mounting
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The Firmware Loader dialog opens. 

Figure 111.	 Firmware Loader

5.	 From the menu bar, select File>Open.

6.	 Locate the downloaded firmware file and click it.

7.	 Click Begin on the main Firmware Loader dialog. The total progress bar tracks the 
loading progress.

8.	 When the upload is completed, select File>Exit.

The firmware upload is complete.

Firmware Loader
Extron provides a firmware loader utility that, when installed, allows the firmware of the 
DSP Configurator program to be updated or replaced. 

To upgrade the DMP 128 firmware:

•	 Download and install the Firmware Loader utility from www.extron.com.

•	 Download the desired firmware file from the Extron Website (see Firmware Upgrade 
Page on page 162).

To access Firmware Loader:

1.	 From the DSP Configurator toolbar, select Tools > Firmware Loader.

2.	 The Add Device dialog opens.  Enter the 
model number of your device.

3.	 Select the connection method.

4.	 Enter the communication settings for your device 
and click OK.

 

DMP 128 • Reference Information 168

www.extron.com


DMP 128 Hardware Reset Modes
DMP 128 Reset Mode Summary

Mode Mode Activation Result Purpose/Notes

U
se

 F
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to
ry

 F
ir

m
w
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e

1 Hold the Reset button while applying 
power.

NOTE:	 After a mode 1 reset, 
update the DMP 128 firmware 
to the latest version. DO NOT 
operate the firmware version that 
results from this reset.

The DMP 128 reverts to the factory 
default firmware.

Event scripting does not start if the 
DMP 128 is powered on in this mode. 
All user files and settings (drivers, 
IP settings, and similar items) are 
maintained.

NOTE:	 If you do not want to update 
the firmware or perform a mode 1 
reset by mistake, cycle power 
to the DMP 128 to return to the 
firmware version running prior to 
the reset.

This mode reverts to the 
factory default firmware 
version if incompatibility 
issues arise with user‑loaded 
firmware.

NOTE:	 User-defined Web 
pages may not work 
correctly if using an 
earlier firmware version.

R
un

/S
to

p
 

E
ve

nt
s

3 With power on, press and hold the 
Reset button until the Power LED 
blinks once (3 seconds) and then 
release. Within 1 second, press Reset 
momentarily (<1 second).

NOTE:	 The mode is not entered 
unless the momentary press 
occurs within 1 second.

Mode 3 toggles events on or off. Front 
panel level indicators blink twice to 
indicate events has toggled on, or three 
times to indicate event logging has 
toggled off.

Useful for troubleshooting

R
es

et
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ll 
IP

 S
et

ti
ng

s

4 Press and hold the Reset button  until 
the Power LED blinks twice (once at 3 
seconds, and again at 6 seconds) and 
then release. Within 1 second, press 
Reset momentarily (< 1 second).

NOTE:	 The mode is not entered 
unless the momentary press 
occurs within 1 second.

Mode 4:

•	 Enables ARP capability.

•	 Set the IP address to default.

•	 Sets the subnet to default.

•	 Sets the gateway address to 
default.

•	 Sets port mapping back to default.

•	 Turns DHCP off.

•	 Turns events off.

Enables resetting IP address 
information using ARP and 
MAC address.

R
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5 Press and hold the Reset button 
until the Power LED blinks three 
times (once at 3 seconds, again at 6 
seconds, again at 9 seconds) and then 
release. Within 1 second press Reset 
momentarily (< 1 second). 

NOTE:	 The mode is not entered 
unless the momentary press 
occurs within 1 second.

Mode 5 performs a complete reset 
to factory defaults, except for 
firmware:

•	 Does everything mode 4 reset 
does.

•	 All mix‑points are muted and set 
to 0 dB.

•	 All outputs are unmuted and set 
to 0 dB.

•	 DSP Processing returned to 
defaults and bypassed.

•	 All inputs are muted and set to 
0 dB.

•	 All presets and group master 
memory cleared.

Useful to start over with 
configuration or uploading, 
and to replace events.
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DSP SIS Commands for Mix-Point Level and Mute Control
Gain, mute, group masters, mix-points, and a protected configuration can be controlled 
using SIS commands. These commands follow the same general rules as basic SIS 
commands, but the variables (X/) tend to be more complex. Before attempting SIS 
control of the DSP, a comprehensive understanding of the audio signal flow is helpful to 
understanding the commands. Figure 113 shows the specific DSP functions available for 
SIS command control of the mix-points. 

NOTE:	 This supplement refers only to the mix-point and corresponding level and 
mute control commands. See DSP SIS Commands on page 141 for basic SIS 
commands and functions.

Virtual Send Bus Expansion Outputs1     2     3     4      5     6     7      8  

Expansion Outputs1     2     3     4     5     6     7     8  

1     2     3     4      5     6     7      8  

A     B     C     D     E     F     G     H  1     2     3     4     5     6     7     8  

9

10

11

12

13

14

15

16

A     B     C     D     E     F     G     H  

Inputs

Virtual Returns

Expansion Inputs

Outputs

1 - 8

9 - 16

Output 
Mix Matrix

Virtual Send
Mix Matrix

Expansion Output
Mix Matrix

Figure 112.	 DSP Processors Addressable via SIS Commands

The Mix Matrix mix-points addressed by this section are:

•	 Output Mix Matrix (including level and mute)

•	 Virtual Send Mix Matrix (including level and mute)

•	 Expansion Output Mix Matrix (including level and mute)

Setting the level of a single mix-point in the mix matrix requires an SIS command that 
contains both the mix-point location and level. Making or breaking a connection between a 
mix-point input and output requires the mix-point location be unmuted or muted.
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Selecting Mix-Points
A mix-point contains a level control and a routing control that mutes or unmutes the signal 
path from the input mix‑point to the output. Each mix-point in figure 100 on the previous 
page has an individual address to identify it for SIS commands (see table 3 on page 176, 
table 4 on page 178, and table 5 on page 179). 

For example, to view the current status of the input 1 to output 1 mix-point the SIS 
command is: EMX6)*AU} 

To view the current status of SIS address: 20000) enter: 
EM20000*AU}
The response from the DMP 128 is:

DsM20000*1AU} if the mix-point is muted, or

EM20000*0AU] if the mix-point is unmuted.

The command to view the current level setting of a mix-point is:

EGX6)AU}. 

Looking at the same input 1 to output 1 mix-point (20000), enter:

EG20000AU} or

The response is:

DsG20000*1948].

Use the table 2 cross-reference on page page 150 to determine the mix-point is set to 
-10 dB.

Signal Routing
Mix-point routing is achieved by unmuting the mix-point. To select a mix-point, use the 
tables starting on page 176 to find a specific mix-point. In the following example, input 1 is 
routed to output 1. 

Connecting a mix-point input to an output requires the mix-point be unmuted. Using the 
command from the previous examples where X6) is the mix-point, to unmute any processor 
or mix-point:

EMX6)*0AU}. 

The input 1 to output 1 mix-point address, according to table 3 on page 176, is 20000 
making the correct formula EM20000*0AU}. This routes input 1 to output 1.

To break the signal, use the mute formula:

EMX6)*1AU} or EM20000*1AU}.

In this manner any mix-point can be selected and a connection can be made or broken 
between an input and output.
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Setting Audio Levels
The mix-point level is controlled using SIS commands. The commands template follows a 
similar structure as mute and unmute commands.

The audio conversion tables are the same for all mix-points (see table 2 on page 150). 
Although a greater range is shown in the table, the minimum and maximum levels are the 
same for all mix-points (-35.0 to +25.0 dB). 

To select the mix-point, use table 3 beginning on page 176 to find the specific mix‑point. 
In the following example, the audio level of mix-point input 1 to output 1 is set to -10 dB. 

The audio level control and mix-point selection formula is:

EGX6)*X6!AU} 

where X6) is the mix-point location and X6! is the signal level. The mix-point location 
according to table 3, is 20000 and the SIS conversion for -10 dB from table 2, is 1948 
creating a SIS command EG20000*1948AU. This sets the mix-point level at input 1 to 
output 1 to -10 dB.

To return the signal level back to default, use the same formula:

EG20000*2048AU sets the level back to 0 dB.

In this manner, any mix-point can be selected and the signal level between its input and 
output changed within the range of -35 to +25 dB.
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SIS Command and Response Table for DSP Mix-Point and Level Control
Setting the level of a mix-point requires the mix-point address and level value. Making a 
connection between a mix-point input and output requires the mix-point be unmuted.

Command ASCII command
(host to device)

Response
(device to host)

Additional description

Audio level control, and mix-point selection

NOTES:	

	 The command format is the same, regardless of the control or mix-point to be set; the acceptable adjustment range of the 
main mix-points is -35 dB to +25 dB, in 0.1 dB increments.

	 All responses are shown with the DMP 128 in Verbose mode 2 or 3.

Set a mixpoint trim 
or gain

EGX6)*X6!AU} DsGX6)*X6!] Set trim or mix control X6) to a value 
of X6! dB.

Example 1 Input 1 
to Virtual Send A 
gain:

EG20009*2040AU} DsG20009*2040] Set Input 1 to Virtual Send A gain to 
a value of -0.8 dB.

Example 2 
mix‑point gain:

EG20001*2213AU} DsG20001*2213] Mix +16.5 dB of input 1 into output 2.

Read a mix-point 
level

EGX6)AU} DsGX6)*X6!] Mixpoint X6) is set to a value of 
X6! dB.

Example 1 
Input 11 to 
Output 8:

EG21007AU} DsG21007*2103] Mix-point In 11 to output 8 is set to a 
value of +5.5 dB.

Example 2  
Input 3 to 
Output 4:

EG20203AU} DsG20203*2140] +9.2 dB of In 3 is mixed to output 4.

Audio mute

NOTE:	 All responses are shown with the mixer device in Verbose mode 2 or 3.

Audio mute EMX6)*1AU} DsMX6)*1] Mute mix-point X6).

Example: 
Input 4 to 
Output 2:

EM20301*1AU} DsM20301*1] Mute mix-point input 4 to output 2.

Audio unmute EMX6)*0AU} DsMX6)*0] Unmute mix-point X6).

Read mute status EMX6)AU} DsMX6)*X6$]

NOTES:	

	 X6) = Mix-point select (see table 3 on page 176 through table 10 on page 198) 
X6! = Signal level value in dB (see table 2 on page 150) 
X6$ = Mute status, 0 = unmute    1 = mute
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Virtual Send Bus Expansion Outputs1     2     3     4      5     6     7      8  

Expansion Outputs1     2     3     4     5     6     7     8  

1     2     3     4      5     6     7      8  

A     B     C     D     E     F     G     H  1     2     3     4     5     6     7     8  

9

10

11

12

13

14

15

16

A     B     C     D     E     F     G     H  

Inputs

Virtual Returns

Expansion Inputs

Outputs

1 - 8

9 - 16

Output 
Mix Matrix

Virtual Send
Mix Matrix

Expansion Output
Mix Matrix

SIS Command Mix-Points
The mix-points are divided into three main matrix mixers: the output mix matrix, the virtual 
send bus mix matrix, and the expansion (EXP) outputs mix matrix.
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Virtual Send Bus Expansion Outputs1     2     3     4      5     6     7      8  

Expansion Outputs1     2     3     4     5     6     7     8  

1     2     3     4      5     6     7      8  

A     B     C     D     E     F     G     H  1     2     3     4     5     6     7     8  

9

10

11

12

13

14

15

16

A     B     C     D     E     F     G     H  

Inputs

Virtual Returns

Expansion Inputs

Outputs

1 - 8

9 - 16

Mic/Line Inputs to 
Output Mix-points

Virtual Returns to
Output Mix-points

EXP Inputs to 
Output Mix-points

Output Mix Matrix

A

B

C

Output Mix Matrix 
The output mix matrix routes the mic/line inputs (A), virtual returns (B), and expansion bus 
inputs (C), to the outputs.

Figure 113.	 Output Mix Matrix
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Table 3:  Mic/Line Inputs to Output Mix-points

A Mic/Line Inputs to Outputs X6) A Mic/Line Inputs to Outputs X6)

Mic/Line Input 1 to Output 1 20000 Mic/Line Input 2 to Output 1 20100
Mic/Line Input 1 to Output 2 20001 Mic/Line Input 2 to Output 2 20101
Mic/Line Input 1 to Output 3 20002 Mic/Line Input 2 to Output 3 20102
Mic/Line Input 1 to Output 4 20003 Mic/Line Input 2 to Output 4 20103
Mic/Line Input 1 to Output 5 20004 Mic/Line Input 2 to Output 5 20104
Mic/Line Input 1 to Output 6 20005 Mic/Line Input 2 to Output 6 20105
Mic/Line Input 1 to Output 7 20006 Mic/Line Input 2 to Output 7 20106
Mic/Line Input 1 to Output 8 20007 Mic/Line Input 2 to Output 8 20107

Mic/Line Input 3 to Output 1 20200 Mic/Line Input 4 to Output 1 20300
Mic/Line Input 3 to Output 2 20201 Mic/Line Input 4 to Output 2 20301
Mic/Line Input 3 to Output 3 20202 Mic/Line Input 4 to Output 3 20302
Mic/Line Input 3 to Output 4 20203 Mic/Line Input 4 to Output 4 20303
Mic/Line Input 3 to Output 5 20204 Mic/Line Input 4 to Output 5 20304
Mic/Line Input 3 to Output 6 20205 Mic/Line Input 4 to Output 6 20305
Mic/Line Input 3 to Output 7 20206 Mic/Line Input 4 to Output 7 20306
Mic/Line Input 3 to Output 8 20207 Mic/Line Input 4 to Output 8 20307

Mic/Line Input 5 to Output 1 20400 Mic/Line Input 6 to Output 1 20500
Mic/Line Input 5 to Output 2 20401 Mic/Line Input 6 to Output 2 20501
Mic/Line Input 5 to Output 3 20402 Mic/Line Input 6 to Output 3 20502
Mic/Line Input 5 to Output 4 20403 Mic/Line Input 6 to Output 4 20503
Mic/Line Input 5 to Output 5 20404 Mic/Line Input 6 to Output 5 20504
Mic/Line Input 5 to Output 6 20405 Mic/Line Input 6 to Output 6 20505
Mic/Line Input 5 to Output 7 20406 Mic/Line Input 6 to Output 7 20506
Mic/Line Input 5 to Output 8 20407 Mic/Line Input 6 to Output 8 20507

Mic/Line Input 7 to Output 1 20600 Mic/Line Input 8 to Output 1 20700
Mic/Line Input 7 to Output 2 20601 Mic/Line Input 8 to Output 2 20701
Mic/Line Input 7 to Output 3 20602 Mic/Line Input 8 to Output 3 20702
Mic/Line Input 7 to Output 4 20603 Mic/Line Input 8 to Output 4 20703
Mic/Line Input 7 to Output 5 20604 Mic/Line Input 8 to Output 5 20704
Mic/Line Input 7 to Output 6 20605 Mic/Line Input 8 to Output 6 20705
Mic/Line Input 7 to Output 7 20606 Mic/Line Input 8 to Output 7 20706
Mic/Line Input 7 to Output 8 20607 Mic/Line Input 8 to Output 8 20707

Mic/Line Input 9 to Output 1 20800 Mic/Line Input 10 to Output 1 20900
Mic/Line Input 9 to Output 2 20801 Mic/Line Input 10 to Output 2 20901
Mic/Line Input 9 to Output 3 20802 Mic/Line Input 10 to Output 3 20902
Mic/Line Input 9 to Output 4 20803 Mic/Line Input 10 to Output 4 20903
Mic/Line Input 9 to Output 5 20804 Mic/Line Input 10 to Output 5 20904
Mic/Line Input 9 to Output 6 20805 Mic/Line Input 10 to Output 6 20905
Mic/Line Input 9 to Output 7 20806 Mic/Line Input 10 to Output 7 20906
Mic/Line Input 9 to Output 8 20807 Mic/Line Input 10 to Output 8 20907
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A Mic/Line Inputs to Outputs X6) A Mic/Line Inputs to Outputs X6)

Mic/Line Input 11 to Output 1 21000 Mic/Line Input 12 to Output 1 21100
Mic/Line Input 11 to Output 2 21001 Mic/Line Input 12 to Output 2 21101
Mic/Line Input 11 to Output 3 21002 Mic/Line Input 12 to Output 3 21102
Mic/Line Input 11 to Output 4 21003 Mic/Line Input 12 to Output 4 21103
Mic/Line Input 11 to Output 5 21004 Mic/Line Input 12 to Output 5 21104
Mic/Line Input 11 to Output 6 21005 Mic/Line Input 12 to Output 6 21105
Mic/Line Input 11 to Output 7 21006 Mic/Line Input 12 to Output 7 21106
Mic/Line Input 11 to Output 8 21007 Mic/Line Input 12 to Output 8 21107

Telephone Rx to Output 1 21200
Telephone Rx to Output 2 21201
Telephone Rx to Output 3 21202
Telephone Rx to Output 4 21203
Telephone Rx to Output 5 21204
Telephone Rx to Output 6 21205
Telephone Rx to Output 7 21206
Telephone Rx to Output 8 21207
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Table 4:  Virtual Returns to Output Mix-Points

B Virtual Returns to Outputs X6) B Virtual Returns to Outputs X6)

Virtual Return A to Output 1 21300 Virtual Return B to Output 1 21400
Virtual Return A to Output 2 21301 Virtual Return B to Output 2 21401
Virtual Return A to Output 3 21302 Virtual Return B to Output 3 21402
Virtual Return A to Output 4 21303 Virtual Return B to Output 4 21403
Virtual Return A to Output 5 21304 Virtual Return B to Output 5 21404
Virtual Return A to Output 6 21305 Virtual Return B to Output 6 21405
Virtual Return A to Output 7 21306 Virtual Return B to Output 7 21406
Virtual Return A to Output 8 21307 Virtual Return B to Output 8 21407

Virtual Return C to Output 1 21500 Virtual Return D to Output 1 21600
Virtual Return C to Output 2 21501 Virtual Return D to Output 2 21601
Virtual Return C to Output 3 21502 Virtual Return D to Output 3 21602
Virtual Return C to Output 4 21503 Virtual Return D to Output 4 21603
Virtual Return C to Output 5 21504 Virtual Return D to Output 5 21604
Virtual Return C to Output 6 21505 Virtual Return D to Output 6 21605
Virtual Return C to Output 7 21506 Virtual Return D to Output 7 21606
Virtual Return C to Output 8 21507 Virtual Return D to Output 8 21607

Virtual Return E to Output 1 21700 Virtual Return F to Output 1 21800
Virtual Return E to Output 2 21701 Virtual Return F to Output 2 21801
Virtual Return E to Output 3 21702 Virtual Return F to Output 3 21802
Virtual Return E to Output 4 21703 Virtual Return F to Output 4 21803
Virtual Return E to Output 5 21704 Virtual Return F to Output 5 21804
Virtual Return E to Output 6 21705 Virtual Return F to Output 6 21805
Virtual Return E to Output 7 21706 Virtual Return F to Output 7 21806
Virtual Return E to Output 8 21707 Virtual Return F to Output 8 21807

Virtual Return G to Output 1 21900 Virtual Return H to Output 1 22000
Virtual Return G to Output 2 21901 Virtual Return H to Output 2 22001
Virtual Return G to Output 3 21902 Virtual Return H to Output 3 22002
Virtual Return G to Output 4 21903 Virtual Return H to Output 4 22003
Virtual Return G to Output 5 21904 Virtual Return H to Output 5 22004
Virtual Return G to Output 6 21905 Virtual Return H to Output 6 22005
Virtual Return G to Output 7 21906 Virtual Return H to Output 7 22006
Virtual Return G to Output 8 21907 Virtual Return H to Output 8 22007

 

DMP 128 • Reference Information 178



Table 5:  EXP and AT Inputs to Output Mix-Points

c EXP Returns to Outputs X6) c EXP Returns to Outputs X6)

EXP Input 1 to Output 1 22100 EXP Input 2 to Output 1 22200
EXP Input 1 to Output 2 22101 EXP Input 2 to Output 2 22201
EXP Input 1 to Output 3 22102 EXP Input 2 to Output 3 22202
EXP Input 1 to Output 4 22103 EXP Input 2 to Output 4 22203
EXP Input 1 to Output 5 22104 EXP Input 2 to Output 5 22204
EXP Input 1 to Output 6 22105 EXP Input 2 to Output 6 22205
EXP Input 1 to Output 7 22106 EXP Input 2 to Output 7 22206
EXP Input 1 to Output 8 22107 EXP Input 2 to Output 8 22207

EXP Input 3 to Output 1 22300 EXP Input 4 to Output 1 22400
EXP Input 3 to Output 2 22301 EXP Input 4 to Output 2 22401
EXP Input 3 to Output 3 22302 EXP Input 4 to Output 3 22402
EXP Input 3 to Output 4 22303 EXP Input 4 to Output 4 22403
EXP Input 3 to Output 5 22304 EXP Input 4 to Output 5 22404
EXP Input 3 to Output 6 22305 EXP Input 4 to Output 6 22405
EXP Input 3 to Output 7 22306 EXP Input 4 to Output 7 22406
EXP Input 3 to Output 8 22307 EXP Input 4 to Output 8 22407

EXP Input 5 to Output 1 22500 EXP Input 6 to Output 1 22600
EXP Input 5 to Output 2 22501 EXP Input 6 to Output 2 22601
EXP Input 5 to Output 3 22502 EXP Input 6 to Output 3 22602
EXP Input 5 to Output 4 22503 EXP Input 6 to Output 4 22603
EXP Input 5 to Output 5 22504 EXP Input 6 to Output 5 22604
EXP Input 5 to Output 6 22505 EXP Input 6 to Output 6 22605
EXP Input 5 to Output 7 22506 EXP Input 6 to Output 7 22606
EXP Input 5 to Output 8 22507 EXP Input 6 to Output 8 22607

EXP Input 7 to Output 1 22700 EXP Input 8 to Output 1 22800
EXP Input 7 to Output 2 22701 EXP Input 8 to Output 2 22801
EXP Input 7 to Output 3 22702 EXP Input 8 to Output 3 22802
EXP Input 7 to Output 4 22703 EXP Input 8 to Output 4 22803
EXP Input 7 to Output 5 22704 EXP Input 8 to Output 5 22804
EXP Input 7 to Output 6 22705 EXP Input 8 to Output 6 22805
EXP Input 7 to Output 7 22706 EXP Input 8 to Output 7 22806
EXP Input 7 to Output 8 22707 EXP Input 8 to Output 8 22807

EXP Input 9 to Output 1 22900 EXP Input 10 to Output 1 23000
EXP Input 9 to Output 2 22901 EXP Input 10 to Output 2 23001
EXP Input 9 to Output 3 22902 EXP Input 10 to Output 3 23002
EXP Input 9 to Output 4 22903 EXP Input 10 to Output 4 23003
EXP Input 9 to Output 5 22904 EXP Input 10 to Output 5 23004
EXP Input 9 to Output 6 22905 EXP Input 10 to Output 6 23005
EXP Input 9 to Output 7 22906 EXP Input 10 to Output 7 23006
EXP Input 9 to Output 8 22907 EXP Input 10 to Output 8 23007
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c EXP Returns to Outputs X6) c EXP Returns to Outputs X6)

EXP Input 11 to Output 1 23100 EXP Input 12 to Output 1 23200
EXP Input 11 to Output 2 23101 EXP Input 12 to Output 2 23201
EXP Input 11 to Output 3 23102 EXP Input 12 to Output 3 23202
EXP Input 11 to Output 4 23103 EXP Input 12 to Output 4 23203
EXP Input 11 to Output 5 23104 EXP Input 12 to Output 5 23204
EXP Input 11 to Output 6 23105 EXP Input 12 to Output 6 23205
EXP Input 11 to Output 7 23106 EXP Input 12 to Output 7 23206
EXP Input 11 to Output 8 23107 EXP Input 12 to Output 8 23207

EXP Input 13 to Output 1 23300 EXP Input 14 to Output 1 23400
EXP Input 13 to Output 2 23301 EXP Input 14 to Output 2 23401
EXP Input 13 to Output 3 23302 EXP Input 14 to Output 3 23402
EXP Input 13 to Output 4 23303 EXP Input 14 to Output 4 23403
EXP Input 13 to Output 5 23304 EXP Input 14 to Output 5 23404
EXP Input 13 to Output 6 23305 EXP Input 14 to Output 6 23405
EXP Input 13 to Output 7 23306 EXP Input 14 to Output 7 23406
EXP Input 13 to Output 8 23307 EXP Input 14 to Output 8 23407

EXP Input 15 to Output 1 23500 EXP Input 16 to Output 1 23600
EXP Input 15 to Output 2 23501 EXP Input 16 to Output 2 23601
EXP Input 15 to Output 3 23502 EXP Input 16 to Output 3 23602
EXP Input 15 to Output 4 23503 EXP Input 16 to Output 4 23603
EXP Input 15 to Output 5 23504 EXP Input 16 to Output 5 23604
EXP Input 15 to Output 6 23505 EXP Input 16 to Output 6 23605
EXP Input 15 to Output 7 23506 EXP Input 16 to Output 7 23606
EXP Input 15 to Output 8 23507 EXP Input 16 to Output 8 23607

EXP Input 17 to Output 1 23700 EXP Input 18 to Output 1 23800
EXP Input 17 to Output 2 23701 EXP Input 18 to Output 2 23801
EXP Input 17 to Output 3 23702 EXP Input 18 to Output 3 23802
EXP Input 17 to Output 4 23703 EXP Input 18 to Output 4 23803
EXP Input 17 to Output 5 23704 EXP Input 18 to Output 5 23804
EXP Input 17 to Output 6 23705 EXP Input 18 to Output 6 23805
EXP Input 17 to Output 7 23706 EXP Input 18 to Output 7 23806
EXP Input 17 to Output 8 23707 EXP Input 18 to Output 8 23807

EXP Input 19 to Output 1 23900 EXP Input 20 to Output 1 24000
EXP Input 19 to Output 2 23901 EXP Input 20 to Output 2 24001
EXP Input 19 to Output 3 23902 EXP Input 20 to Output 3 24002
EXP Input 19 to Output 4 23903 EXP Input 20 to Output 4 24003
EXP Input 19 to Output 5 23904 EXP Input 20 to Output 5 24004
EXP Input 19 to Output 6 23905 EXP Input 20 to Output 6 24005
EXP Input 19 to Output 7 23906 EXP Input 20 to Output 7 24006
EXP Input 19 to Output 8 23907 EXP Input 20 to Output 8 24007

EXP Input 21 to Output 1 24100 EXP Input 22 to Output 1 24200
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c EXP Returns to Outputs X6) c EXP Returns to Outputs X6)

EXP Input 21 to Output 2 24101 EXP Input 22 to Output 2 24201
EXP Input 21 to Output 3 24102 EXP Input 22 to Output 3 24202
EXP Input 21 to Output 4 24103 EXP Input 22 to Output 4 24203
EXP Input 21 to Output 5 24104 EXP Input 22 to Output 5 24204
EXP Input 21 to Output 6 24105 EXP Input 22 to Output 6 24205
EXP Input 21 to Output 7 24106 EXP Input 22 to Output 7 24206
EXP Input 21 to Output 8 24107 EXP Input 22 to Output 8 24207

EXP Input 23 to Output 1 24300 EXP Input 24 to Output 1 24400
EXP Input 23 to Output 2 24301 EXP Input 24 to Output 2 24401
EXP Input 23 to Output 3 24302 EXP Input 24 to Output 3 24402
EXP Input 23 to Output 4 24303 EXP Input 24 to Output 4 24403
EXP Input 23 to Output 5 24304 EXP Input 24 to Output 5 24404
EXP Input 23 to Output 6 24305 EXP Input 24 to Output 6 24405
EXP Input 23 to Output 7 24306 EXP Input 24 to Output 7 24406
EXP Input 23 to Output 8 24307 EXP Input 24 to Output 8 24407

EXP Input 25 to Output 1 24500 EXP Input 26 to Output 1 24600
EXP Input 25 to Output 2 24501 EXP Input 26 to Output 2 24601
EXP Input 25 to Output 3 24502 EXP Input 26 to Output 3 24602
EXP Input 25 to Output 4 24503 EXP Input 26 to Output 4 24603
EXP Input 25 to Output 5 24504 EXP Input 26 to Output 5 24604
EXP Input 25 to Output 6 24505 EXP Input 26 to Output 6 24605
EXP Input 25 to Output 7 24506 EXP Input 26 to Output 7 24606
EXP Input 25 to Output 8 24507 EXP Input 26 to Output 8 24607

EXP Input 27 to Output 1 24700 EXP Input 28 to Output 1 24800
EXP Input 27 to Output 2 24701 EXP Input 28 to Output 2 24801
EXP Input 27 to Output 3 24702 EXP Input 28 to Output 3 24802
EXP Input 27 to Output 4 24703 EXP Input 28 to Output 4 24803
EXP Input 27 to Output 5 24704 EXP Input 28 to Output 5 24804
EXP Input 27 to Output 6 24705 EXP Input 28 to Output 6 24805
EXP Input 27 to Output 7 24706 EXP Input 28 to Output 7 24806
EXP Input 27 to Output 8 24707 EXP Input 28 to Output 8 24807

EXP Input 29 to Output 1 24900 EXP Input 30 to Output 1 25000
EXP Input 29 to Output 2 24901 EXP Input 30 to Output 2 25001
EXP Input 29 to Output 3 24902 EXP Input 30 to Output 3 25002
EXP Input 29 to Output 4 24903 EXP Input 30 to Output 4 25003
EXP Input 29 to Output 5 24904 EXP Input 30 to Output 5 25004
EXP Input 29 to Output 6 24905 EXP Input 30 to Output 6 25005
EXP Input 29 to Output 7 24906 EXP Input 30 to Output 7 25006
EXP Input 29 to Output 8 24907 EXP Input 30 to Output 8 25007

EXP Input 31 to Output 1 25100 EXP Input 32 to Output 1 25200
EXP Input 31 to Output 2 25101 EXP Input 32 to Output 2 25201
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c EXP Returns to Outputs X6) c EXP Returns to Outputs X6)

EXP Input 31 to Output 3 25102 EXP Input 32 to Output 3 25202
EXP Input 31 to Output 4 25103 EXP Input 32 to Output 4 25203
EXP Input 31 to Output 5 25104 EXP Input 32 to Output 5 25204
EXP Input 31 to Output 6 25105 EXP Input 32 to Output 6 25205
EXP Input 31 to Output 7 25106 EXP Input 32 to Output 7 25206
EXP Input 31 to Output 8 25107 EXP Input 32 to Output 8 25207

EXP Input 33 to Output 1 25300 EXP Input 34 to Output 1 25400
EXP Input 33 to Output 2 25301 EXP Input 34 to Output 2 25401
EXP Input 33 to Output 3 25302 EXP Input 34 to Output 3 25402
EXP Input 33 to Output 4 25303 EXP Input 34 to Output 4 25403
EXP Input 33 to Output 5 25304 EXP Input 34 to Output 5 25404
EXP Input 33 to Output 6 25305 EXP Input 34 to Output 6 25405
EXP Input 33 to Output 7 25306 EXP Input 34 to Output 7 25406
EXP Input 33 to Output 8 25307 EXP Input 34 to Output 8 25407

EXP Input 35 to Output 1 25500 EXP Input 36 to Output 1 25600
EXP Input 35 to Output 2 25501 EXP Input 36 to Output 2 25601
EXP Input 35 to Output 3 25502 EXP Input 36 to Output 3 25602
EXP Input 35 to Output 4 25503 EXP Input 36 to Output 4 25603
EXP Input 35 to Output 5 25504 EXP Input 36 to Output 5 25604
EXP Input 35 to Output 6 25505 EXP Input 36 to Output 6 25605
EXP Input 35 to Output 7 25506 EXP Input 36 to Output 7 25606
EXP Input 35 to Output 8 25507 EXP Input 36 to Output 8 25607

EXP Input 37 to Output 1 25700 EXP Input 38 to Output 1 25800
EXP Input 37 to Output 2 25701 EXP Input 38 to Output 2 25801
EXP Input 37 to Output 3 25702 EXP Input 38 to Output 3 25802
EXP Input 37 to Output 4 25703 EXP Input 38 to Output 4 25803
EXP Input 37 to Output 5 25704 EXP Input 38 to Output 5 25804
EXP Input 37 to Output 6 25705 EXP Input 38 to Output 6 25805
EXP Input 37 to Output 7 25706 EXP Input 38 to Output 7 25806
EXP Input 37 to Output 8 25707 EXP Input 38 to Output 8 25807

EXP Input 39 to Output 1 25900 EXP Input 40 to Output 1 26000
EXP Input 39 to Output 2 25901 EXP Input 40 to Output 2 26001
EXP Input 39 to Output 3 25902 EXP Input 40 to Output 3 26002
EXP Input 39 to Output 4 25903 EXP Input 40 to Output 4 26003
EXP Input 39 to Output 5 25904 EXP Input 40 to Output 5 26004
EXP Input 39 to Output 6 25905 EXP Input 40 to Output 6 26005
EXP Input 39 to Output 7 25906 EXP Input 40 to Output 7 26006
EXP Input 39 to Output 8 25907 EXP Input 40 to Output 8 26007

EXP Input 41 to Output 1 26100 EXP Input 42 to Output 1 26200
EXP Input 41 to Output 2 26101 EXP Input 42 to Output 2 26201
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c EXP Returns to Outputs X6) c EXP Returns to Outputs X6)

EXP Input 41 to Output 3 26102 EXP Input 42 to Output 3 26202
EXP Input 41 to Output 4 26103 EXP Input 42 to Output 4 26203
EXP Input 41 to Output 5 26104 EXP Input 42 to Output 5 26204
EXP Input 41 to Output 6 26105 EXP Input 42 to Output 6 26205
EXP Input 41 to Output 7 26106 EXP Input 42 to Output 7 26206
EXP Input 41 to Output 8 26107 EXP Input 42 to Output 8 26207

EXP Input 43 to Output 1 26300 EXP Input 44 to Output 1 26400
EXP Input 43 to Output 2 26301 EXP Input 44 to Output 2 26401
EXP Input 43 to Output 3 26302 EXP Input 44 to Output 3 26402
EXP Input 43 to Output 4 26303 EXP Input 44 to Output 4 26403
EXP Input 43 to Output 5 26304 EXP Input 44 to Output 5 26404
EXP Input 43 to Output 6 26305 EXP Input 44 to Output 6 26405
EXP Input 43 to Output 7 26306 EXP Input 44 to Output 7 26406
EXP Input 43 to Output 8 26307 EXP Input 44 to Output 8 26407

EXP Input 45 to Output 1 26500 EXP Input 46 to Output 1 26600
EXP Input 45 to Output 2 26501 EXP Input 46 to Output 2 26601
EXP Input 45 to Output 3 26502 EXP Input 46 to Output 3 26602
EXP Input 45 to Output 4 26503 EXP Input 46 to Output 4 26603
EXP Input 45 to Output 5 26504 EXP Input 46 to Output 5 26604
EXP Input 45 to Output 6 26505 EXP Input 46 to Output 6 26605
EXP Input 45 to Output 7 26506 EXP Input 46 to Output 7 26606
EXP Input 45 to Output 8 26507 EXP Input 46 to Output 8 26607

EXP Input 47 to Output 1 26700 EXP Input 48 to Output 1 26800
EXP Input 47 to Output 2 26701 EXP Input 48 to Output 2 26801
EXP Input 47 to Output 3 26702 EXP Input 48 to Output 3 26802
EXP Input 47 to Output 4 26703 EXP Input 48 to Output 4 26803
EXP Input 47 to Output 5 26704 EXP Input 48 to Output 5 26804
EXP Input 47 to Output 6 26705 EXP Input 48 to Output 6 26805
EXP Input 47 to Output 7 26706 EXP Input 48 to Output 7 26806
EXP Input 47 to Output 8 26707 EXP Input 48 to Output 8 26807

EXP Input 49 to Output 1 26900 EXP Input 50 to Output 1 27000
EXP Input 49 to Output 2 26901 EXP Input 50 to Output 2 27001
EXP Input 49 to Output 3 26902 EXP Input 50 to Output 3 27002
EXP Input 49 to Output 4 26903 EXP Input 50 to Output 4 27003
EXP Input 49 to Output 5 26904 EXP Input 50 to Output 5 27004
EXP Input 49 to Output 6 26905 EXP Input 50 to Output 6 27005
EXP Input 49 to Output 7 26906 EXP Input 50 to Output 7 27006
EXP Input 49 to Output 8 26907 EXP Input 50 to Output 8 27007

EXP Input 51 to Output 1 27100 EXP Input 52 to Output 1 27200
EXP Input 51 to Output 2 27101 EXP Input 52 to Output 2 27201
EXP Input 51 to Output 3 27102 EXP Input 52 to Output 3 27202
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c EXP Returns to Outputs X6) c EXP Returns to Outputs X6)

EXP Input 51 to Output 4 27103 EXP Input 52 to Output 4 27203
EXP Input 51 to Output 5 27104 EXP Input 52 to Output 5 27204
EXP Input 51 to Output 6 27105 EXP Input 52 to Output 6 27205
EXP Input 51 to Output 7 27106 EXP Input 52 to Output 7 27206
EXP Input 51 to Output 8 27107 EXP Input 52 to Output 8 27207

EXP Input 53 to Output 1 27300 EXP Input 54 to Output 1 27400
EXP Input 53 to Output 2 27301 EXP Input 54 to Output 2 27401
EXP Input 53 to Output 3 27302 EXP Input 54 to Output 3 27402
EXP Input 53 to Output 4 27303 EXP Input 54 to Output 4 27403
EXP Input 53 to Output 5 27304 EXP Input 54 to Output 5 27404
EXP Input 53 to Output 6 27305 EXP Input 54 to Output 6 27405
EXP Input 53 to Output 7 27306 EXP Input 54 to Output 7 27406
EXP Input 53 to Output 8 27307 EXP Input 54 to Output 8 27407

EXP Input 55 to Output 1 27500 EXP Input 56 to Output 1 27600
EXP Input 55 to Output 2 27501 EXP Input 56 to Output 2 27601
EXP Input 55 to Output 3 27502 EXP Input 56 to Output 3 27602
EXP Input 55 to Output 4 27503 EXP Input 56 to Output 4 27603
EXP Input 55 to Output 5 27504 EXP Input 56 to Output 5 27604
EXP Input 55 to Output 6 27505 EXP Input 56 to Output 6 27605
EXP Input 55 to Output 7 27506 EXP Input 56 to Output 7 27606
EXP Input 55 to Output 8 27507 EXP Input 56 to Output 8 27607
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Virtual Send Bus Mix-Points
(from Mic/Line Inputs)

Virtual Send
Bus Mix Matrix

Virtual Send Bus Mix-Points
(from Virtual Bus Returns)

EXP Inputs to Virtual 
Bus Sends

A

B

C

Virtual Sends Bus Mix Matrix
The Virtual Send Bus Mix Matrix can be further broken down into the mix-points for the  
mic/line inputs (A), virtual bus returns (B), and EXP inputs (C).

Figure 114.	 Virtual Send Bus Mix Matrix
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Table 6: Mic/Line Inputs to Virtual Sends Mix-Points

A Inputs to Virtual Sends X6) A Inputs to Virtual Sends X6)

Input 1 to Virtual Send A 20009 Input 2 to Virtual Send A 20109
Input 1 to Virtual Send B 20010 Input 2 to Virtual Send B 20110
Input 1 to Virtual Send C 20011 Input 2 to Virtual Send C 20111
Input 1 to Virtual Send D 20012 Input 2 to Virtual Send D 20112
Input 1 to Virtual Send E 20013 Input 2 to Virtual Send E 20113
Input 1 to Virtual Send F 20014 Input 2 to Virtual Send F 20114
Input 1 to Virtual Send G 20015 Input 2 to Virtual Send G 20115
Input 1 to Virtual Send H 20016 Input 2 to Virtual Send H 20116

Input 3 to Virtual Send A 20209 Input 4 to Virtual Send A 20309
Input 3 to Virtual Send B 20210 Input 4 to Virtual Send B 20310
Input 3 to Virtual Send C 20211 Input 4 to Virtual Send C 20311
Input 3 to Virtual Send D 20212 Input 4 to Virtual Send D 20312
Input 3 to Virtual Send E 20213 Input 4 to Virtual Send E 20313
Input 3 to Virtual Send F 20214 Input 4 to Virtual Send F 20314
Input 3 to Virtual Send G 20215 Input 4 to Virtual Send G 20315
Input 3 to Virtual Send H 20216 Input 4 to Virtual Send H 20316

Input 5 to Virtual Send A 20409 Input 6 to Virtual Send A 20509
Input 5 to Virtual Send B 20410 Input 6 to Virtual Send B 20510
Input 5 to Virtual Send C 20411 Input 6 to Virtual Send C 20511
Input 5 to Virtual Send D 20412 Input 6 to Virtual Send D 20512
Input 5 to Virtual Send E 20413 Input 6 to Virtual Send E 20513
Input 5 to Virtual Send F 20414 Input 6 to Virtual Send F 20514
Input 5 to Virtual Send G 20415 Input 6 to Virtual Send G 20515
Input 5 to Virtual Send H 20416 Input 6 to Virtual Send H 20516

Input 7 to Virtual Send A 20609 Input 8 to Virtual Send A 20709
Input 7 to Virtual Send B 20610 Input 8 to Virtual Send B 20710
Input 7 to Virtual Send C 20611 Input 8 to Virtual Send C 20711
Input 7 to Virtual Send D 20612 Input 8 to Virtual Send D 20712
Input 7 to Virtual Send E 20613 Input 8 to Virtual Send E 20713
Input 7 to Virtual Send F 20614 Input 8 to Virtual Send F 20714
Input 7 to Virtual Send G 20615 Input 8 to Virtual Send G 20715
Input 7 to Virtual Send H 20616 Input 8 to Virtual Send H 20716

Input 9 to Virtual Send A 20809 Input 10 to Virtual Send A 20909
Input 9 to Virtual Send B 20810 Input 10 to Virtual Send B 20910
Input 9 to Virtual Send C 20811 Input 10 to Virtual Send C 20911
Input 9 to Virtual Send D 20812 Input 10 to Virtual Send D 20912
Input 9 to Virtual Send E 20813 Input 10 to Virtual Send E 20913
Input 9 to Virtual Send F 20814 Input 10 to Virtual Send F 20914
Input 9 to Virtual Send G 20815 Input 10 to Virtual Send G 20915
Input 9 to Virtual Send H 20816 Input 10 to Virtual Send H 20916
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A Inputs to Virtual Sends X6) A Inputs to Virtual Sends X6)

Input 11 to Virtual Send A 21009 Input 12 to Virtual Send A 21109
Input 11 to Virtual Send B 21010 Input 12 to Virtual Send B 21110
Input 11 to Virtual Send C 21011 Input 12 to Virtual Send C 21111
Input 11 to Virtual Send D 21012 Input 12 to Virtual Send D 21112
Input 11 to Virtual Send E 21013 Input 12 to Virtual Send E 21113
Input 11 to Virtual Send F 21014 Input 12 to Virtual Send F 21114
Input 11 to Virtual Send G 21015 Input 12 to Virtual Send G 21115
Input 11 to Virtual Send H 21016 Input 12 to Virtual Send H 21116

Telephone Rx to Virtual Send A 21209
Telephone Rx to Virtual Send B 21210
Telephone Rx to Virtual Send C 21211
Telephone Rx to Virtual Send D 21212
Telephone Rx to Virtual Send E 21213
Telephone Rx to Virtual Send F 21214
Telephone Rx to Virtual Send G 21215
Telephone Rx to Virtual Send H 21216
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Table 7:  Virtual Returns to Virtual Sends

B  Virtual Returns to  
       Virtual Sends X6) B  Virtual Returns to  

       Virtual Sends X6)

Virtual Return B to Virtual Send A 21409
Virtual Return A to Virtual Send B 21310
Virtual Return A to Virtual Send C 21311 Virtual Return B to Virtual Send C 21411
Virtual Return A to Virtual Send D 21312 Virtual Return B to Virtual Send D 21412
Virtual Return A to Virtual Send E 21313 Virtual Return B to Virtual Send E 21413
Virtual Return A to Virtual Send F 21314 Virtual Return B to Virtual Send F 21414
Virtual Return A to Virtual Send G 21315 Virtual Return B to Virtual Send G 21415
Virtual Return A to Virtual Send H 21316 Virtual Return B to Virtual Send H 21416

Virtual Return C to Virtual Send A 21509 Virtual Return D to Virtual Send A 21609
Virtual Return C to Virtual Send B 21510 Virtual Return D to Virtual Send B 21610

Virtual Return D to Virtual Send C 21611
Virtual Return C to Virtual Send D 21512
Virtual Return C to Virtual Send E 21513 Virtual Return D to Virtual Send E 21613
Virtual Return C to Virtual Send F 21514 Virtual Return D to Virtual Send F 21614
Virtual Return C to Virtual Send G 21515 Virtual Return D to Virtual Send G 21615
Virtual Return C to Virtual Send H 21516 Virtual Return D to Virtual Send H 21616

Virtual Return E to Virtual Send A 21709 Virtual Return F to Virtual Send A 21809
Virtual Return E to Virtual Send B 21710 Virtual Return F to Virtual Send B 21810
Virtual Return E to Virtual Send C 21711 Virtual Return F to Virtual Send C 21811
Virtual Return E to Virtual Send D 21712 Virtual Return F to Virtual Send D 21812

Virtual Return F to Virtual Send E 21813
Virtual Return E to Virtual Send F 21714
Virtual Return E to Virtual Send G 21715 Virtual Return F to Virtual Send G 21815
Virtual Return E to Virtual Send H 21716 Virtual Return F to Virtual Send H 21816

Virtual Return G to Virtual Send A 21909 Virtual Return H to Virtual Send A 22009
Virtual Return G to Virtual Send B 21910 Virtual Return H to Virtual Send B 22010
Virtual Return G to Virtual Send C 21911 Virtual Return H to Virtual Send C 22011
Virtual Return G to Virtual Send D 21912 Virtual Return H to Virtual Send D 22012
Virtual Return G to Virtual Send E 21913 Virtual Return H to Virtual Send E 22013
Virtual Return G to Virtual Send F 21914 Virtual Return H to Virtual Send F 22014

Virtual Return H to Virtual Send G 22015
Virtual Return G to Virtual Send H 21916
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Table 8:  EXP Bus Inputs to Virtual Sends

C EXP Inputs to Virtual Sends X6) C EXP Inputs to Virtual Sends X6)

EXP Input 1 to Virtual Sends A 22109 EXP Input 2 to Virtual Sends A 22209
EXP Input 1 to Virtual Sends B 22110 EXP Input 2 to Virtual Sends B 22210
EXP Input 1 to Virtual Sends C 22111 EXP Input 2 to Virtual Sends C 22211
EXP Input 1 to Virtual Sends D 22112 EXP Input 2 to Virtual Sends D 22212
EXP Input 1 to Virtual Sends E 22113 EXP Input 2 to Virtual Sends E 22213
EXP Input 1 to Virtual Sends F 22114 EXP Input 2 to Virtual Sends F 22214
EXP Input 1 to Virtual Sends G 22115 EXP Input 2 to Virtual Sends G 22215
EXP Input 1 to Virtual Sends H 22116 EXP Input 2 to Virtual Sends H 22216

EXP Input 3 to Virtual Sends A 22309 EXP Input 4 to Virtual Sends A 22409
EXP Input 3 to Virtual Sends B 22310 EXP Input 4 to Virtual Sends B 22410
EXP Input 3 to Virtual Sends C 22311 EXP Input 4 to Virtual Sends C 22411
EXP Input 3 to Virtual Sends D 22312 EXP Input 4 to Virtual Sends D 22412
EXP Input 3 to Virtual Sends E 22313 EXP Input 4 to Virtual Sends E 22413
EXP Input 3 to Virtual Sends F 22314 EXP Input 4 to Virtual Sends F 22414
EXP Input 3 to Virtual Sends G 22315 EXP Input 4 to Virtual Sends G 22415
EXP Input 3 to Virtual Sends H 22316 EXP Input 4 to Virtual Sends H 22416

EXP Input 5 to Virtual Sends A 22509 EXP Input 6 to Virtual Sends A 22609
EXP Input 5 to Virtual Sends B 22510 EXP Input 6 to Virtual Sends B 22610
EXP Input 5 to Virtual Sends C 22511 EXP Input 6 to Virtual Sends C 22611
EXP Input 5 to Virtual Sends D 22512 EXP Input 6 to Virtual Sends D 22612
EXP Input 5 to Virtual Sends E 22513 EXP Input 6 to Virtual Sends E 22613
EXP Input 5 to Virtual Sends F 22514 EXP Input 6 to Virtual Sends F 22614
EXP Input 5 to Virtual Sends G 22515 EXP Input 6 to Virtual Sends G 22615
EXP Input 5 to Virtual Sends H 22516 EXP Input 6 to Virtual Sends H 22616

EXP Input 7 to Virtual Sends A 22709 EXP Input 8 to Virtual Sends A 22809
EXP Input 7 to Virtual Sends B 22710 EXP Input 8 to Virtual Sends B 22810
EXP Input 7 to Virtual Sends C 22711 EXP Input 8 to Virtual Sends C 22811
EXP Input 7 to Virtual Sends D 22712 EXP Input 8 to Virtual Sends D 22812
EXP Input 7 to Virtual Sends E 22713 EXP Input 8 to Virtual Sends E 22813
EXP Input 7 to Virtual Sends F 22714 EXP Input 8 to Virtual Sends F 22814
EXP Input 7 to Virtual Sends G 22715 EXP Input 8 to Virtual Sends G 22815
EXP Input 7 to Virtual Sends H 22716 EXP Input 8 to Virtual Sends H 22816

EXP Input 9 to Virtual Sends A 22909 EXP Input 10 to Virtual Sends A 23009
EXP Input 9 to Virtual Sends B 22910 EXP Input 10 to Virtual Sends B 23010
EXP Input 9 to Virtual Sends C 22911 EXP Input 10 to Virtual Sends C 23011
EXP Input 9 to Virtual Sends D 22912 EXP Input 10 to Virtual Sends D 23012
EXP Input 9 to Virtual Sends E 22913 EXP Input 10 to Virtual Sends E 23013
EXP Input 9 to Virtual Sends F 22914 EXP Input 10 to Virtual Sends F 23014
EXP Input 9 to Virtual Sends G 22915 EXP Input 10 to Virtual Sends G 23015
EXP Input 9 to Virtual Sends H 22916 EXP Input 10 to Virtual Sends H 23016
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C EXP Inputs to Virtual Sends X6) C EXP Inputs to Virtual Sends X6)

EXP Input 11 to Virtual Sends A 23109 EXP Input 12 to Virtual Sends A 23209
EXP Input 11 to Virtual Sends B 23110 EXP Input 12 to Virtual Sends B 23210
EXP Input 11 to Virtual Sends C 23111 EXP Input 12 to Virtual Sends C 23211
EXP Input 11 to Virtual Sends D 23112 EXP Input 12 to Virtual Sends D 23212
EXP Input 11 to Virtual Sends E 23113 EXP Input 12 to Virtual Sends E 23213
EXP Input 11 to Virtual Sends F 23114 EXP Input 12 to Virtual Sends F 23214
EXP Input 11 to Virtual Sends G 23115 EXP Input 12 to Virtual Sends G 23215
EXP Input 11 to Virtual Sends H 23116 EXP Input 12 to Virtual Sends H 23216

EXP Input 13 to Virtual Sends A 23309 EXP Input 14 to Virtual Sends A 23409
EXP Input 13 to Virtual Sends B 23310 EXP Input 14 to Virtual Sends B 23410
EXP Input 13 to Virtual Sends C 23311 EXP Input 14 to Virtual Sends C 23411
EXP Input 13 to Virtual Sends D 23312 EXP Input 14 to Virtual Sends D 23412
EXP Input 13 to Virtual Sends E 23313 EXP Input 14 to Virtual Sends E 23413
EXP Input 13 to Virtual Sends F 23314 EXP Input 14 to Virtual Sends F 23414
EXP Input 13 to Virtual Sends G 23315 EXP Input 14 to Virtual Sends G 23415
EXP Input 13 to Virtual Sends H 23316 EXP Input 14 to Virtual Sends H 23416

EXP Input 15 to Virtual Sends A 23509 EXP Input 16 to Virtual Sends A 23609
EXP Input 15 to Virtual Sends B 23510 EXP Input 16 to Virtual Sends B 23610
EXP Input 15 to Virtual Sends C 23511 EXP Input 16 to Virtual Sends C 23611
EXP Input 15 to Virtual Sends D 23512 EXP Input 16 to Virtual Sends D 23612
EXP Input 15 to Virtual Sends E 23513 EXP Input 16 to Virtual Sends E 23613
EXP Input 15 to Virtual Sends F 23514 EXP Input 16 to Virtual Sends F 23614
EXP Input 15 to Virtual Sends G 23515 EXP Input 16 to Virtual Sends G 23615
EXP Input 15 to Virtual Sends H 23516 EXP Input 16 to Virtual Sends H 23616

EXP Input 17 to Virtual Sends A 23709 EXP Input 18 to Virtual Sends A 23809
EXP Input 17 to Virtual Sends B 23710 EXP Input 18 to Virtual Sends B 23810
EXP Input 17 to Virtual Sends C 23711 EXP Input 18 to Virtual Sends C 23811
EXP Input 17 to Virtual Sends D 23712 EXP Input 18 to Virtual Sends D 23812
EXP Input 17 to Virtual Sends E 23713 EXP Input 18 to Virtual Sends E 23813
EXP Input 17 to Virtual Sends F 23714 EXP Input 18 to Virtual Sends F 23814
EXP Input 17 to Virtual Sends G 23715 EXP Input 18 to Virtual Sends G 23815
EXP Input 17 to Virtual Sends H 23716 EXP Input 18 to Virtual Sends H 23816

EXP Input 19 to Virtual Sends A 23909 EXP Input 20 to Virtual Sends A 24009
EXP Input 19 to Virtual Sends B 23910 EXP Input 20 to Virtual Sends B 24010
EXP Input 19 to Virtual Sends C 23911 EXP Input 20 to Virtual Sends C 24011
EXP Input 19 to Virtual Sends D 23912 EXP Input 20 to Virtual Sends D 24012
EXP Input 19 to Virtual Sends E 23913 EXP Input 20 to Virtual Sends E 24013
EXP Input 19 to Virtual Sends F 23914 EXP Input 20 to Virtual Sends F 24014
EXP Input 19 to Virtual Sends G 23915 EXP Input 20 to Virtual Sends G 24015
EXP Input 19 to Virtual Sends H 23916 EXP Input 20 to Virtual Sends H 24016
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C EXP Inputs to Virtual Sends X6) C EXP Inputs to Virtual Sends X6)

EXP Input 21 to Virtual Sends A 24109 EXP Input 22 to Virtual Sends A 24209
EXP Input 21 to Virtual Sends B 24110 EXP Input 22 to Virtual Sends B 24210
EXP Input 21 to Virtual Sends C 24111 EXP Input 22 to Virtual Sends C 24211
EXP Input 21 to Virtual Sends D 24112 EXP Input 22 to Virtual Sends D 24212
EXP Input 21 to Virtual Sends E 24113 EXP Input 22 to Virtual Sends E 24213
EXP Input 21 to Virtual Sends F 24114 EXP Input 22 to Virtual Sends F 24214
EXP Input 21 to Virtual Sends G 24115 EXP Input 22 to Virtual Sends G 24215
EXP Input 21 to Virtual Sends H 24116 EXP Input 22 to Virtual Sends H 24216

EXP Input 23 to Virtual Sends A 24309 EXP Input 24 to Virtual Sends A 24409
EXP Input 23 to Virtual Sends B 24310 EXP Input 24 to Virtual Sends B 24410
EXP Input 23 to Virtual Sends C 24311 EXP Input 24 to Virtual Sends C 24411
EXP Input 23 to Virtual Sends D 24312 EXP Input 24 to Virtual Sends D 24412
EXP Input 23 to Virtual Sends E 24313 EXP Input 24 to Virtual Sends E 24413
EXP Input 23 to Virtual Sends F 24314 EXP Input 24 to Virtual Sends F 24414
EXP Input 23 to Virtual Sends G 24315 EXP Input 24 to Virtual Sends G 24415
EXP Input 23 to Virtual Sends H 24316 EXP Input 24 to Virtual Sends H 24416

EXP Input 25 to Virtual Sends A 24509 EXP Input 26 to Virtual Sends A 24609
EXP Input 25 to Virtual Sends B 24510 EXP Input 26 to Virtual Sends B 24610
EXP Input 25 to Virtual Sends C 24511 EXP Input 26 to Virtual Sends C 24611
EXP Input 25 to Virtual Sends D 24512 EXP Input 26 to Virtual Sends D 24612
EXP Input 25 to Virtual Sends E 24513 EXP Input 26 to Virtual Sends E 24613
EXP Input 25 to Virtual Sends F 24514 EXP Input 26 to Virtual Sends F 24614
EXP Input 25 to Virtual Sends G 24515 EXP Input 26 to Virtual Sends G 24615
EXP Input 25 to Virtual Sends H 24516 EXP Input 26 to Virtual Sends H 24616

EXP Input 27 to Virtual Sends A 24709 EXP Input 28 to Virtual Sends A 24809
EXP Input 27 to Virtual Sends B 24710 EXP Input 28 to Virtual Sends B 24810
EXP Input 27 to Virtual Sends C 24711 EXP Input 28 to Virtual Sends C 24811
EXP Input 27 to Virtual Sends D 24712 EXP Input 28 to Virtual Sends D 24812
EXP Input 27 to Virtual Sends E 24713 EXP Input 28 to Virtual Sends E 24813
EXP Input 27 to Virtual Sends F 24714 EXP Input 28 to Virtual Sends F 24814
EXP Input 27 to Virtual Sends G 24715 EXP Input 28 to Virtual Sends G 24815
EXP Input 27 to Virtual Sends H 24716 EXP Input 28 to Virtual Sends H 24816

EXP Input 29 to Virtual Sends A 24909 EXP Input 30 to Virtual Sends A 25009
EXP Input 29 to Virtual Sends B 24910 EXP Input 30 to Virtual Sends B 25010
EXP Input 29 to Virtual Sends C 24911 EXP Input 30 to Virtual Sends C 25011
EXP Input 29 to Virtual Sends D 24912 EXP Input 30 to Virtual Sends D 25012
EXP Input 29 to Virtual Sends E 24913 EXP Input 30 to Virtual Sends E 25013
EXP Input 29 to Virtual Sends F 24914 EXP Input 30 to Virtual Sends F 25014
EXP Input 29 to Virtual Sends G 24915 EXP Input 30 to Virtual Sends G 25015
EXP Input 29 to Virtual Sends H 24916 EXP Input 30 to Virtual Sends H 25016

EXP Input 31 to Virtual Sends A 25109 EXP Input 32 to Virtual Sends A 25209
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C EXP Inputs to Virtual Sends X6) C EXP Inputs to Virtual Sends X6)

EXP Input 31 to Virtual Sends B 25110 EXP Input 32 to Virtual Sends B 25210
EXP Input 31 to Virtual Sends C 25111 EXP Input 32 to Virtual Sends C 25211
EXP Input 31 to Virtual Sends D 25112 EXP Input 32 to Virtual Sends D 25212
EXP Input 31 to Virtual Sends E 25113 EXP Input 32 to Virtual Sends E 25213
EXP Input 31 to Virtual Sends F 25114 EXP Input 32 to Virtual Sends F 25214
EXP Input 31 to Virtual Sends G 25115 EXP Input 32 to Virtual Sends G 25215
EXP Input 31 to Virtual Sends H 25116 EXP Input 32 to Virtual Sends H 25216

EXP Input 33 to Virtual Sends A 25309 EXP Input 34 to Virtual Sends A 25409
EXP Input 33 to Virtual Sends B 25310 EXP Input 34 to Virtual Sends B 25410
EXP Input 33 to Virtual Sends C 25311 EXP Input 34 to Virtual Sends C 25411
EXP Input 33 to Virtual Sends D 25312 EXP Input 34 to Virtual Sends D 25412
EXP Input 33 to Virtual Sends E 25313 EXP Input 34 to Virtual Sends E 25413
EXP Input 33 to Virtual Sends F 25314 EXP Input 34 to Virtual Sends F 25414
EXP Input 33 to Virtual Sends G 25315 EXP Input 34 to Virtual Sends G 25415
EXP Input 33 to Virtual Sends H 25316 EXP Input 34 to Virtual Sends H 25416

EXP Input 35 to Virtual Sends A 25509 EXP Input 36 to Virtual Sends A 25609
EXP Input 35 to Virtual Sends B 25510 EXP Input 36 to Virtual Sends B 25610
EXP Input 35 to Virtual Sends C 25511 EXP Input 36 to Virtual Sends C 25611
EXP Input 35 to Virtual Sends D 25512 EXP Input 36 to Virtual Sends D 25612
EXP Input 35 to Virtual Sends E 25513 EXP Input 36 to Virtual Sends E 25613
EXP Input 35 to Virtual Sends F 25514 EXP Input 36 to Virtual Sends F 25614
EXP Input 35 to Virtual Sends G 25515 EXP Input 36 to Virtual Sends G 25615
EXP Input 35 to Virtual Sends H 25516 EXP Input 36 to Virtual Sends H 25616

EXP Input 37 to Virtual Sends A 25709 EXP Input 38 to Virtual Sends A 25809
EXP Input 37 to Virtual Sends B 25710 EXP Input 38 to Virtual Sends B 25810
EXP Input 37 to Virtual Sends C 25711 EXP Input 38 to Virtual Sends C 25811
EXP Input 37 to Virtual Sends D 25712 EXP Input 38 to Virtual Sends D 25812
EXP Input 37 to Virtual Sends E 25713 EXP Input 38 to Virtual Sends E 25813
EXP Input 37 to Virtual Sends F 25714 EXP Input 38 to Virtual Sends F 25814
EXP Input 37 to Virtual Sends G 25715 EXP Input 38 to Virtual Sends G 25815
EXP Input 37 to Virtual Sends H 25716 EXP Input 38 to Virtual Sends H 25816

EXP Input 39 to Virtual Sends A 25909 EXP Input 40 to Virtual Sends A 26009
EXP Input 39 to Virtual Sends B 25910 EXP Input 40 to Virtual Sends B 26010
EXP Input 39 to Virtual Sends C 25911 EXP Input 40 to Virtual Sends C 26011
EXP Input 39 to Virtual Sends D 25912 EXP Input 40 to Virtual Sends D 26012
EXP Input 39 to Virtual Sends E 25913 EXP Input 40 to Virtual Sends E 26013
EXP Input 39 to Virtual Sends F 25914 EXP Input 40 to Virtual Sends F 26014
EXP Input 39 to Virtual Sends G 25915 EXP Input 40 to Virtual Sends G 26015
EXP Input 39 to Virtual Sends H 25916 EXP Input 40 to Virtual Sends H 26016

EXP Input 41 to Virtual Sends A 26109 EXP Input 42 to Virtual Sends A 26209
EXP Input 41 to Virtual Sends B 26110 EXP Input 42 to Virtual Sends B 26210
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C EXP Inputs to Virtual Sends X6) C EXP Inputs to Virtual Sends X6)

EXP Input 41 to Virtual Sends C 26111 EXP Input 42 to Virtual Sends C 26211
EXP Input 41 to Virtual Sends D 26112 EXP Input 42 to Virtual Sends D 26212
EXP Input 41 to Virtual Sends E 26113 EXP Input 42 to Virtual Sends E 26213
EXP Input 41 to Virtual Sends F 26114 EXP Input 42 to Virtual Sends F 26214
EXP Input 41 to Virtual Sends G 26115 EXP Input 42 to Virtual Sends G 26215
EXP Input 41 to Virtual Sends H 26116 EXP Input 42 to Virtual Sends H 26216

EXP Input 43 to Virtual Sends A 26309 EXP Input 44 to Virtual Sends A 26409
EXP Input 43 to Virtual Sends B 26310 EXP Input 44 to Virtual Sends B 26410
EXP Input 43 to Virtual Sends C 26311 EXP Input 44 to Virtual Sends C 26411
EXP Input 43 to Virtual Sends D 26312 EXP Input 44 to Virtual Sends D 26412
EXP Input 43 to Virtual Sends E 26313 EXP Input 44 to Virtual Sends E 26413
EXP Input 43 to Virtual Sends F 26314 EXP Input 44 to Virtual Sends F 26414
EXP Input 43 to Virtual Sends G 26315 EXP Input 44 to Virtual Sends G 26415
EXP Input 43 to Virtual Sends H 26316 EXP Input 44 to Virtual Sends H 26416

EXP Input 45 to Virtual Sends A 26509 EXP Input 46 to Virtual Sends A 26609
EXP Input 45 to Virtual Sends B 26510 EXP Input 46 to Virtual Sends B 26610
EXP Input 45 to Virtual Sends C 26511 EXP Input 46 to Virtual Sends C 26611
EXP Input 45 to Virtual Sends D 26512 EXP Input 46 to Virtual Sends D 26612
EXP Input 45 to Virtual Sends E 26513 EXP Input 46 to Virtual Sends E 26613
EXP Input 45 to Virtual Sends F 26514 EXP Input 46 to Virtual Sends F 26614
EXP Input 45 to Virtual Sends G 26515 EXP Input 46 to Virtual Sends G 26615
EXP Input 45 to Virtual Sends H 26516 EXP Input 46 to Virtual Sends H 26616

EXP Input 47 to Virtual Sends A 26709 EXP Input 48 to Virtual Sends A 26809
EXP Input 47 to Virtual Sends B 26710 EXP Input 48 to Virtual Sends B 26810
EXP Input 47 to Virtual Sends C 26711 EXP Input 48 to Virtual Sends C 26811
EXP Input 47 to Virtual Sends D 26712 EXP Input 48 to Virtual Sends D 26812
EXP Input 47 to Virtual Sends E 26713 EXP Input 48 to Virtual Sends E 26813
EXP Input 47 to Virtual Sends F 26714 EXP Input 48 to Virtual Sends F 26814
EXP Input 47 to Virtual Sends G 26715 EXP Input 48 to Virtual Sends G 26815
EXP Input 47 to Virtual Sends H 26716 EXP Input 48 to Virtual Sends H 26816

EXP Input 49 to Virtual Sends A 26909 EXP Input 50 to Virtual Sends A 27009
EXP Input 49 to Virtual Sends B 26910 EXP Input 50 to Virtual Sends B 27010
EXP Input 49 to Virtual Sends C 26911 EXP Input 50 to Virtual Sends C 27011
EXP Input 49 to Virtual Sends D 26912 EXP Input 50 to Virtual Sends D 27012
EXP Input 49 to Virtual Sends E 26913 EXP Input 50 to Virtual Sends E 27013
EXP Input 49 to Virtual Sends F 26914 EXP Input 50 to Virtual Sends F 27014
EXP Input 49 to Virtual Sends G 26915 EXP Input 50 to Virtual Sends G 27015
EXP Input 49 to Virtual Sends H 26916 EXP Input 50 to Virtual Sends H 27016

EXP Input 51 to Virtual Sends A 27109 EXP Input 52 to Virtual Sends A 27209
EXP Input 51 to Virtual Sends B 27110 EXP Input 52 to Virtual Sends B 27210
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C EXP Inputs to Virtual Sends X6) C EXP Inputs to Virtual Sends X6)

EXP Input 51 to Virtual Sends C 27111 EXP Input 52 to Virtual Sends C 27211
EXP Input 51 to Virtual Sends D 27112 EXP Input 52 to Virtual Sends D 27212
EXP Input 51 to Virtual Sends E 27113 EXP Input 52 to Virtual Sends E 27213
EXP Input 51 to Virtual Sends F 27114 EXP Input 52 to Virtual Sends F 27214
EXP Input 51 to Virtual Sends G 27115 EXP Input 52 to Virtual Sends G 27215
EXP Input 51 to Virtual Sends H 27116 EXP Input 52 to Virtual Sends H 27216

EXP Input 53 to Virtual Sends A 27309 EXP Input 54 to Virtual Sends A 27409
EXP Input 53 to Virtual Sends B 27310 EXP Input 54 to Virtual Sends B 27410
EXP Input 53 to Virtual Sends C 27311 EXP Input 54 to Virtual Sends C 27411
EXP Input 53 to Virtual Sends D 27312 EXP Input 54 to Virtual Sends D 27412
EXP Input 53 to Virtual Sends E 27313 EXP Input 54 to Virtual Sends E 27413
EXP Input 53 to Virtual Sends F 27314 EXP Input 54 to Virtual Sends F 27414
EXP Input 53 to Virtual Sends G 27315 EXP Input 54 to Virtual Sends G 27415
EXP Input 53 to Virtual Sends H 27316 EXP Input 54 to Virtual Sends H 27416

EXP Input 55 to Virtual Sends A 27509 EXP Input 56 to Virtual Sends A 27609
EXP Input 55 to Virtual Sends B 27510 EXP Input 56 to Virtual Sends B 27610
EXP Input 55 to Virtual Sends C 27511 EXP Input 56 to Virtual Sends C 27611
EXP Input 55 to Virtual Sends D 27512 EXP Input 56 to Virtual Sends D 27612
EXP Input 55 to Virtual Sends E 27513 EXP Input 56 to Virtual Sends E 27613
EXP Input 55 to Virtual Sends F 27514 EXP Input 56 to Virtual Sends F 27614
EXP Input 55 to Virtual Sends G 27515 EXP Input 56 to Virtual Sends G 27615
EXP Input 55 to Virtual Sends H 27516 EXP Input 56 to Virtual Sends H 27616
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Virtual Send Bus Expansion Outputs (1-8)1     2     3     4      5     6     7      8  

Expansion Outputs
(9-16)

1     2     3     4     5     6     7     8  

1     2     3     4      5     6     7      8  

A     B     C     D     E     F     G     H  1     2     3     4     5     6     7     8  

9

10

11

12

13

14

15

16

A     B     C     D     E     F     G     H  

Inputs

Virtual Returns

Expansion Inputs

Outputs

1 - 8

9 - 16

EXP Output 
Mix-points 

Mic/Line Inputs to 
EXP Output Mix-points 

Virtual Returns to
EXP Output Mix-points

AA

BB

EXP Outputs 
The EXP Output mix-point bus routes the Mic/line inputs (A) and virtual returns (B) to the 
Extron EXP outputs.

Figure 115.	 EXP Output Mix-Point Bus
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Table 9:  Mic/Line Inputs to EXP Outputs 

A Inputs to EXP Outputs X6) A Inputs to EXP Outputs X6)

Input 1 to EXP Output 1 20018 Input 2 to EXP Output 1 20117
Input 1 to EXP Output 2 20018 Input 2 to EXP Output 2 20118
Input 1 to EXP Output 3 20019 Input 2 to EXP Output 3 20119
Input 1 to EXP Output 4 20020 Input 2 to EXP Output 4 20120
Input 1 to EXP Output 5 20021 Input 2 to EXP Output 5 20121
Input 1 to EXP Output 6 20022 Input 2 to EXP Output 6 20122
Input 1 to EXP Output 7 20023 Input 2 to EXP Output 7 20123
Input 1 to EXP Output 8 20024 Input 2 to EXP Output 8 20124

Input 3 to EXP Output 1 20217 Input 4 to EXP Output 1 20317
Input 3 to EXP Output 2 20218 Input 4 to EXP Output 2 20318
Input 3 to EXP Output 3 20219 Input 4 to EXP Output 3 20319
Input 3 to EXP Output 4 20220 Input 4 to EXP Output 4 20320
Input 3 to EXP Output 5 20221 Input 4 to EXP Output 5 20321
Input 3 to EXP Output 6 20222 Input 4 to EXP Output 6 20322
Input 3 to EXP Output 7 20223 Input 4 to EXP Output 7 20323
Input 3 to EXP Output 8 20224 Input 4 to EXP Output 8 20324

Input 5 to EXP Output 1 20417 Input 6 to EXP Output 1 20517
Input 5 to EXP Output 2 20418 Input 6 to EXP Output 2 20518
Input 5 to EXP Output 3 20419 Input 6 to EXP Output 3 20519
Input 5 to EXP Output 4 20420 Input 6 to EXP Output 4 20520
Input 5 to EXP Output 5 20421 Input 6 to EXP Output 5 20521
Input 5 to EXP Output 6 20422 Input 6 to EXP Output 6 20522
Input 5 to EXP Output 7 20423 Input 6 to EXP Output 7 20523
Input 5 to EXP Output 8 20424 Input 6 to EXP Output 8 20524

Input 7 to EXP Output 1 20617 Input 8 to EXP Output 1 20717
Input 7 to EXP Output 2 20618 Input 8 to EXP Output 2 20718
Input 7 to EXP Output 3 20619 Input 8 to EXP Output 3 20719
Input 7 to EXP Output 4 20620 Input 8 to EXP Output 4 20720
Input 7 to EXP Output 5 20621 Input 8 to EXP Output 5 20721
Input 7 to EXP Output 6 20622 Input 8 to EXP Output 6 20722
Input 7 to EXP Output 7 20623 Input 8 to EXP Output 7 20723
Input 7 to EXP Output 8 20624 Input 8 to EXP Output 8 20724

Input 9 to EXP Output 1 20817 Input 10 to EXP Output 1 20917
Input 9 to EXP Output 2 20818 Input 10 to EXP Output 2 20918
Input 9 to EXP Output 3 20819 Input 10 to EXP Output 3 20919
Input 9 to EXP Output 4 20820 Input 10 to EXP Output 4 20920
Input 9 to EXP Output 5 20821 Input 10 to EXP Output 5 20921
Input 9 to EXP Output 6 20822 Input 10 to EXP Output 6 20922
Input 9 to EXP Output 7 20823 Input 10 to EXP Output 7 20923
Input 9 to EXP Output 8 20824 Input 10 to EXP Output 8 20924
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A Inputs to EXP Outputs X6) A Inputs to EXP Outputs X6)

Input 11 to EXP Output 1 21017 Input 12 to EXP Output 1 21117
Input 11 to EXP Output 2 21018 Input 12 to EXP Output 2 21118
Input 11 to EXP Output 3 21019 Input 12 to EXP Output 3 21119
Input 11 to EXP Output 4 21020 Input 12 to EXP Output 4 21120
Input 11 to EXP Output 5 21021 Input 12 to EXP Output 5 21121
Input 11 to EXP Output 6 21022 Input 12 to EXP Output 6 21122
Input 11 to EXP Output 7 21023 Input 12 to EXP Output 7 21123
Input 11 to EXP Output 8 21024 Input 12 to EXP Output 8 21124

Telephone Rx to EXP Output 1 21217
Telephone Rx to EXP Output 2 21218
Telephone Rx to EXP Output 3 21219
Telephone Rx to EXP Output 4 21220
Telephone Rx to EXP Output 5 21221
Telephone Rx to EXP Output 6 21222
Telephone Rx to EXP Output 7 21223
Telephone Rx to EXP Output 8 21224
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Table 10:  Virtual Returns to EXP Outputs 

B Virtual Returns to EXP   
      Outputs X6) B Virtual Returns to EXP  

      Outputs X6)

Virtual Return A to EXP Output 1 21317 Virtual Return B to EXP Output 1 21417
Virtual Return A to EXP Output 2 21318 Virtual Return B to EXP Output 2 21418
Virtual Return A to EXP Output 3 21319 Virtual Return B to EXP Output 3 21419
Virtual Return A to EXP Output 4 21320 Virtual Return B to EXP Output 4 21420
Virtual Return A to EXP Output 5 21321 Virtual Return B to EXP Output 5 21421
Virtual Return A to EXP Output 6 21322 Virtual Return B to EXP Output 6 21422
Virtual Return A to EXP Output 7 21323 Virtual Return B to EXP Output 7 21423
Virtual Return A to EXP Output 8 21324 Virtual Return B to EXP Output 8 21424

Virtual Return C to EXP Output 1 21517 Virtual Return D to EXP Output 1 21617
Virtual Return C to EXP Output 2 21518 Virtual Return D to EXP Output 2 21618
Virtual Return C to EXP Output 3 21519 Virtual Return D to EXP Output 3 21619
Virtual Return C to EXP Output 4 21520 Virtual Return D to EXP Output 4 21620
Virtual Return C to EXP Output 5 21521 Virtual Return D to EXP Output 5 21621
Virtual Return C to EXP Output 6 21522 Virtual Return D to EXP Output 6 21622
Virtual Return C to EXP Output 7 21523 Virtual Return D to EXP Output 7 21623
Virtual Return C to EXP Output 8 21524 Virtual Return D to EXP Output 8 21624

Virtual Return E to EXP Output 1 21717 Virtual Return F to EXP Output 1 21817
Virtual Return E to EXP Output 2 21718 Virtual Return F to EXP Output 2 21818
Virtual Return E to EXP Output 3 21719 Virtual Return F to EXP Output 3 21819
Virtual Return E to EXP Output 4 21720 Virtual Return F to EXP Output 4 21820
Virtual Return E to EXP Output 5 21721 Virtual Return F to EXP Output 5 21821
Virtual Return E to EXP Output 6 21722 Virtual Return F to EXP Output 6 21822
Virtual Return E to EXP Output 7 21723 Virtual Return F to EXP Output 7 21823
Virtual Return E to EXP Output 8 21724 Virtual Return F to EXP Output 8 21824

Virtual Return G to EXP Output 1 21917 Virtual Return H to EXP Output 1 22017
Virtual Return G to EXP Output 2 21918 Virtual Return H to EXP Output 2 22018
Virtual Return G to EXP Output 3 21919 Virtual Return H to EXP Output 3 22019
Virtual Return G to EXP Output 4 21920 Virtual Return H to EXP Output 4 22020
Virtual Return G to EXP Output 5 21921 Virtual Return H to EXP Output 5 22021
Virtual Return G to EXP Output 6 21922 Virtual Return H to EXP Output 6 22022
Virtual Return G to EXP Output 7 21923 Virtual Return H to EXP Output 7 22023
Virtual Return G to EXP Output 8 21924 Virtual Return H to EXP Output 8 22024
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Contact Information

Worldwide Headquarters:  Extron USA West, 1025 E. Ball Road, Anaheim, CA 92805, 800.633.9876

Extron Warranty

Extron Electronics warrants this product against defects in materials and workmanship for a period of three years 
from the date of purchase. In the event of malfunction during the warranty period attributable directly to faulty 
workmanship and/or materials, Extron Electronics will, at its option, repair or replace said products or components, 
to whatever extent it shall deem necessary to restore said product to proper operating condition, provided that it is 
returned within the warranty period, with proof of purchase and description of malfunction to:

USA, Canada, South America, 
and Central America:
Extron Electronics 
1230 South Lewis Street 
Anaheim, CA 92805 
U.S.A.

Asia:
Extron Asia Pte Ltd 
135 Joo Seng Road, #04-01 
PM Industrial Bldg. 
Singapore 368363 
Singapore

Japan:
Extron Electronics, Japan 
Kyodo Building, 16 Ichibancho 
Chiyoda-ku, Tokyo 102-0082 
Japan

Europe:
Extron Europe 
Hanzeboulevard 10 
3825 PH Amersfoort 
The Netherlands

China:
Extron China 
686 Ronghua Road 
Songjiang District 
Shanghai 201611 
China

Middle East:
Extron Middle East 
Dubai Airport Free Zone 
F13, PO Box 293666 
United Arab Emirates, Dubai

Africa:
Extron South Africa 
3rd Floor, South Tower  
160 Jan Smuts Avenue  
Rosebank 2196, South Africa

This Limited Warranty does not apply if the fault has been caused by misuse, improper handling care, electrical 
or mechanical abuse, abnormal operating conditions, or if modifications were made to the product that were not 
authorized by Extron.

NOTE:	 If a product is defective, please call Extron and ask for an Application Engineer to receive an RA (Return 
Authorization) number. This will begin the repair process. 
 
USA:	 714.491.1500 or 800.633.9876	 Asia:	 65.6383.4400	  

	 Europe:	31.33.453.4040 or 800.3987.6673	 Japan:	 81.3.3511.7655
	 Africa:	 27.11.447.6162	 Middle East:	 971.4.299.1800	  

Units must be returned insured, with shipping charges prepaid. If not insured, you assume the risk of loss or damage 
during shipment. Returned units must include the serial number and a description of the problem, as well as the 
name of the person to contact in case there are any questions. 

Extron Electronics makes no further warranties either expressed or implied with respect to the product and its quality, 
performance, merchantability, or fitness for any particular use. In no event will Extron Electronics be liable for direct, 
indirect, or consequential damages resulting from any defect in this product even if Extron Electronics has been 
advised of such damage.

Please note that laws vary from state to state and country to country, and that some provisions of this warranty may 
not apply to you.



Extron Headquarters
+1.800.633.9876 (Inside USA/Canada Only)

Extron USA - West	 Extron USA - East 
+1.714.491.1500	 +1.919.850.1000 
+1.714.491.1517 FAX	 +1.919.850.1001 FAX

Extron Europe
+800.3987.6673 
(Inside Europe Only)

+31.33.453.4040 
+31.33.453.4050 FAX

Extron Asia
+65.6383.4400
+65.6383.4664 FAX

Extron Japan
+81.3.3511.7655
+81.3.3511.7656 FAX

Extron China
+86.21.3760.1568 
+86.21.3760.1566 FAX

Extron Middle East
+971.4.299.1800
+971.4.299.1880 FAX

Extron Korea
+82.2.3444.1571
+82.2.3444.1575 FAX

Extron India
1800.3070.3777 
(Inside India Only)

+91.80.3055.3777 
+91.80.3055.3737 FAX

© 2015 Extron Electronics   All rights reserved.   www.extron.com
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Contact Information

Extron Warranty

Extron Electronics warrants this product against defects in materials and workmanship for a period of three years 
from the date of purchase. In the event of malfunction during the warranty period attributable directly to faulty 
workmanship and/or materials, Extron Electronics will, at its option, repair or replace said products or components, 
to whatever extent it shall deem necessary to restore said product to proper operating condition, provided that it is 
returned within the warranty period, with proof of purchase and description of malfunction to:

USA, Canada, South America, 
and Central America: 
Extron Electronics 
1230 South Lewis Street 
Anaheim, CA 92805 
U.S.A.

 
Japan: 
Extron Electronics, Japan 
Kyodo Building, 16 Ichibancho 
Chiyoda-ku, Tokyo 102-0082 
Japan

Europe and Africa: 
Extron Europe 
Hanzeboulevard 10 
3825 PH Amersfoort 
The Netherlands

China: 
Extron China 
686 Ronghua Road 
Songjiang District 
Shanghai 201611 
China

Asia: 
Extron Asia Pte Ltd 
135 Joo Seng Road, #04-01 
PM Industrial Bldg. 
Singapore 368363 
Singapore

Middle East: 
Extron Middle East 
Dubai Airport Free Zone 
F13, PO Box 293666 
United Arab Emirates, Dubai

This Limited Warranty does not apply if the fault has been caused by misuse, improper handling care, electrical 
or mechanical abuse, abnormal operating conditions, or if modifications were made to the product that were not 
authorized by Extron.

NOTE:	 If a product is defective, please call Extron and ask for an Application Engineer to receive an RA (Return 
Authorization) number. This will begin the repair process. 
 
USA:	 714.491.1500 or 800.633.9876	 Europe:	 31.33.453.4040  
Asia:	 65.6383.4400	 Japan:	 81.3.3511.7655 

Units must be returned insured, with shipping charges prepaid. If not insured, you assume the risk of loss or damage 
during shipment. Returned units must include the serial number and a description of the problem, as well as the 
name of the person to contact in case there are any questions. 

Extron Electronics makes no further warranties either expressed or implied with respect to the product and its quality, 
performance, merchantability, or fitness for any particular use. In no event will Extron Electronics be liable for direct, 
indirect, or consequential damages resulting from any defect in this product even if Extron Electronics has been 
advised of such damage.

Please note that laws vary from state to state and country to country, and that some provisions of this warranty may 
not apply to you.
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